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Chapter 1 Introduction 

Welcome to Vibrodesigner! 

Vibrodesigner is an advanced condition monitoring system for industrial machinery. The 

system functionality encompasses a wide range of maintenance engineer tasks, from 

simple measurements and data acquisition to complete plant-wide maintenance. The 

Vibrodesigner solution has the power to enable monitoring and protecting machinery 

against high vibration and the potential damage associated with excessive vibration. 

Condition-based machinery maintenance provides you with recording and trending 

vibration data to keep track of component performance. Permanent vibration analysis of 

machines for potential faults is the most effective technique in condition monitoring. 

Fault detection at early stages is based on spectral analysis of mechanical vibration of 

machinery components. With Vibrodesigner, you perform regular machinery inspections 

(diagnostic data acquisition), monitor condition and plan maintenance over the entire 

operating period for all machines. Shaft speed, temperature and other parameters are also 

used by Vibrodesigner for machinery monitoring. 

Integrating offline and online monitoring is the optimal solution for condition-based 

maintenance. Data acquisition with portable STD-500/510/3300, stationary CTD-

2060/2160/3168 monitors, or online ASTD-2 system helps you implement plant-wide 

maintenance. 

Vibrodesigner automatically fulfills the following monitoring requirements: 

 Preventing machinery from failures. 

 Regular measurements for detecting possible machinery condition changes. 

 Real-time machinery condition monitoring over any set of specified parameters. 

 Long term storage of the collected data for statistics, further analysis and diagnostics. 

 Pinpointing progressive defects and defining deadlines for repairs. 

 Locating faulty components and determining a fault causes. 

Vibrodesigner provides a large-scale functionality. It allows you to create the plant 

hierarchy that matches the structure of a real-world plant. Using Vibrodesigner, the 

maintenance engineer makes a plan of vibration inspections by creating machine models, 

machines, measurement points and inspection routes. An embedded interface for 

connecting to Technekon’s portable analyzers enables loading inspection configuration 

(routes) into these devices. Inspection routes set all the parameters that a portable data 

collector will need for data acquisition. When vibration data are collected, you can load 

the collected data into the Vibrodesigner database on your computer. To detect various 

machine defects, you may compute any parameters from measured signals, bands or 

other calculated parameters. You may specify alarm/warning thresholds for these 

parameters and monitor calculated parameters as trends. You can also import the files 
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containing inspection data retrieved via the online ASTD-2 monitoring system. Besides, 

scheduled auto acquisition with remote data monitors can be applied. 

A maintenance specialist may use the data stored in the database for: 

 Creating and printing reports. 

 Visual analysis of waveforms, orbits and spectra. 

 Calculating and storing trends of frequency bands (absolute and relative). 

 Trend visual analysis for frequency bands and different operational parameters. The 

analysis includes forecast and alarm levels. 

 Viewing and analyzing orbits. 

 Waveforms and spectra integration and differentiation, FFT, and so on. 

You can create more than one database. Thus, the user may work with various databases, 

choosing the one of interest. 

When installed on a plant local network, the program supports a multi-user access mode. 

Multiple users may logon to a common database that resides on one of the computers on 

the network
1
. 

Who Should Use This Book 

This manual is intended for vibration analysis specialists in charge of monitoring a 

plant’s machinery. It is assumed that the reader has acquired the following knowledge 

and skills: 

 Knowledge of machinery vibration analysis 

 Skills in using Windows 2000/XP 

                                                      

1
 You need to specify special Windows security settings for accessing remote computers. For more 

information, see ―Windows Security Settings for Remote Access‖. 
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Chapter 2 Vibrodesigner Installation 

This chapter describes how to install Vibrodesigner. It also contains Vibrodesigner 

system requirements. 

It covers the following topics: 

 Workstation Requirements 

 Installing Vibrodesigner 

Workstation Requirements 

Before you install, make sure that your workstation meets the following hardware 

requirements: 

 Processor Intel Pentium™ 500 MHz or higher 

 At least 128 MB of RAM (Windows 2000), 256 MB (Windows XP) 

 At least 350 MB free hard disk space 

Note This disk space may vary depending on your database size. Up to 

2.5 GB may be additionally required. 

 Video system supporting at least 1024x768 (High Color) 

One of the following operating systems must be preinstalled on your computer: 

 Microsoft Windows 2000 SP4 

 Microsoft Windows XP SP1, SP2 or SP3 

Note To enable Vibrodesigner-Standard to work properly, the following 

program is to be preinstalled on your workstation: Microsoft .NET 

Framework 2.0. 
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Installing Vibrodesigner 

To install Vibrodesigner-Standard properly, log on to the workstation as a local 

administrator. If necessary, contact your system administrator. 

Before installing Vibrodesigner-Standard, make sure that the freeware Microsoft .NET 

Framework 2.0 software is installed on your computer and it works properly. If not, you 

have to install it. To do so, use the dotnetfx.exe file located in the folder 

NET_FRAMEWORK2.0\ of the Vibrodesigner-Standard installation CD. Run 

dotnetfx.exe and follow the onscreen instructions. Make sure .NET Framework has been 

installed properly and no errors occurred. If another version of .NET Framework 

(different from 2.0) is installed, it do not affect Vibrodesigner performance. You have to 

install .NET Framework version 2.0. 

Note Close all running applications before installing Vibrodesigner. 

1 Run the setup.exe file located on the Vibrodesigner installation CD. This file is 

selected in the picture below. 

 
Figure 1 Installation CD files 

A dialog box appears, prompting you to select the installation and localization 

language. 
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Figure 2 Choosing installation language 

2 Select English from the drop-down list and click OK. 

The setup wizard is started. 

 
Figure 3 Starting InstallShield Wizard 

The installation of supplementary MSDE 2000 Release A program (the 

VD_SQL_SERVER instance) is performed to manage Vibrodesigner databases 

properly. This software will not affect your computer performance. Its installation 

may take several minutes, please wait until this operation is finished. 

Note: The SQL server is not installed if you have previously installed 

Vibrodesigner 3.1 or higher on your computer. 

 
Figure 4 MSDE Installation Process 

When finished, the Vibrodesigner program installation is started. 
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Figure 5 Welcome Screen page 

3 Click Next. 

 
Figure 6 Choose Destination Location page 
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4 Either accept the default installation path or specify a different destination location 

by clicking Browse, and then click Next. 

 
Figure 7 Choose Databases Folder page 

5 Either accept the default path to the stored databases or specify a different folder by 

clicking Browse, and then click Next. 

The selected settings are displayed. 
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Figure 8 Start Copying Files page 

6 Click Next. 

The Vibrodesigner installation is started. 

 
Figure 9 Starting Vibrodesigner installation 
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If you had installed MSDE 2000 just before installing Vibrodesigner, you are 

prompted to restart the computer. If not, you may start working with Vibrodesigner. 

 
Figure 10 InstallShield Wizard Complete Page 

7 Click Finish. 

Having Windows restarted, a dialog box appears displaying how the demo database 

is being restored. 

 
Figure 11 Restoring demo database 

When finished, you may start working with Vibrodesigner. 
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Chapter 3 Overview 

This chapter contains a brief overview of Vibrodesigner. 

It covers the following topics: 

 Features of Vibrodesigner 

 Starting Vibrodesigner 

 Vibrodesigner Interface 

 Vibrodesigner Working Modes 

 Vibrodesigner Configuration Types 

Features of Vibrodesigner 

Vibrodesigner is a robust system intended to accomplish various tasks of vibration 

condition monitoring. Main features of Vibrodesigner are the following: 

 Standard Interface 

The Vibrodesigner provides a standard intuitive user interface that helps quickly 

master the software. Working with Vibrodesigner does not require special skills or 

knowledge of any programming language. 

 Versatility 

The Vibrodesigner system enables you to work either with portable data collectors or 

stationary analyzers, as well as with the online ASTD-2 vibration diagnostics system. 

You can also import the data received by email from remote machine shops of your 

plant. 

 Multi-user access 

The client-server architecture of the Vibrodesigner software allows you to work 

remotely with databases on the local plant network. You can create a unified 

repository of diagnostics data available to all interested specialists of your plant, as 

well as to outsourced specialists engaged in investigating the causes of the 

machinery condition changes. 

 Fast and easy configuration 

The easy-to-use table editor allows you to quickly perform all necessary 

measurement settings. Modifying parameters of measurement points, frequency 

bands and warning/alarm levels becomes as easy as using a common office 

application. 
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 Import/export of a plant hierarchy 

Vibrodesigner has a mechanism of import/export of the plant hierarchy, machine 

models and separate machine elements. It allows you to upload a ready-to-use 

configuration from a template and exchange configuration templates with fellow 

specialists. 

 Import/export of inspections 

Vibrodesigner allows exchanging data between various databases with identical 

logical structure and exporting collected data into MS Excel format. 

 Auto acquisition 

You can apply scheduled auto acquisition from remote data monitors. 

 Frequency bands 

Vibrodesigner enables you to create any absolute or relative bands, estimate trends 

for these bands using the collected data, automatically calculate RMS in bands in 

case of new data retrieval. 

 Alarms/warnings 

You can set alarms/warnings either for absolute level or for absolute/relative change 

of vibration levels in a band. When a level is exceeded, the corresponding element in 

the plant hierarchy is marked by an exclamation mark. 

 Reports 

You can easily create and print out a machinery condition report when an inspection 

is completed. 

 Graphical data representation 

Vibrodesigner provides you with a variety of features to display and analyze scalar 

and vector data. While displaying graphs, you use various settings (for example, 

color settings, line thickness and so on.) 

 Trends and prediction 

Flexible mechanisms of creating so-called trend sets of various technological 

parameters enables even an inexperienced specialist to reasonably estimate 

machinery functional reliability. Analyzing graphs, you can build prognoses and 

estimate machinery remaining time before failure. Prediction and warning levels can 

be displayed onscreen to help you in machinery condition analysis. 

 Waveforms and orbits 

Virtually infinite capabilities of waveform analysis. Integrating and differentiating 

vibration data, applying various filters to waveforms and shaft orbits, etc.—all these 

Vibrodesigner features greatly facilitate the work of maintenance engineers. 

 Spectra and spectrograms 

Any specialist will be delighted with our optimal solutions for extended spectrum 

analysis. Fourier transformation of vibration signals, cascade presentation of 

spectrum time dynamics, quick switch between spectrum measurement units, 

logarithmic scaling, harmonic cursors, automatic spectrum peak detection—all that is 

at your fingertips! 
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 Envelope spectra 

By analyzing envelope spectra (frequencies and magnitudes of harmonics), you can 

define parameters of the vibration signal having amplitude modulation due to friction 

unit defects. Typically, this analysis is used for identifying inceptive bearing defects. 

 Cepstra 

Cepstral analysis allows getting spectra from original signal spectra logarithm and 

sometimes helps to detect implicit periodicity of original signal. 

 Daily trends and coast-downs 

Analyzing coast-down graphs may help you solve various vibration diagnostics 

issues, e.g., revealing rotor self-resonance frequencies. Viewing daily trends 

retrospective enables a maintenance engineer to perform effective analysis based on 

historical data. 

 Monitoring real-time data 

You can monitor real-time data captured from remote stationary devices or ASTD-2 

systems on request. This significantly expand abilities of real-time machine 

diagnostics. 

 Calculated parameters 

You can monitor any machine parameters by automatic computing such parameters 

during inspection. Calculated parameters are computed with the specified formulas 

using measured or calculated parameters. You can specify alarm/warning levels for 

calculated parameters and thus automate defect development inspection. 

 User support 

The program is accompanied by a set of documentation, including a user’s manual. 

Registered users are provided with prompt technical consultations and new software 

versions. 

Starting Vibrodesigner 

To start Vibrodesigner: 

1 On the Windows Start menu, point to Programs, and then select Vibrodesigner > 

Standard > Vibrodesigner-Standard. 

If you are starting Vibrodesigner for the first time, the Vibration Unit Systems 

dialog box appears. 
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Figure 12 Vibration Unit Systems dialog box 

2 Select the system of units you are going to work with and click OK. 

3 If you are starting Vibrodesigner for the first time, the Select data collection device 

dialog box appears. 

 
Figure 13 Select data collection device dialog box 

4 From the drop-down list, select the default data collector and click OK. 

The Vibrodesigner main window appears. You can now work with Vibrodesigner. 

For convenience, you may adjust the program interface. For more information, see 

Chapter 9, ―Program Settings.‖ 

Note: The database you have previously been working is opened when 

Vibrodesigner starts. The software will start in the mode in which the 

database to be opened was closed. 

You can also start Vibrodesigner from command prompt. In this case, you need to 

explicitly specify the server (/NETPATH:<server_name>) where the program has been 

installed and the database name (/CONTAINER <db_name>). 
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Software Registration 

When you start the program for the first time, you are informed that your version of 

software is not registered. If you don’t register the program, this notification will be 

displayed each time you launch Vibrodesigner-Standard. 

 
Figure 14 Registration prompt 

A non-registered version of Vibrodesigner can be used as an evaluation demo less than 

60 days starting from the installation date. 

Important! A non-registered version of Vibrodesigner has a limited 

functionality: you can work with the preinstalled demo database only 

with Configuration mode prohibited. 

Registered users are provided with prompt technical consultations and new software 

versions. To register the program, request a license key from Technekon. 

Note: If you have not registered your version, the NOT REGISTERED 

text will be displayed at the top of the main program window and in the 

About dialog box. 

To request a license key: 

1. Send an email to sales@tehnekon.ru with the following information: 

 Your company’s name 

 A user’s name 

 Your email 

 Software Copy ID 

This ID is generated by the program and is displayed in Registration of 

Vibrodesigner-Standard dialog box only. 

Important! These data will be used to generate a license key. Save this 

information for further registration. 

2. After a while, check your email for a license key from Technekon. 

mailto:sales@tehnekon.ru
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To register Vibrodesigner-Standard: 

1. Click the Register Now button. 

The Registration of Vibrodesigner-Standard dialog box appears. 

 
Figure 15 Software registration dialog box 

2. Enter the registration data you previously sent to generate the license key, and the 

license key. 

3. Click the Register Now button. 

The program is registered. 

Vibrodesigner Interface 

This section describes the Vibrodesigner main window, main menu commands and the 

status bar. 
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Vibrodesigner Main Window 

The Vibrodesigner screen consists of the elements described below. 

 
Figure 16 Vibrodesigner main window 

1. Vibrodesigner panel 

The Vibrodesigner view depends on the program working mode (see ―Vibrodesigner 

Working Modes‖). In the Analysis mode, the panel displays the plant hierarchy. 

Choosing the needed machine or a measurements point in the plant hierarchy allows 

you to view the corresponding graphs in the workspace. In the Configuration mode, 

the panel has three tabs. On the Plants tab, you can customize the plant hierarchy 

(see Chapter 5, ―Plant Hierarchy‖). On the Machines tab, you can create and 

customize machine models (see Chapter 5, ―Machine Models‖). On the Elements 

tab, you can create and customize machine element models (see Chapter 5, 

―Machine Element Models‖). 

2. Workspace 

Depending on the working mode, the workspace is used either to view graphical data 

or edit object properties. 

3. Menu 

Provides access to Vibrodesigner commands. 

4. Toolbar 

Provides buttons for the common Vibrodesigner commands. 

5. Status bar 
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Shows the current working mode, the current database, and the name of the object 

selected in the Vibrodesigner panel. 

Main Menu Overview 

The File menu contains commands for: 

 Working with databases 

 Exporting/importing data 

 Recalculating bands and calculated parameters 

 Saving and printing graphical data 

 Quitting Vibrodesigner 

The Edit menu commands are available in the Configuration mode only and intended for 

working with the plant hierarchy objects. 

Using the View menu commands, you can choose the working mode of interest, hide 

some interface elements and change the Vibrodesigner panel view. 

Clicking Settings on the main menu displays the Settings dialog box used to customize 

the program interface and specify the default device. 

The Help menu commands allow you to view the information about the current 

Vibrodesigner version 

Note: For more information about main menu commands, refer to 

Chapter 11, ―Main Menu.‖ 

Status Bar 

The status bar is the area at the bottom of the Vibrodesigner main window. The picture 

below shows an example of the status bar view. 

 
Figure 17 Status bar 

The status bar provides you with the following information: 

 The current working mode 

Vibrodesigner may work in one of the following modes: Analysis, Configuration, 

Comparison, and Real Time. For more information, refer to ―Vibrodesigner Working 

Modes.‖ 

 The name of the open database 

This element displays a name of the database which the user is currently working 

with. 

 The path to a selected object 
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This element displays the path to the object selected in the plant hierarchy in the 

Vibrodesigner panel. 

 The progress indicator 

This element shows the percentage of a particular process that has been completed, 

such as inspection data import. 

Vibrodesigner Working Modes 

Vibrodesigner may work in one of four modes: 

 The Configuration mode 

 The Analysis mode 

 The Comparison mode 

 The Real Time mode
2
 

The Configuration mode is intended for creating a database structure, namely a plant 

hierarchy and a measurement model. Without a plant hierarchy and a monitored 

machinery structure, you cannot perform measurements neither save data in a database. 

 
Figure 18 Configuration mode 

The Analysis mode is intended for recording data from devices into a database and 

viewing/analyzing the collected data. In this mode, you cannot change the plant 

hierarchy. You are only allowed to add data by loading it from a vibration monitoring 

device. 

                                                      

2
 The Real-time mode is activated only after installing a special Vibrodesigner-RT package. 
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You can also switch to the Comparison mode whereby you may simultaneously view 

data from various machines belonged to different machine shops. 

 
Figure 19 Analysis mode 

In the Real time mode, you can analyze real-time data captured directly from ASTD-2
3
 

systems or from connected CTD-2060/2160/3168 monitors on request. The program 

enables you to get and view current spectra, waveforms, orbits, and trend sets of machine 

parameters. 

Note: Configuring the ASTD-2 system is carried out by Technekon’s 

skilled technicians during the system deployment. This work involves 

synchronous setup and testing of machine shop servers and maintenance 

engineers’ workstations (including configuring Vibrodesigner-Standard). 

To select the working mode you need: 

1. From the main menu, select View. 

The View context menu appears. 

                                                      

3
 To view current data, the maintenance engineer’s workstation and ASTD-2 servers must reside 

on the same local network. 



Vibrodesigner User's Guide 

28 

 
Figure 20 Switching between modes 

2. Point to Mode and select the mode of interest—Analysis, Comparison, Real Time, 

and Configuration. 

The selected mode is marked by a dot (●) in the menu. In the picture above, Analysis 

is the active mode. 

Note: The active mode is also displayed on the status bar (in the left 

lower corner of the main program window.) 

Vibrodesigner Configuration Types 

You may deploy one of the following Vibrodesigner configuration types: 

 Local system 

 Network system with local databases 

 Network system with a unified repository of the plant diagnostics data 

 Network System based on ASTD-2 machine shop server 

Local System 

A local system is a typical and most frequently used type of configuration. In this case, a 

maintenance engineer performs all operations on his standalone computer and normally 

within one database. All the data are stored on the same computer. Access to the 

software and the databases is allowed only from the operator’s workstation. If the 

workstation fails, vital diagnostics information may be lost. To prevent accidental loss of 

data, the maintenance engineer has to archive databases regularly. It is the most 

economical configuration. 

Network System with Local Databases 

Additional capabilities become available if Vibrodesigner is installed on several 

workstations connected within the plant local area network (LAN). On each workstation, 

local databases available from other computers can be created. This is a multi-user 
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system. The data are distributed among multiple workstations so that data are available 

from remote computers only when the destination computers are switched on. 

Client-server Configuration 

Vibrodesigner client server architecture is used to centralize control over the plant (or 

any plant division) databases. Typically, this configuration needs a dedicated computer 

(server) to store data. The server, which is powered via an UPS and is running round the 

clock, must be powerful and reliable. The server typically has special systems to improve 

data storage reliability, such as RAID-arrays. Vibrodesigner is installed on the server and 

a unified repository of the diagnostics data
4
 is created, maintained, and regularly backed 

up. The Vibrodesigner applications are also installed on specialist’ workstations, but 

local databases are not created on these computers. A maintenance specialist logs on and 

works with a database of interest stored on the server. This configuration provides a 

unified information environment on the plant to accomplish condition monitoring tasks. 

This is the most reliable and efficient solution. 

The picture below shows an example of the Vibrodesigner client-server architecture. 

 
Figure 21 Client-server architecture 

                                                      

4
 The unified repository of the diagnostics data term does not assume that all the data are stored in 

a single Vibrodesigner database. This might affect the system performance in case of a large plant 

and large amounts of data. The number of databases to be created is not limited, it all depends on 

actual tasks and the plant scale. The unified repository means that all databases are stored and 

maintained centrally and available to all interested specialists. 
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Network ASTD-2 System 

The simplified network ASTD-2 architecture is shown in the picture below. 

 
Figure 22 Network ASTD-2 architecture 

The Vibrodesigner-Standard 3.2 application is an essential part of the automated 

ASTD-2 system. The ASTD-2 is installed on the local network and contains the 

following primary elements: 

 ASTD-2 machine shop server 

 Shift operator’s workstation 

 Maintenance engineer’s workstation 

The machine shop server is a powerful and reliable computer. This computer 

automatically performs the following operations: 

 Collecting data from machines 

 Generating daily trend 

 Generating and storing shift reports and machine inspections 

 Saving machine stops data 

 Sending data files to maintenance engineer’s workstation 

The shift operator’s workstation is intended for online monitoring of machine vibration 

condition. The Vibrodesigner-SCADA software is installed on this workstation. 

The maintenance engineer’s workstation is used for handling vibration diagnostics tasks. 

The Vibrodesigner-Standard software is installed on this computer and thus the entire 

system for condition monitoring and vibration analysis is created. 
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Chapter 4 Quick Start 

This chapter contains a small tutorial that helps you learn how to work with 

Vibrodesigner. 

It covers the following topics: 

 Introduction 

 Creating New Databases 

 Creating Machine Models 

 Creating Plant Hierarchy 

 Working with STD-500 

 Analyzing Collected Data 

Introduction 

This chapter allows you to acquire practical skills in using Vibrodesigner. If you have 

not worked with Vibrodesigner before, it is recommended to read this chapter carefully 

before studying all program features described in the following chapters. It will help you 

become familiar with basic concepts and work with the program professionally later on. 

Here, we provide you with a brief step-by-step procedure of a simplified routine 

performed by a maintenance engineer. To successfully follow all steps of the procedure, 

you need to have an STD-500 monitor with accessories and any source of mechanical 

vibrations. 

We will consider the following major actions: 

1. Creating an empty database. 

2. Creating a machine measurement model from machine element models. 

3. Creating a plant hierarchy. 

4. Working with STD-500. 

5. Analyzing collected data. 

Creating New Databases 

To create a new database: 

1. Start Vibrodesigner. 
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The Vibrodesigner main window appears. In the Analysis mode, the left pane shows 

the object hierarchy, and the data associated with the selected object are displayed on 

the right. By default, the demonstration database is started. 

2. Switch to the Configuration mode by selecting Mode > Configuration from the 

View menu. 

3. On the File menu, click Create database. 

The Create database dialog box appears. 

 
Figure 23 Create Database dialog box 

4. In the Database name box, type a name of the database (for example, ―db1‖) and 

click OK. 

The left Vibrodesigner panel displays the newly created database. The database 

object tree contains only the root element (the database name). The Vibrodesigner 

panel has three tabs. Firstly, on the Elements tab, machine elements are to be 

created. Secondly, on the Machine tab, the created elements are assembled into 

machines. Finally, on the Plants tab, the complete plant hierarchy is created. For 

now, your newly created database has no plants or machines. 

 
Figure 24 Empty database 

After creating a new empty database, you need to create models of machines to be 

inspected. 
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Creating Machine Models 

Creating Machine Element Models 

To create a machine measurement model, you need first to assemble such models from 

separate elements. On this step, you will create element models which can be used 

several times later on. 

1. Click the Elements tab. 

 
Figure 25 Editing element models—the list is empty 

2. To create a machine element model, right-click the root element Models of elements 

and select Create > Machine element model from the menu. 

 
Figure 26 Creating new machine element model 

A new machine element model is now created. The tabs used to adjust element 

parameters are displayed in the workspace on the right. 
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Figure 27 Newly created element model 

3. Rename the newly created model to Engine. To do so, right-click the newly created 

model displayed on the left, select Rename from the menu, and then type in Engine. 

You can rename any machine element in the same way. 

The machine element model is renamed. 

 
Figure 28 Renaming model 

4. On the Properties tab to the right, specify the type of the measurement device (STD-

500 Collector) which will be used to collect vibration data in the engine 

measurement points. 

5. Click the Measurement points tab on the right. The table on this tab displays a list 

of measurement points of the selected element model. As we have not created any 

points so far, the table is empty. 
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Figure 29 Measurement Points tab 

6. Create a 1-channel measurement point on the Engine model. To do so, right-click in 

the measurement point table and select Add 1-channel point from the menu. 

 
Figure 30 Creating measurement point on the element 

A new measurement point is created and consequently a new record is displayed in 

the table. All point parameters are displayed in a row. 

 
Figure 31 Parameters of newly created point 
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Note: The STD-500 data collector registers and measures signals as 

waveforms. 

As a result, you have created an element model named Engine. On the engine, you 

specified one measurement point and set it to collect waves. The data acquisition is 

performed with a portable STD-500 data collector. 

7. Repeat Steps 2-6 to create Turbine and Intermediate Pole elements. For this 

example, each element will contain one measurement point in which waveform type 

of data are to be measured. After creating a point, simply do not modify the default 

value in the Measure cell. 

 
Figure 32 Created point on the Turbine element 

8. Select Engine in the left panel and then click the Monitoring formulas on the right. 

This tab allows you to create machine monitoring parameters to be computed 

automatically with the specified formulas during recording inspection into the 

database. 

9. Click  on the toolbar. 

A new row with default properties appears at the bottom of the table. 

10. Click the Parameter cell and specify a name of the new calculated parameter (Peak-

peak). 

11. In the Unit cell, select the parameter measurement unit of interest from the drop-

down list (mm/s in the Vibration section). 
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Figure 33 Selecting measurement unit 

12. Right-click the Name cell and select Add variable from the menu. 

A new variable with default properties appears in the table. The  icon in the Name 

cell means that you have not selected a data source for the variable. 

13. In the Name cell, specify a name of the variable (wave). 

14. Double-click the Data source cell. 

The Selecting data source dialog box appears. 

 
Figure 34 Selecting data source 

15. Select the Waveform data source and click OK. 

16. From the Dimension list, select Array. 

17. Double-click the Monitoring formula cell. 

The Monitoring formula dialog box appears. 
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Figure 35 Monitoring formula dialog box 

18. Enter the following text into the Monitoring formula dialog box: 

 ‘Calculating peak-peak 

If wave.count > 0 Then  

max=wave.item(0) 

min=wave.item(0) 

For x = 0 To (wave.count - 1) 

Value = wave.item(x) 

If max < value Then 

max = value 

End If 

Next 

Result = (max – min) 

end if 

Note: You must assign the calculated value to the Result variable at the 

end of any monitoring formula. The program retrieves the resultant value 

from this reserved variable. 

19. Click ОК. 
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The first row of the specified formula is displayed in the Monitoring formula cell
5
. 

This formula will be used to automatically calculate a waveform peak-to-peak value 

when recording data into the database after inspection in the engine point. 

 
Figure 36 Peak-peak monitoring formula 

Assembling Machine Model 

Generally, a machine measurement model consists of several standard elements, and 

multiple points are placed on each element. For simplicity, we have created only three 

elements (Engine, Turbine and Intermediate pole) with just one point on each element. 

Now let us build a Machine model with these three Elements. 

1. On the left panel, click the Machines tab. 

 
Figure 37 Machines tab 

2. To create the first object in the machine models list, right-click the root element 

Machine models and select Create > Machine model from the menu. 

                                                      

5
 It is recommended to write comments for the multi-line formula in the first row. 
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Figure 38 Creating new machine model 

3. Rename the newly created model to DG-90 and specify the STD-500 monitor for 

measurements. 

 
Figure 39 Renaming machine model 

On this step, the model itself is created but it has no distinctive features, i.e. 

measurement points. Since all measurement points are created on machine elements, 

you need now to "fill" the model with previously created machine elements (Engine 

and Turbine in this example). 

4. To add machine element models into the machine model, right-click the DG-90 

model and select Add from the menu. 
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Figure 40 Adding machine element 

The Add element model dialog box appears. 

 
Figure 41 Assembling DG-90 model—adding Engine and Turbine elements 

5. Click the Engine element and then click the Add button. 

The Engine element containing its single measurement point appears in the DG-90 

model. 

6. Click the Turbine element and then click the Add button. 

Now, the Turbine element containing a single measurement point also appears in the 

DG-90 model. 

7. Close the Add element model dialog box. 

Note: Modifying measurement point parameters on the Machine tab is 

prohibited. By clicking the Measurement points tab you may only view 

previously created points. You may modify their parameters on the 

Elements tab only; the point parameters will be updated at once in all 

machine models that contain such element models. It is useful since you 

do it once for all machines containing the element with this modified 

point. 
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Figure 42 Assembled DG-90 model 

As a result, we have created a new machine model. It is assumed that our plant has only 

machines of "DG-90" type described by our DG-90 model. Otherwise, we would need to 

create more models corresponding to actual machines in use. 

After creating the machine model, you need to create a plant hierarchy to store data. 

Creating Plant Hierarchy 

Having created a measurement model of the machine, it is necessary to create the 

machine itself. Besides, you need to create a plant hierarchy that repeats the structure of 

the real-world plant. In this example, creating a plant hierarchy involves the following: 

1. Creating a machine shop. 

2. Creating a machine in the machine shop. 

3. Specifying the machine properties, that is, defining its measurement model based on 

the created DG-90 model and specifying a serial number of the machine. 

4. Creating the STD-500 data collector. 

On this step, you build the database and create the structure that will be filled with 

machines. All machines have their measurement points that store collected data. 

Note: All actions are performed in the Configuration mode. 

1. Click the Plants tab. 

2. To create a new plant, right-click the root element db1 and select Create > Plant 

from the menu. 
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Figure 43 Creating plant 

3. To add a new machine shop into the plant, right-click the created plant and select 

Create > Machine shop from the menu. 

 
Figure 44 Creating machine shop within plant 

4. To create a machine within the Machine Shop 1, right-click the created machine shop 

and select Create > Machine from the menu. 

 
Figure 45 Newly created machine within machine shop 

5. Specify the properties of the newly created machine. To do so, select DG-90 from 

the Model drop-down list. 

The Machine 1 now has child elements, the same as in the DG-90 model. 
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Figure 46 Choosing machine model 

6. Create a STD-500 data collector for Machine shop 1. To do so, right-click Machine 

shop 1 and select Create > STD-500 Collector from the menu. 

 
Figure 47 Newly created STD-500 collector for machine shop 

7. Click the Routes tab on the right. 

8. To create a route for the STD-500 collector, click . 

The Create Route dialog box is displayed. 
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Figure 48 Create Route dialog box 

9. Specify a name of the route (e.g. Machine shop 1) and click OK. 

10. Drag the Engine element from the left panel into the right panel, and then drag the 

Turbine element, as shown in the picture below. 

 
Figure 49 Adding measurement points into route 

11. Click the Properties tab on the right. 

12. Specify a version and a serial number of the device at hand, as well as the software 

version used by your STD-500. 

The plant hierarchy is configured (all necessary objects are created). You can now start 

working with the STD-500. In our example, operations in the Configuration mode are 

finished, and you will proceed with the Analysis mode. 

Working with STD-500 

1. Install the STD-500 driver. For more information about the STD-500 driver 

installation, see ―Installing STD-500/510 Driver.‖ 
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2. Connect your STD-500 to any USB port of your workstation. Use a special USB 

cable delivered with STD-500. 

3. Switch to the Analysis mode and then select the device to be connected. 

On the Communication tab on the right, the connection settings are displayed. 

 
Figure 50 Communication tab 

4. Click the Connect button. 

The connection session is established. 

Important! You will fail to establish a connection session if you have 

previously entered incorrect STD-500 version and serial number. 

5. From the Routes list, select the Machine shop 1 route and click the Load Route 

button. 

6. To close the connection session, click the Disconnect button. 

7. Take your STD-500 and go through all route points. 

For information on how to work with STD-500, refer to STD-500 Operation Manual. 

8. Load measured data into the database. To do so, establish a connection session and 

click the Read Data button. 

When loading, you can see the progress indicator. 

9. When done, click the Disconnect button. 

The loaded data become available for analysis. 
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Analyzing Collected Data 

Having loaded the data, you may start to view and analyze it. To begin, select the 

machine measurement point with the measured spectrum or waveform, and click the 

Signals tab in the workspace on the right. You can also switch to the Comparison 

submode by selecting Mode > Comparison on the toolbar. In this mode, you can view 

and compare on one screen measurements from different measurement points and 

machines. 

Let’s briefly consider some aspects of spectrum and waveform analysis. 

 
Figure 51 Viewing spectrum 
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Figure 52 Viewing waveform 

Vibrodesigner provides you with features for detailed analysis of spectrum and 

waveform graphs. In particular, you can change the vertical and horizontal view range 

using the  and  buttons on the toolbar or by dragging the mouse 

pointer in the workspace. 

You can integrate and differentiate signals (the  buttons on the Signals tab) 

and transform waveforms into spectra and vice versa. You can set labels on the graphs. 

To do so, just double-click in the needed location, holding down the CTRL key. For 

more information, refer to Chapter 6, ―Working with Graphical Data.‖ 

We have finished the introductory section. In the following chapters, all Vibrodesigner 

features are described in details. 
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Chapter 5 Configuration Mode 

This chapter describes how to configure your measurement model. 

It covers the following topics: 

 Configuration Overview 

 Machine Element Models 

 Machine Models 

 Plant Hierarchy 

 Configuring Devices 

 Configuring Auto Acquisition 

 Database Structure Import and Export 

Configuration Overview 

With Vibrodesigner, you can accomplish the following tasks: 

 Machinery inspection 

 Condition monitoring 

 Visual data analysis 

 Machinery diagnostics 

Before going to any of these tasks, you need to build the plant hierarchy and to create the 

measurement model by specifying measurement points, measured signals on the points 

and alarm/warning levels. All these operations are done in the Configuration mode. 

The first step in configuring your database is creating the plant hierarchy that matches 

the structure of your real-world plant and contains all the machine types operating in 

your plant. This database structure is used to store diagnostics information, display data 

as a hierarchy of machine locations, and specify measurement and control parameters. 

That's what we call a measurement model of monitored machinery. 

Machine element models and machine models are used to build a measurement model. 

As any machine on the plant consists of standard elements, it is efficient to use element 

models. They are reusable parts that are added in different machines. Each element 

model describes all major element characteristics such as the number and types of 

measurement points; settings for signal and parameter measurements. It allows you to 

reuse once created models. From the condition monitoring point of view, machine 

models built with element models do fully define any machine. Thus, you need to create 

every point and measurement parameter only once. And it allows you to quickly modify 



Vibrodesigner User's Guide 

50 

parameters in a model, since it will automatically spread to all elements and machines 

built from this model, no matter how many of them exist. 

Typically, creating a plant hierarchy and a measurement model involves the following: 

1. Creating an empty database. 

2. Creating a plant hierarchy to the level of machines. 

This step includes creating plants, stations, divisions, and machine shops. 

3. Creating machine element models. 

On this step, you create measurement points of machine elements, including 2-

channel points. Then, for each point you specify transducer orientation, measured 

and computed signals, and alarm/warning levels. 

Note: Before configuring a point of a machine element model, you need 

to correctly specify a type of the measurement device used to retrieve or 

collect data to be recorded into measurement points. 

Vibrodesigner automatically checks whether the entered measurement 

parameters do match the capabilities of the specified device. It prevents 

from recording prohibited values into the database. 

4. Creating machine models. 

For each machine model, you specify the number and types of machine elements, 

define the sequence of elements connection, and specify the number of measurement 

points. If you have specified relative frequency bands in elements, you also need to 

match the fundamental frequency multipliers with the measurement points where 

these fundamental frequencies are measured. 

5. Creating machines of a predefined type in the hierarchy. 

You specify serial numbers of machines and other relevant information. 

6. Creating inspection routes. 

Inspection routes specify in which points, on which machines and in which order the 

measurements are to be performed. You may create multiple inspection routes but a 

single inspection route must include at least one inspection of one machine.  

7. Specifying data collectors used for measurements. 

You may specify several devices. Measured signal parameters and inspection routes 

must match the capabilities of the devices in use. 

Creating Database 

To create a new database: 

1. Switch to the Configuration mode by selecting Mode > Configuration from the 

View menu. 

2. On the File menu, click Create database. 
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The Create database dialog box appears. 

 
Figure 53 Create Database dialog box 

3. In the Database name box, type a name of the database (for example, ―db1‖) and 

click OK. 

The left Vibrodesigner panel displays the newly created database. The database 

object tree contains only the root element (the database name). The Vibrodesigner 

panel has three tabs. Firstly, on the Elements tab, machine elements are to be 

created. Secondly, on the Machines tab, the created elements are assembled into 

machines. Finally, on the Plants tab, the complete plant hierarchy is created. For 

now, your newly created database has no plants or machines. 

 
Figure 54 Empty database 

4. To specify recommendation to be displayed in the inspection reports, click the 

Recommendations tab on the right. 
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Figure 55 Recommendations tab 

5. The Recommendations tab displays the preset recommendations by default. You 

can modify this list of recommendations. To add a new recommendation, click the 

Add button. 

A new item appears on the recommendations list. 

6. Click the item and type the recommendation you need. 

Note: The recommendation ID in Vibrodesigner must match the 

recommendation ID in the ASTD-2 system. Setting up this 

correspondence is performed when configuring the ASTD-2 system. 

Machine Element Models 

Introduction 

A machine element is a part of a machine that can work separately. A machine element 

does not perform a particular technological task. Examples of machine elements are: 

engines, turbines and so on. As well as a complete machine, a machine element can be 

monitored. A machine element is completely described by the model of this machine 

element. 

A machine element model is a type of machine element as those types are set in the 

manufacturer classification. A machine element model describes all element 
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characteristics essential for monitoring (number and names of measurement points and 

parameters, possible frequency bands, and alarms/warnings thresholds.) 

Note: A machine element model cannot contain any other machine 

element models. A machine element model can be a part of more than 

one machine model. For information on machine models, refer to 

―Machine Models.‖ 

Using Machine Element Models 

Machine element models do not exist in the real world. A machine element model is a 

template used to build inside a database records of multiple machines with their 

respective sets of predefined elements. In other words, the main purpose of a machine 

element model is to define all necessary settings for diagnostics tasks on any machine 

element of this model. Element models are typical units and you can work with them 

uniformly and repetitively. Modifying parameters of a machine element model changes 

characteristics of every corresponding element composing various machines. 

A machine element model includes: 

 Measurement points 

 Measured signals (spectra and waveforms) and their characteristics 

 Absolute or relative frequency bands and their characteristics 

 Band alarm/warning levels 

 Calculated parameters (monitoring formulas) of an element 

 Calculated parameters alarms 

Note: A machine element model cannot include any route or data 

collector. 

How to Create and Adjust Element Models 

Generally, creating and adjusting a machine element model in Vibrodesigner is done as 

follows: 

1. Creating a model and specifying its properties. 

First, an empty model of a standard element is created and its common properties are 

specified. 

2. Creating fundamental frequencies. 

You specify fundamental frequencies (shafts) linked with the element model. 

3. Creating measurement points on a machine element. 

Main parameters of any measurement point are transducer orientation and measured 

signal type. You can create either 1-channel or 2-channel measurement points. You 

can specify waveform, spectrum, or envelope spectrum as a measured signal type 

(depending on the data collector in use.) 
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4. Adjusting measured signal properties in each measurement point. 

For each signal type, you may customize different properties, for example, the 

number of samples for waveforms; the number of spectrum lines for spectra; upper 

frequency limit of a measurement, and so on. 

5. If necessary, specifying a set of frequency bands used to monitor machinery 

condition. 

You can customize as many absolute or relative frequency bands as needed 

(Vibrodesigner calculates RMS of spectrum magnitudes in the specified band.) If 

you plan to use relative (a.k.a. shaft speed tracking) bands, you need first to set 

fundamental frequencies (see ―Adjusting Relative Bands‖ later in this chapter). 

6. If necessary, specifying a set of calculated parameters (monitoring formulas) used to 

monitor a machine element condition. 

7. Specifying alarm/warning levels for each created band or calculated parameter. 

These levels are used to automatically monitor vibration by parameter value or by 

speed of parameter change. 

You may specify any set of the following types of alarm level: 

 Warning for absolute value of the monitored parameter 

 Warning for absolute change of the monitored parameter 

 Warning for relative change of the monitored parameter 

Creating Element Models and Specifying Model Parameters 

Machine element models are created or modified on the Elements tab in the 

Configuration mode. Creating machine element models is done by a context menu of the 

hierarchy root element. 

 
Figure 56 Creating machine element model 

Each model has a set of the following properties: 

 A type of the device intended for vibration measurement (mandatory parameter) 

 Machine element manufacturer 

 Short text description 

 A scheme or a picture of the element model 

An element model properties are specified on the Properties tab. 
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Figure 57 Element model properties 

To select a picture for the machine model: 

1. Click the Model scheme button. 

The Open dialog box appears. 

 
Figure 58 Open dialog box 

2. Select the file you need and click the Open button. 

The selected image is displayed on the Properties tab. 

Note: You can select files in BMP format only. 

The empty machine element—even with specified properties—has no functionality. 

After creating an empty element, you must specify measured and calculated vibration 

characteristics. 

Specifying Fundamental Frequencies 

A fundamental frequency is a current rotation speed of a shaft. Fundamental frequencies 

are used to configure relative bands. For more information, see ―.‖ 
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To set fundamental frequencies for a machine element model: 

1. On the Elements tab, select the machine element you need. 

2. Select the Fundamental frequencies tab on the right. 

A list of fundamental frequencies is displayed. By default, the list is empty. 

Fundamental frequency values are specified as logical names N1, N2 … Since we do 

not have yet any point of rotation frequency measurement, these names are used for 

the algorithm of relative band calculation. Later in this manual (see ―Linking 

Fundamental Frequencies to Measurement Points‖) we will discuss how to link a 

fundamental frequency to a shaft frequency measurement point. 

 
Figure 59 Creating fundamental frequencies 

3. Right-click in the table of fundamental frequencies and select Create from the menu. 

A new record appears in the list of fundamental frequencies. In the Fundamental 

frequency column, fundamental frequency values are displayed in 

N<frequency_multiplier> format. You can add comments in the next column but you 

are not allowed to change fundamental frequency names. 

4. Create all the fundamental frequencies you need. 

If you need to delete a fundamental frequency, select the frequency to be deleted and 

use the Delete context menu command. 

Note: When building a machine model, you must link its fundamental 

frequencies to the measurement points. For more information, see 

―Linking Fundamental Frequencies to Measurement Points‖ later in this 

chapter. 

Measurement Points Overview 

Measurement points and their properties completely describe an element measurement 

model. There are two types of points: 

 1-channel measurement point 

In the Vibrodesigner software and throughout this manual, a 1-channel measurement 

point is called a measurement point, or a point. A measurement point is characterized 

by a type of measured parameter. There are four types of a measured data parameter: 
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 Waveform 

 Spectrum 

 Envelope spectrum 

 Parameter 

 2-channel measurement point 

Measurements in a 2-channel point are done via two channels. The parameters in 

both channels are the same (see ―Creating and Editing Measurement Points‖), except 

for transducer orientation and transducer parameters. Each channel of a 2-channel 

point is characterized by one of the following measured type: 

 Waveform 

 Spectrum 

These signals specify which values are measured by a data collector. 

As a rule, knowing measured signals is not enough for analysis. If you measure a 

waveform (for example, with CTD-2060), you need the software to compute a spectrum 

from the waveform and calculate spectrum parameters (RMS in frequency bands). 

Although CTD-2060/2160 collect all initial data, spectrum parameters are not measured 

directly by these devices. Vibrodesigner computes all spectrum parameters. For this 

purpose, the software has an algorithm of computed frequency bands in points of both 

types (waveform and spectrum). 

Measurement Point Editor Overview 

The measurement point editor is an electronic worksheet that allows you to create and 

modify points of a machine element. Working with the editor is similar to working with 

Microsoft Excel. An intuitive user interface allows you to easily create measurement 

points and modify their parameters. The editor controls the user input and does not allow 

the operator to enter inappropriate values. 

In this editor, you can: 

 Add a row (at the bottom of the table) 

 Duplicate the selected row 

 Copy a row 

 Paste a row (below the selected row) 

 Replace a row 

 Move a row up and down 

 Delete a row 

You can perform the following actions with a Bands sub-row of the selected point: 

 Add a sub-row (at the bottom of the Bands table) 

 Paste a sub-row (below the selected sub-row) 
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 Replace a sub-row 

 Move a sub-row up and down 

 Delete a sub-row 

As a monitored parameter, you can use an absolute band, relative band, peak, or peak-

peak. 

For each machine element, you can create all needed measurement point and specify its 

parameters. You may perform various actions with existing measurement points: 

duplicate points; copy and then paste or replace points; change the points order; delete 

points. You can also add comments for a table row, which will be displayed when resting 

the mouse pointer over the Point cell. 

For more information on this editor, see Appendixes, ―Measurement Point Editor.‖ 

Editing Measurement Parameters 

Measurement signal parameters depend on the device in use. Using various Technekon’s 

online/offline devices, you can measure: 

 Waveform 

 Spectrum 

 Envelope spectrum 

 Vibration parameter 

For more information on device parameters, refer to Appendixes, ―Measurement 

Parameters for Different Devices.‖ 

Creating and Editing Bands 

You can define frequency bands computed from measured signals in machine element 

points. Frequency bands can be calculated in the measurement points with Spectrum, 

Envelope spectrum and Waveform parameters. You can create bands with absolute 

frequency range or relative (tracking) bands. First, you need create the band itself, then 

select the band type (absolute or relative), and finally adjust band parameters. 

Note: Before adjusting parameters of a relative band, you need to create 

fundamental frequencies (see ―Specifying Fundamental Frequencies‖). 

When creating a complete machine model, you must link these 

frequencies to measurement points of shaft rotation frequencies. For 

more information, see ―Linking Fundamental Frequencies to 

Measurement Points‖ later in this chapter. 

For detailed instructions on how to create and edit bands, refer to Appendixes, ―How to 

Create and Edit Bands.‖ 
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Adjusting Absolute Bands 

For more information on how to adjust absolute bands, refer to Appendixes, ―Adjusting 

Absolute Band.‖ 

Adjusting Relative Bands 

Before adjusting a relative band, you need first to define fundamental frequencies for a 

machine element model. The actual range of a relative band depends on the fundamental 

frequency in use and is constantly changed over time. Hence, for calculating RMS in a 

relative band: 

1. The center frequency is calculated. 

This frequency is linked to the shaft rotation frequency. The fundamental frequency 

value is not defined explicitly as this value is measured at the moment of calculation 

and depends on the machine operating mode. 

2. The band limits are calculated. 

RMS in the band frequency range is calculated in accordance with the lower and 

upper frequencies of the band. 

Having created fundamental frequencies, you may adjust your relative bands. 

To adjust relative bands for a machine element: 

1. Click the Measurement points tab. 

2. In the Type cell of the band you need, select a band type from the drop-down list.  

3. Specify the center frequency. 

4. Specify the lower frequency of the band. 

5. Specify the upper frequency of the band. 

6. If necessary, clear the Calc. check box. 

The program can either automatically calculate RMS in the configured band, or 

retrieve RMS value from inspection data (if any). 

Monitoring Formulas for Element Models 

You can create calculated parameters
6
 and formulas for calculation for machine element 

models. 

To create a calculated parameter for an element model: 

1. Select a target machine element on the Elements tab. 

2. Select the Monitoring formulas tab on the right. 

                                                      

6
 Calculated parameters are scalar values computed from current measured or calculated machine 

parameters using specified formulas. 
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3. To add a new calculated parameter in the table, right-click in the table and select 

Create parameter from the menu. You can also click  on the toolbar. 

A new row with the default properties appears at the bottom of the table.  

4. In the Parameter cell, type the name of the parameter. 

5. In the Unit cell, select the parameter measurement unit of interest from the drop-

down list. 

6. In the Variables group cell, specify all the needed variables to be used in the 

monitoring formula. 

7. Double-click the Monitoring formula cell. 

The Monitoring formula dialog box appears. 

8. Specify the formula to be used for computing the parameter. 

9. If necessary, specify alarms/warnings for the calculated parameter. To do so, click 

the «-» sign in the A/W Levels column and then enter the needed values in the cells.  

Note: For more information on how to work with monitoring formulas 

editor, see Appendixes, ―Configuring Calculated Parameters.‖ 

Exporting/Importing Element Models 

You can export and import element models. Exporting data allows you to save into file 

the model structure. Importing allows you to upload the element models exported before. 

Thus, you can use standard element models and significantly save your time while 

creating a plant structure. 

To export element models: 

1. On the Elements tab, right-click the name of the element model to be exported (or 

the root Element models node) and select Export structure from the menu. 

The Export to file dialog box appears. 

2. Select the target folder, type the file name you need in the File name box, and then 

click the Save button. 

The export of the selected object structure is started. When finished, the successful 

message is displayed. 

3. Click OK. 

To import a database structure: 

1. Right-click the root Element models node where you need to import a structure and 

select Import structure from the menu. 

The Import from file dialog box appears. 

2. Select the file for import and click the Open button. 

The import is started. When finished, the successful message is displayed. 
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3. Click OK. 

Machine Models 

Machine Models Overview 

From the diagnostics point of view, a machine model does completely describe the 

machine. For each machine model, a configuration of machine element models is 

defined. 

For each machine, its model defines: 

 An assembly of elements into a machine 

 General information about the machine model 

Important! Each machine model requires one or more machine element 

models, as only machine element models contain information about 

measurement points. 

Using Machine Models 

Machine models do not exist in the real world. These models are standard units inside 

your database and you can work with them uniformly and repetitively. In other words, a 

machine model is a template used for creating multiple machines with identical 

parameters. Modifying a machine model parameter makes all machines of this model 

change their characteristics accordingly and simultaneously. The main purpose of a 

machine model is to define once all the necessary settings for doing later all diagnostics 

tasks on all machines of this model. 

A machine model consists of: 

 Machine element models 

 All objects composing the machine element models 

Note: A machine model may not include an inspection route, but cannot 

include a data retrieval device. 

Relations between Element Models, Machine Models and Machines 

Should be noted the following relations between the concepts of machine element model, 

machine model and the actual machine. 

1. Modifying characteristics of machine element models results in changing the same 

characteristics of all models of the machines containing the changed element model. 

2. A new machine in a plant hierarchy is build using one of the previously created 

machine models. 

3. Modifying characteristics of a machine model results in changing the same 

characteristics of all machines created on the basis of the changed model. The only 
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exception is some parameters that describe a particular machine instance (for 

example, a serial number). 

4. Modifying common parameters of a signal and alarms/warnings of an element model 

affects all signals and alarms/warnings belonging to the actual elements created on 

the basis of the changed models. 

5. You can modify characteristics of a machine element model in the following cases: 

 All changes are enabled when no machines contain any data in any element model 

composing these machine model. 

 If at least one machine contains data under this machine element model, you are 

going to be prompted to delete such data. If confirmed, the data are removed and 

then all changes are enabled. 

 If at least one machine contains data under this machine element model, you can 

change the properties that do not affect data measurement and calculation. 

 In case of adding new elements. If a new frequency band is added, the data 

recalculation is required. For more information, see Chapter 6, ―Recalculating 

Bands.‖ 

6. You can modify characteristics of a machine model in the following cases: 

 All changes are enabled when no machines based on this model contain any data 

defined under this machine model. 

 If at least one machine contains data under this machine model, you are prompted to 

delete such data. If confirmed, the data are removed and then all changes are 

enabled. 

 If at least one machine contains data under this machine model, you can change the 

properties that do not affect data measurement and calculation. 

 In case of adding new machine elements. 

How to Create and Adjust Machine Models 

In Vibrodesigner, machine models are made of machine element models. Assembling 

machine models is possible only after creating all necessary element models. 

Creating a machine model involves the following steps: 

1. Creating a model and adjusting its properties. 

The empty model is created first and then the model properties are specified. 

2. Assembling the machine model. 

On this step, the contents of the model is specified, i.e. the previously created 

machine elements are added into the machine model. 

3. If fundamental frequencies have been set for machine element, you need to link the 

fundamental frequencies to the measurement points within the machine model. 

4. If necessary, specify a set of calculated parameters (monitoring formulas) used to 

monitor a machine condition. 
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5. Typically, you need to set alarms to automatically monitor calculated parameters by 

value or change. 

6. Configuring trend sets. 

You can specify any trend sets, that is, sets of parameters which are to be displayed 

during analysis. 

7. Configuring a stationary device for measurements. 

If you plan to retrieve data for a certain machine model through a stationary device, 

you also need to configure such a device (see ―Configuring Stationary Devices‖). 

Creating and modifying machine models is performed on the Machines tab in the 

Configuration mode. 

 
Figure 60 Machine models 

Creating Machine Models 

To create a machine model, use a context menu of the hierarchy root element. 
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Figure 61 Creating machine model 

Each model has a set of the following properties: 

 A type of the data collector used for vibration measurement (mandatory parameter) 

This parameter is used to filter element models to be included in a machine model. 

The data collector specified for a machine model and for its nested element models 

must be the same. 

 Machine manufacturer 

 Graphical scheme of the model 

A model properties are specified on the Properties tab. 

 
Figure 62 Properties of machine model 

To select a picture for the machine model: 

1. Click the Model scheme button. 

The Open dialog box appears. 
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Figure 63 Open dialog box 

2. Select the file you need and click the Open button. 

The selected image is displayed on the Properties tab.  

Note: You can select files in BMP format only. 

Assembling Machine Models from Elements 

The empty machine model—even with specified properties—has no functionality. After 

creating an empty model, you must assemble the model from previously created 

elements. 

To add machine element models into a machine model: 

1. Right-click the machine model you need and select Add from the menu. 

 
Figure 64 Adding machine element 

The Add element model dialog box appears. 
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Figure 65 Assembling machine model from elements 

2. Select the element model(s) you need and click the Add button. 

Note: You can select more than one element at once if you hold down 

CTRL or SHIFT keys. 

The selected elements appear in the machine model hierarchy. 

 
Figure 66 Assembled machine model 

3. Close the Add element model dialog box. 

Element models are not modified on the Machines tab. On this tab, you cannot add, 

delete, or rename the measurement points belonging to the machine element model. To 

modify point parameters, navigate to the Elements tab whereby you can change the 

needed element. The changes affect all machine models made of the modified machine 

element. On the Machines tab, you can only view measurement points by clicking either 

a name of the machine model or a name of the element model. The picture below shows 

how to display points by clicking a name of the machine model. 
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Figure 67 Measurement point parameters on element model—the 

parameters are not modified in the machine tree 

You can also display measurement points of each machine element model by selecting it 

in the tree. 

 
Figure 68 Viewing point parameters on machine element 

Linking Fundamental Frequencies to Measurement Points 

To customize relative bands, you need to link created fundamental frequencies (see 

―Adjusting Relative Bands‖) to the measurement points. 

To link fundamental frequencies to measurement points: 

1. On the left Vibrodesigner panel, click the Machines tab. 
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2. Create a machine model. 

3. Add the machine element models in the newly created machine model. 

Once done, the machine model has the rotation frequency measurement points that is 

the data source for fundamental frequency values. 

4. Click the Fundamental Frequencies tab on the right. 

5. For each element model of the machine model, link the fundamental frequencies to 

the measurement points. 

 
Figure 69 Linking fundamental frequencies to measurement points—LPC 

rotations, HPC rotations, and FT rotations points can be linked 

Note: You cannot create new fundamental frequencies on the 

Fundamental Frequencies tab. Such frequencies are created for 

machine element models only. 

Monitoring Formulas for Machine Models 

You can create calculated parameters
7
 and formulas for calculation for machine models. 

To create a calculated parameter for an machine model: 

1. Select a target machine model on the Machines tab. 

2. Select the Monitoring formulas tab on the right. 

3. To add a new calculated parameter in the table, right-click in the table and select 

Create parameter from the menu. You can also click  on the toolbar. 

                                                      

7
 Calculated parameters are scalar values computed from current measured or calculated machine 

parameters using specified formulas. 
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A new row with the default properties appears at the bottom of the table.  

4. In the Parameter cell, type the name of the parameter. 

5. In the Unit cell, select the parameter measurement unit of interest from the drop-

down list. 

6. In the Variables group cell, specify all the needed variables to be used in the 

monitoring formula. 

7. Double-click the Monitoring formula cell. 

The Monitoring formula dialog box appears. 

8. Specify the formula to be used for computing the parameter. 

9. If necessary, specify alarms/warnings for the calculated parameter. To do so, click 

the «-» sign in the A/W Levels column and then enter the needed values in the cells.  

Note: For more information on how to work with monitoring formulas 

editor, see Appendixes, ―Configuring Calculated Parameters.‖ 

Creating Trend Sets 

You can create a number of parameter trend sets for each machine model to enable 

analyzing multiple parameters trends simultaneously. You may add the same parameter 

in various trend sets. 

To create a trend set for a machine model: 

1. Select the Machines tab on the right and then select the machine model of interest. 

2. Click the Trend Sets tab on the right. 

Two panels for configuring trend sets are displayed. In the left panel, you can see all 

available parameters. At the top of the right panel, you can see the drop-down list 

that contains existing trend sets. On selecting the trend set from this list, the trend set 

parameters are displayed below. 
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Figure 70 Trend Sets tab 

3. Click the Create button. 

The Create dialog box appears. 

 
Figure 71 Create dialog box 

4. Type a name of the new trend set and click OK. 

The created trend set is displayed in the drop-down list in the right panel. 

5. In the left panel, select the parameters you need and click the Add button. 

The selected parameters are displayed in the right panel. 

Note: You can also select more than one parameter at a time, holding 

CTRL or SHIFT down. 

To modify a parameters list of the trend set: 

1. From the drop-down list on the right, select the trend set of interest. 
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2. To add parameters into the trend set, select the parameters you need and click the 

Add button. 

3. To remove parameters from the trend set, in the right panel select the parameters to 

be removed and click the Remove button. 

You can save the selected trend set with another name. This will allow you to create a 

new trend set with pre-created parameters and thus save your time. 

To save a trend set with another name: 

1. From the drop-down list on the right, select the trend set to be saved with another 

name and click the Save As button. 

The Save As dialog box appears. 

 
Figure 72 Save as dialog box 

2. Type a name of the new trend set and click OK. 

The new trend set containing parameters of the selected trend set is created. 

To delete a trend set: 

1. From the drop-down list on the right, select the trend set to be deleted and click the 

Delete button. 

You are prompted to confirm the operation. 

2. Click Yes. 

The selected trend set is deleted. 

Configuring Stationary Devices 

If you plan to retrieve data from machine of a certain model via a stationary monitor, you 

have to add this monitor into the machine model. Then, you need to link monitor’s 

channels to machine model measurement points. This will allow you to promptly replace 

the mounted monitor without any changes in the database structure. Besides, it allows 

creating standard machine models containing preconfigured monitors. 

To create a stationary monitor in the machine model: 

1. Right-click the machine model of interest and select a name of the device from the 

Create menu. 

The monitor is created and displayed at the bottom of the element models list. In the 

workspace on the right, you can see a panel used to configure the device properties. 
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In the Vibration channels table, you need to match the monitor vibration channels 

and machine model points. In the Tacho Channels table, you need to match the 

monitor tachometric channels and rotation speed points of the machine model. 

2. To match a monitor channel and a measurement point, right-click the channel 

number in the Vibration channels table and select the needed point from the menu. 

3. Match all vibration channels and measurement point you need. 

4. If necessary, match rotation speed channels and measurement points you need. 

Note: For more information on configuring certain data monitors, see 

―Configuring Stationary Devices.‖ 

Exporting/Importing Machine Models 

You can export and import machine models. Exporting data allows you to save into file 

the model structure. Importing allows you to upload the machine models exported before. 

Thus, you can use standard machine models and significantly save your time while 

creating a plant structure. 

To export machine models: 

1. On the Machines tab, right-click the name of the model to be exported (or the root 

Machine models node) and select Export structure from the menu. 

The Export to file dialog box appears. 

2. Select the target folder, type the file name you need in the File name box, and then 

click the Save button. 

The export of the selected object structure is started. When finished, the successful 

message is displayed. 

3. Click OK. 

To import machine models: 

1. Right-click the root Machine models node where you need to import a structure and 

select Import structure from the menu. 

The Import from file dialog box appears. 

2. Select the file for import and click the Open button. 

The import is started. When finished, the successful message is displayed. 

3. Click OK. 

Plant Hierarchy 

Introduction 

From the vibration diagnostics point of view, a plant hierarchy describes the structure of 

your real-world plant and contains all the machine types operating in your plant. First, 
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you create an empty database, then add information about existing divisions and machine 

shops, and finally specify monitored machinery, data collectors, and inspection routes. 

A plant structure is a hierarchical list (tree). This tree is formed in the Configuration 

mode on the Plants tab. 

 
Figure 73 Plant hierarchy 

Your database may contain various plants which structures represent the structures of 

real-world plants. An example of the plant hierarchy is shown in the picture below. 
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Figure 74 Plant hierarchy example 

The first element in the hierarchy is always the root plant that may include one or more 

child plants. Child plants may include stations, divisions and machine shops. A station 

may include divisions or machine shops. A division may include child divisions, stations 

and machine shops. Machines are placed in machine shops. Besides, every hierarchy 

level may contain routes and devices. For convenience, routes and devices may be 

grouped. 

To create an object on a certain level of hierarchy (for example, to create a machine in 

the machine shop), use a context menu. 
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Figure 75 Creating machine within machine shop—all hierarchy is created 

in the same way 

When you created an object, you are prompted to specify its properties in the right pane. 

Object properties are described in the following sections. 

Creating and Opening Databases 

The complete plant hierarchy is stored in a database. The database created by a user on a 

local computer becomes available to all users on the local network
8
. All changes made by 

one user are displayed on workstations of other users. For more information about 

Vibrodesigner architecture, see Chapter 3, ―Vibrodesigner Configuration Types.‖ 

To create a new database: 

1. On the File menu, click Create Database. 

The Create Database dialog box appears. 

                                                      

8
 You have to configure Windows security settings as described in ―Windows Security Settings for 

Remote Access.‖ 
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Figure 76 Create Database dialog box 

2. In the Database name box, type the database name you need. 

3. Click OK. 

A new database is created. You can now start configure a plant hierarchy. 

You may work with various databases. Thus, in addition to creating a new database from 

scratch, you can open an existing database and modify its structure. 

To open an existing database: 

1. On the File menu, select Open database. 

The Open Database dialog box appears. 

 
Figure 77 Open Database dialog box 

2. If the database of interest is stored on a remote computer, clear the Locally check 

box and then select the needed database server from the Computer name list. 

In the Database name box, a name of the database you opened for the last time on 

your computer is displayed. Clicking the arrow in this box shows the list of the 

databases stored on the specified computer. 

3. From the Database name list, select the database you need. 

Note: If the database you need is stored locally, select the Locally check 

box and select the needed local database from the Database name list. 

4. Click OK. 

The selected database is opened. 
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Plant 

A plant is a root object in the plant hierarchy. All structure of the modeled plant is 

placed under the Plant object. Plant properties are the following: 

 Plant name 

 Plant identification code 

 Short text description 

 
Figure 78 Plant properties 

Station 

A station is the object of a plant hierarchy located under a plant or a division. A station 

may include divisions and machine shops. Station properties are the following: 

 Station name 

 Station identification code 

 Short text description 
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Figure 79 Station properties 

Division 

A division is the object of a plant hierarchy located under a plant, a station or another 

division. A division may include stations, machine shops and other divisions. Division 

properties are the following: 

 Division name 

 Division identification code 

 Short text description 

 
Figure 80 Division properties 
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Machine Shop 

A machine shop is the object of a plant hierarchy located under a plant, a station or a 

division. A division contains machines. Machine shop properties include the following: 

 Machine shop name 

 Machine shop identification code 

 Short text description 

 
Figure 81 Machine shop properties 

For each machine shop, you can specify on the Data source tab a computer name and the 

folders that contain coast-downs and daily trends archives. Coast-downs and daily trend 

files can be retrieved from the online machine shop systems. Coast-downs and daily 

trend retrospective can be then displayed in the Analysis mode. 

 
Figure 82 Coast-downs and daily trends locations 
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Machine 

From the vibration diagnostics point of view, a machine is the equipment for condition 

monitoring and hence a main object in the hierarchy. A machine is an electromechanical 

system designed to perform a particular technological task on the plant. Machines are 

located in machine shops. A machine consists of one or more machine elements, for 

example, engine, turbine and so on. Machine properties include the following: 

 Machine model 

The main property of a machine. A model is selected from the list of predefined 

machine models. 

 Data collector type applied for the machine 

 Machine manufacturer 

 Short text description 

 Model scheme 

 
Figure 83 Machine properties 

After adding element models, the machine will have the components with measurement 

points. You can view all measurement points by clicking either a name of the machine 

model or a name of the element model. Measurement points on machine level are not 

modified. For more information about machine models, see ―Machine Models‖ earlier in 

this chapter. 
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Figure 84 Viewing points of the element belonged to machine 

Machine Element 

A machine element is a part of the machine that can operate separately. A machine 

element does not perform a particular technological task. The examples of machine 

elements are engine, turbine and so on. As well as a complete machine, a machine 

element can be monitored. 

Machine elements appear in the hierarchy after selecting a machine model that set all 

major element characteristics, i.e. the number and names of measurement points, 

measurement parameters, possible diagnoses and messages (events), recommendations 

and so on. For more information about machine elements, see ―Machine Element 

Models‖ earlier in this chapter. 

Devices 

Devices are used to measure signals and save data in a database. It does not matter which 

plant hierarchy level devices occupy. Device properties include the following: 

 Device name 

 Device type 

 Device version 

 Device serial number 

 Short text description 

 Transducer information 

 Measurement unit that defines which parameter is measured by the transducer 

 Transducer sensitivity. 

For more information about devices, see ―Configuring Devices‖. 
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Editing Plant Hierarchy 

To edit a plant hierarchy, you can use a context menu commands. All described below 

actions are applied both to a structure of machine models and a structure of machine 

element models. A context menu of hierarchy object is shown in the picture below. 

 
Figure 85 Context menu of hierarchy object 

The table below describes the context menu commands. 

Context menu commands of a hierarchy object 

MENU COMMAND DESCRIPTION 

Delete Delete the selected hierarchy object. 

Rename Rename the selected object of the plant hierarchy. 

Move up Move the selected object (or the measurement point) one 
level up in the hierarchy. 

Move down Move the selected object (or the measurement point) one 
level down in the hierarchy. 

Cut Cut the selected object to the Clipboard. 

Copy Copy the selected object to the Clipboard. 

Paste Paste the object from the Clipboard to the specified 
location. 

Export structure  Export the selected data structure into a text file. For 
more information, see ―Exporting Database Structure.‖ 

Import structure Import the data structure from a text file. For more 
information, see ―Importing Database Structure.‖ 
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MENU COMMAND DESCRIPTION 

Undo  Cancel the last operation. 

 

When pasting an object, a new window is displayed whereby you can rename the object 

and confirm/cancel the operation. 

 
Figure 86 Copying elements 

Note: You can modify: 

a plant hierarchy down to machines level 

a machine model structure down to elements level. 

Managing Hierarchy Viewing Modes 

Plant Hierarchy 

While viewing a plant hierarchy, you can display each machine shop and machine 

separately. It is useful when a plant contains many machines and machine shops. For this 

purpose, use the Machine and Machine shop commands from the View menu. 
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Figure 87 Machine shop and Machine commands are used to view these 

objects in a convenient way 

Selecting the Machine shop command transforms the plant hierarchy on the left panel to 

provide easy navigation through machine shops. 

 
Figure 88 Plant hierarchy after selecting Machine shop command 

Switching between machine shops is performed by selecting the element of interest from 

the drop-down list. You can also create a new machine shop after selecting <New 

machine shop> from the drop-down list. 

 
Figure 89 Creating new machine shop 

Selecting the Machine command transforms the plant hierarchy on the left panel to 

provide easy navigation through machine shops and machines. 
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Figure 90 Plant hierarchy after selecting Machine command 

To switch between machine shops, select the element of interest from the upper drop-

down list. To switch between machines, select the element of interest from the lower 

drop-down list. You can create a new machine shop after selecting <New machine 

shop> from the upper drop-down list. You can also create a new machine after selecting 

<New machine > from the lower drop-down list. 

Machine Models and Elements 

You can display machine models in drop-down lists on the Machines tab. To do so, 

select List View from the View menu. 

 
Figure 91 Viewing model list of machine elements 

You can also display machine element models in drop-down lists on the Elements tab. 

To do so, select List View from the View menu. Working with these lists is similar to 

working with machine and machine shop lists. 

Configuring Devices 

This section describes how to create and adjust data collectors and analyzers in the 

Vibrodesigner-Standard application. 
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Configuring Portable Devices 

The new generation of Technekon’s portable devices— STD-500, STD-510 and 

STD-3300—is designed to effectively perform inspections manually. An operator works 

with such devices in a similar way.  

You can create portable devices at any level of plant hierarchy (plant, machine shop, 

station and so on). 

Note: Portable devices are created on the machine shop level only. 

STD-500 Data Collector 

To add a STD-500 data collector into the plant hierarchy: 

1. Right-click the hierarchy object of interest and select Create > STD-500 Collector 

from the menu. 

The device appears in the plant hierarchy and at the same time the device properties 

are displayed on the right. 

 
Figure 92 STD-500 properties 

2. Specify a version and a serial number of the device at hand, as well as the software 

version used by your STD-500. 

3. Click the Routes tab and link the needed route to the created STD-500 instance. For 

more information on creating routes, see ―Creating Routes for Portable Data 

Collectors‖. 
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STD-510 Data Collector 

To add a STD-510 data collector into the plant hierarchy: 

1. Right-click the hierarchy object of interest and select Create > STD-510 Collector 

from the menu. 

 
Figure 93 Creating STD-510 collector in plant hierarchy 

The device appears in the plant hierarchy and at the same time the device properties 

are displayed on the right. 

 
Figure 94 STD-510 properties 

4. Specify a version and a serial number of the device at hand, as well as the software 

version used by your STD-510. 
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5. Specify properties of the collector’s transducer. You can set the measurement unit, 

sensitivity, and the transducer’s model and serial number. If the Plug-and-Play 

check box is selected, the regular transducer is to be used. 

6. Click the Routes tab and link the needed route to the created STD-510 instance. For 

more information on creating routes, see ―Creating Routes for Portable Data 

Collectors‖. 

STD-3300 Analyzer 

To add a STD-3300 analyzer into the plant hierarchy: 

1. Right-click the hierarchy object of interest and select Create > STD-3300 Analyzer 

from the menu. 

The device appears in the plant hierarchy and at the same time the device properties 

are displayed on the right. 

 
Figure 95 STD-3300 properties 

2. Specify a version and a serial number of the device at hand, as well as the software 

version used by your STD-3300. 

3. Specify properties of the collector’s transducers. You can set the measurement unit, 

sensitivity, and the transducer’s model and serial number. If the Plug-and-Play 

check box is selected, the regular transducer is to be used. 
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4. Click the Routes tab and link the needed route to the created STD-3300 instance. For 

more information on creating routes, see ―Creating Routes for Portable Data 

Collectors‖. 

Creating Routes for Portable Data Collectors 

A route is the order of measurements in points during inspection. Inspection routes 

specify in which points, on which machines and in which order the measurements are to 

be performed. Routes are created for portable devices and can be loaded only into 

assigned devices. You can include into the route only points of the element intended for 

using with particular device type. For a device instance, you may create as many routes 

as needed. 

To create a route for a portable device: 

1. Select the device of interest in the plant hierarchy. 

2. Click the Routes tab on the right. 

 
Figure 96 Routes tab 

3. Click . 

The Create Route dialog box is displayed. 

 
Figure 97 Create Route dialog box 
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4. Type a name of the new route and click OK. 

The new route is created. On creating, the route contains no measurement points. 

5. To add points into the route, drag the machine element (e.g. Engine as shown below) 

from the left to right panel. 

 
Figure 98 Add measurement points to route 

The points located on the selected machine element are displayed in the table of 

route points. 

 
Figure 99 Route points 

6. Using the same technique, add all necessary points into the route. 
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7. If you plan to use a non-regular transducer for measurements, specify the name of the 

transducer in the Transducer cell. See below for more information on creating non-

regular transducer models. 

If you want to use non-regular transducers for portable devices, you need first to create 

models of such transducers. 

To create a transducer model: 

1. Click . 

The Transducer models editor dialog box appears. To view a list of existing 

transducers, click a transducer type. As a result, transducers of the selected type are 

displayed below.  

 
Figure 100 Transducer model editor dialog box 

2. Click the Add button. 

The Transducer model dialog box appears. 

 
Figure 101 Transducer model dialog box 
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3. In the Model box, type a name of the transducer model. 

4. From the Transducer type list, select the type of interest. 

5. From the Measurement unit list, select the measurement unit of interest. 

6. From the Sensitivity meas. unit list, select the sensitivity measurement unit of 

interest. 

7. Click OK. 

The new transducer model is created. 

To change the route points order, do one of the following: 

 Right-click the selected point and select Move up or Move down from the menu. 

 Click  in the Point cell and drag the point to the needed location. 

The point position is changed. 

To remove a measurement point from the route: 

1. Select the route you need. 

2. Select the point to be deleted. 

3. Press DELETE. 

The selected point is removed from the route. 

To rename a route: 

1. Select the route you need. 

2. Click . 

The Rename Route dialog box is displayed. 

 
Figure 102 Rename route dialog box 

3. Modify the route name and click OK. 

The route name is changed. 

To delete a route: 

1. Select the route you need. 
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2. Click . 

3. Click Yes to confirm the deletion. 

The route is deleted. 

To create a route map: 

1. From the Route list, select the route of interest and click . 

The route map is displayed in the workspace on the right. 

 
Figure 103 Viewing route map 

At the top of the route map, you can see a toolbar for zooming a route map and 

navigating through map’s pages. This toolbar is described in ―Inspection Reports‖. 

2. To print out a route map, click  on the toolbar. 

The Print dialog box appears. 

3. Click Yes to confirm the operation. 

The route map is printed. 
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Manual input of fundamental frequencies and mode parameters 

Having loaded route data from the device, you can additionally enter fundamental 

frequencies and operating mode parameters values manually. Fundamental frequency 

values may be also come to the device during inspection—when route data are loaded, 

you will be able to modify these values. For more information, see ―Working with STD-

500, STD-510 and STD-3300.‖ 

To activate manual input of fundamental frequencies in the Analysis mode: 

 Select the Input fundamental frequency values manually check box. 

 
Figure 104 Activating manual input of fundamental frequencies 

To activate manual input of mode parameters in the Analysis mode: 

 Select the Input operating mode parameters values manually check box. 

Configuring synchronous data collection of single-channel points for STD-3300 

If you need to collect data synchronously in two different point on the same machine, 

you can use STD-3300. The following conditions must be met: 

 Point parameters are identical 

 Points must belong to the same machine 

 These points are single-channel 

To configure synchronous collection in two points: 

1. Click the Plants tab. 

2. In the plant hierarchy, select the device of interest. 

3. Click the Routes tab on the right. 

4. Click the first point for synchronous collection. 
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Figure 105 Configuring synchronous collection in two points—step 1 

5. Holding CTRL down, click the second point for synchronous collection. 

When passing the route, data in these points will be collected synchronously. 



Vibrodesigner User's Guide 

96 

 
Figure 106 Configuring synchronous collection in two points—step 2 

Note: The transducer’s type is defined automatically as to 
reference to the first point. 

Configuring Stationary Devices 

The CTD-2160/2060 monitors allow you to make inspections of oil-transfer power 

equipments, pumps, compressors, pipelines and so on. These monitors are mounted 

permanently next to the inspected equipment and collect signals continuously via 

transducers. The major difference between the monitors is that CTD-2160 has 16 

vibration channels and three tachometric channels, whereas CTD-2060 has six vibration 

channels and one tachometric channel. 

Common procedure for configuring stationary monitors includes the following: 

1. Creating a stationary monitor in the machine model. 

2. Linking a monitor’s channels to measurement points of the machine model. 

3. Specifying parameters of a monitor’s instance in the plant hierarchy. 

СТD-2160 Monitor 

The CTD-2160 monitor is designed for continuous protection of rotary equipment. This 

monitor registers and measures signals from vibration and rotary transducers. You can 

monitor up to 16 vibration channels and three tachometric channel simultaneously. 
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To create and configure a CTD-2160 monitor in the machine model: 

1. Right-click the machine model of interest and select Create > CTD-2160 Monitor. 

 
Figure 107 Creating CTD-2160 

The monitor is created and displayed at the bottom of the element models list. In the 

workspace on the right, you need match the monitor channels (both vibration and 

tachometric) and machine points. 



Vibrodesigner User's Guide 

98 

 
Figure 108 CTD-2160 properties 

2. To match a monitor channel and a measurement point, right-click the channel 

number in the Vibration channels table and select the needed point from the menu. 

 
Figure 109 Linking device channels to measurement points 
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3. Match all vibration channels and measurement point you need. 

4. If necessary, match rotation speed channels and measurement points you need. 

Note: To remove a link between a channel and a measurement point, 

press DELETE. 

Having created and configured the CTD-2160 at the machine models level, you need to 

specify the following information for each monitor’s instance in the plant hierarchy: 

 Serial number 

 Profibus address 

 COM port 

 Baudrate 

These settings will be used for identifying the monitor on the Profibus network. After 

specifying these settings, the user will not be able to change parameters of the monitor’s 

channels. 

Important! These settings are required for proper operation in real-time 

mode. 

To specify parameters of the CTD-2160 instance: 

1. Click the Plants tab. 

2. Locate the machine of interest and click CTD-2160 Monitor. 

 
Figure 110 Configuring CTD-2160 in plant hierarchy 

3. On the Properties tab on the right, specify the correct serial number of your monitor. 
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4. In the Address box, specify the monitor address on the Profibus network. 

Note: The Profibus address is set with special jumpers located on the 

board inside. For more information, refer to CTD-2160 Operation 

Manual. 

5. In the Port box, specify the number of the serial port your monitor is connected to. 

6. In the Baudrate box, specify the connection speed with the monitor. 

СТD-2060 Monitor 

The CTD-2060 monitor measures signals from vibration and rotary transducers. You can 

monitor up to six vibration channels simultaneously and one tachometric channel. 

To create and configure a CTD-2060 monitor in the machine model: 

1. Right-click the machine model of interest and select Create > CTD-2060 Monitor. 

The monitor is created and displayed at the bottom of the element models list. In the 

workspace on the right, you need match the monitor channels (both vibration and 

tachometric) and machine points. 

 
Figure 111 CTD-2060 properties 

2. To match a monitor channel and a measurement point, right-click the channel 

number in the Vibration channels table and select the needed point from the menu. 

3. Match all vibration channels and measurement point you need. 

4. If necessary, match the rotation speed channels and the measurement point you need. 
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Note: To remove a link between a channel and a measurement point, 

press DELETE. 

Having created and configured the CTD-2060 at the machine models level, you need to 

specify the following information for each monitor’s instance in the plant hierarchy: 

 Serial number 

 Profibus address 

 COM port 

 Baudrate 

These settings will be used for identifying the monitor on the Profibus network. After 

specifying these settings, the user will not be able to change parameters of the monitor’s 

channels. 

Important! These settings are required for proper operation in real-time 

mode. 

To specify parameters of the CTD-2060 instance: 

1. Click the Plants tab. 

2. Locate the machine of interest and click CTD-2060 Monitor. 

 
Figure 112 Configuring CTD-2060 in plant hierarchy 

3. On the Properties tab on the right, specify the correct serial number of your monitor. 



Vibrodesigner User's Guide 

102 

4. In the Address box, specify the monitor address on the Profibus network. 

Note: The Profibus address is set with special jumpers located on the 

board inside. For more information, refer to CTD-2060 Operation 

Manual. 

5. In the Port box, specify the number of the serial port your monitor is connected to. 

6. In the Baudrate box, specify the connection speed with the monitor. 

Configuring ASTD-2 System Monitor 

To view real-time data from remote ASTD-2 servers, you have to create and configure 

machine shop system monitors for all machines with inspected points. These monitors 

will be used for collecting vibration data. 

To create and configure a machine shop system monitor for the machine 

model: 

1. Right-click the machine model you need and then select Create > Machine shop 

monitor from the menu. 

 
Figure 113 Creating machine shop system device 

The monitor is created and displayed at the bottom of the element models list. In the 

workspace on the right, you need match the monitor channels and machine points. 

2. To match a monitor channel and a measurement point, right-click the channel 

number in the Vibration channels table and select the needed point from the menu. 
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Figure 114 Linking device channels to measurement points 

3. Match all vibration channels and measurement point you need. 

Note: To remove a link between a channel and a measurement point, 

press DELETE. 

Having created and configured the monitors at the machine models level, you need to 

specify monitor’s serial numbers and IDs in the plant hierarchy. These settings will be 

used for identifying the monitor within the ASTD-2 system. After specifying the ID and 

the serial number of the monitor, the user will not be able to change parameters of the 

monitor’s channels. 

Important! These settings are required for proper operation in real-time 

mode. 

To specify a serial number and ID of the machine shop monitor: 

1. Click the Plants tab. 

2. Locate the machine shop monitor of interest. 

3. On the Properties tab on the right, specify the correct ID and serial number of your 

monitor. 
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Figure 115 Configuring machine shop system device in plant hierarchy 

The final step in configuring machine shop system monitors is creating a ASTD-2 server 

in the machine shop which machines are to be inspected real-time. The created ASTD-2 

descriptions is used for identifying the computer on the network which serves as a data 

source. 

To create a ASTD-2 server: 

1. Right-click a name of the machine shop of interest and select Create > Machine 

shop server from the menu. 

 
Figure 116 Creating ASTD-2 server 

The machine shop server appears in the plant hierarchy.  
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Figure 117 ASTD-2 server properties 

2. In the Computer name box, specify the DNS name of the machine shop server on 

the network or its IP address. 

Configuring Auto Acquisition 

You can configure scheduled auto acquisition from remote monitors. 

To configure auto acquisition: 

1. In the left panel, select the Plants tab and then select the database of interest. 

2. Click the Scheduled Tasks tab on the right. 

 
Figure 118 Configuring autoacquisition 

3. To perform daily auto acquisition from remote monitors, select the Autoacquisition 

check box. 

4. In the Number of autoacqisitions per day box, specify how many times per day 

you have to collect data. 
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Data will be collected every day at regular intervals. 

5. In the First acquisition start time box, specify the time of the first daily acquisition. 

At this time the auto acquisition will start automatically. For more information, see 

―Auto acquisitions.‖ 

Database Structure Import and Export 

You can export and import a database structure. Exporting data allows you to save into 

file the configuration of one of the plant child elements (for example, a machine) or the 

complete plant. Importing allows you to upload the data exported before. Thus, you can 

use standard plant hierarchy elements and significantly save your time while creating a 

plant structure. 

Exporting Database Structure 

A hierarchy export is performed into a text file. You can export the following elements: 

 Root plant 

 Child plant 

 Station 

 Machine shop 

 Division 

 Machine 

When exporting a plant, the complete structure of the selected plant is recorded, 

including references to models of all transducers, elements and machines. When 

exporting a station, a machine shop, or a division, all upper hierarchy levels including the 

plant are recorded, as well as: 

 Transducer models 

 Element models 

 Machine models 

When exporting a machine, the following information is saved in a text file: 

 Plant information 

 Transducer models 

 Element models 

 Machine models 

To export a database structure: 

1. On the Plants tab, right-click the object to be exported and select Export structure 

from the menu. 
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Figure 119 Exporting database structure 

The Export to file dialog box appears. 

 
Figure 120 Export to file dialog box 

2. Select the target folder, type the file name you need in the File name box, and then 

click the Save button. 
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The export of the selected object structure is started. When finished, the successful 

message is displayed. 

 
Figure 121 Export completed 

3. Click OK. 

Importing Database Structure 

Importing a plant structure allows you to save time while creating a new database. 

Typically, this operation is performed in the following cases: 

 To create a new database which structure repeats the existing one (for example, for 

subsequent import of inspection data from a remote computer). 

 To use a standard set of elements and machine models. 

 To add a structure of one element model or a machine model and all associated 

element models. 

The import operation is applicable to the following objects only: 

 The root element on the Plants tab (only if the newly created database contains no 

nodes, except for Plants). 

 The root element on the Machines tab. 

 The root element on the Elements tab. 

To import a database structure: 

1. Right-click the destination object where you need to import a structure and select 

Import structure from the menu. 
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Figure 122 Importing database structure 

The Import from file dialog box appears. 

 
Figure 123 Import from file dialog box 

2. Select the file for import and click the Open button. 

The import is started. When finished, the successful message is displayed. 
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Figure 124 Import completed 

3. Click OK. 

If the database structure contains all imported objects, the import procedure is 

interrupted and an error message is displayed. 

 
Figure 125 Error message 

The same message is displayed when you try import incorrect file. As a result, a new 

record appears in the event log (see Chapter 8). The event log greatly facilitates solving 

such problems. 
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Chapter 6 Data Acquisition and Analysis 

This chapter describes how to collect data during machinery inspections and analyze 

collected data. 

It covers the following topics: 

 Introduction 

 Opening Database 

 Machinery Inspection 

 Recalculating Bands 

 Data Analysis 

 Working with Graphical Data 

 Comparison Submode 

 Real-time Monitoring 

 Inspection Reports 

Introduction 

Having configured a database structure, you may start inspection of machinery. The 

inspection purpose is estimating the current condition of machinery, detecting potential 

faults and making maintenance decisions. First, you collect data with either a portable or 

stationary device, then the collected data are loaded into a database and become available 

for analysis. Besides, inspection data can be retrieved from the remote online systems 

and imported into a database. When the inspection is completed, you have to generate an 

inspection report. 

Data analysis includes: 

1. Viewing the measurement points with active warnings/alarms. 

2. Analyzing trends of vibration and measured signals (spectra, waveforms, and orbits). 

3. Making a decision about places and causes of machinery faults. 

4. Estimating a current machinery condition. 

5. Making recommendations on machinery operation. 

Thus, machinery inspection is a regular data acquisition for condition monitoring and 

machinery diagnostics. The inspection is not just a data acquisition, this procedure must 

meet the following requirements: 
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1. The data are collected in a certain order. The order is specified in the measurement 

device as a route, which determines the sequence of passing measurement points on 

the machine. 

2. It is strongly recommended to collect all necessary data from a machine during a 

single inspection. It will guarantee completeness and accuracy of the data. 

3. Data acquisition from a single machine must be completed during a short-time 

interval under exactly the same conditions. At least, rotation frequencies during data 

acquisition must remain unchanged. 

4. To trace changes in machinery condition, all inspections must be performed under 

exactly the same conditions. 

The typical machine inspection and subsequent analysis involve the following actions: 

1. Measurements and uploading inspection data into a database. 

You can load inspection data either during a communication session or by importing 

data from file. 

2. Analyzing active warnings/alarms. 

3. Generating and analyzing an inspection report. 

4. Analyzing trends of frequency bands with active warnings/alarms. 

5. Analyzing trends of calculated parameters with active warnings/alarms. 

6. If necessary, analyzing daily trends retrospect. 

7. If necessary, analyzing spectra and waveforms. 

8. If necessary, analyzing orbits in a measurement point. 

9. If necessary, analyzing envelope spectra. 

10. If necessary, analyzing cepstra. 

11. If necessary, analyzing coast-downs. 

12. Diagnostics (detecting places and causes of faults on the basis of collected data). 

13. Preparing inspection results. 

When machinery inspection and data analysis are completed, the maintenance specialist 

generates the «Statement of Machinery Condition» document (or similar) in accordance 

with the plant regulations. The document must include diagnoses, recommendations, 

reports and measurements. Additionally, the maintenance specialist can append to the 

document parameter values and trend/signal graphs which were used to make the 

decision on machinery condition. 

Opening Database 

To start an inspection procedure or data analysis, you need to open the database of 

interest. You may work with various databases, either local or distributed. 
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To open an existing database: 

1. On the File menu, click Open database. 

The Open database dialog box appears. 

 
Figure 126 Open Database dialog box 

2. If the database of interest is stored on a remote computer, clear the Locally check 

box and then select the needed database server from the Computer name list. 

In the Database name box, a name of the database you opened for the last time on 

your computer is displayed. Clicking the arrow in this box shows the list of the 

databases stored on the specified computer. 

3. From the Database name list, select the database of interest. 

Note: If the database you need is stored locally, select the Locally check 

box and select the needed local database from the Database name list. 

4. Click OK. 

Inspection Data Acquisition 

Overview 

When using portable data collectors, the inspection data acquisition procedure involves 

the following steps: 

1. Connecting to the data collector. 

2. Loading a measurement route into the data collector. 

3. If necessary, printing a route map. 

4. Collecting data in the route points. 

5. Loading collected data into the database. 

Note: You can load data either during the connection session or by 

importing data from files if  inspection has been performed remotely. 

6. Printing an inspection report. 
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Figure 127 Inspection with portable device 

When working with stationary vibration monitors (CTD-2060/2160), the inspection 

procedure involves the following: 

1. Connecting to the monitor. 

2. Retrieving inspection data from the monitor and loading these data into the database. 

3. Printing an inspection report. 

Note: If the operator’s computer is turned on, the scheduled auto 

acquisition from vibration monitors can be performed. 

Working with Portable (Offline) Devices 

Working with STD-500, STD-510 and STD-3300 

Working with portable devices is shown with the STD-500 monitor. Use the same 

procedure for STD-510 and STD-3300. 

Note: If you want to work with STD-500/510/3300 monitors on your 

workstation, you need to install a special driver at the first connection. 

For more information, see ―Installing STD-500/510 Driver.‖ 
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To collect data with STD-500: 

1. Connect your STD-500 to any USB port of your workstation. Use a special USB 

cable delivered with STD-500. 

2. Switch to the Analysis mode. 

3. In the plant hierarchy, select the device you want to connect to. 

On the Communication tab on the right, you may see the parameters for establishing 

connection. 

 
Figure 128 Communication tab 

4. Click the Connect button. 

The connection session is established. 

Important! You will fail to establish a connection session if you have 

previously entered incorrect STD-500 version and serial number. 

5. From the Loading routes list, select the Machine shop 1 route and click the Load 

Route button. 

Note: To view a route map, click the Routes tab on the right, select the 

route of interest and click . 

6. To close the connection session, click the Disconnect button. 

7. Take your STD-500 and go through all route points. 

For information on how to work with STD-500, refer to STD-500 Operation Manual. 
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8. Load measured data into the database. To do so, establish a connection session and 

click the Read Data button. 

Note: If you try to load data of the route that is not presented in the 

database, you will see the warning message and the operation will be 

interrupted. A new error appears in the Event Log (see Chapter 8). 

When loading, you can see the progress indicator. If the device configuration and the 

database configuration are the same, the inspection data are loaded into the database. 

If not, the Confirm Data Writing dialog box is displayed whereby you can see the 

detected discrepancies. You can click the Save button and thus record the data from 

channels which match the database configuration, or click the Cancel button to 

cancel the operation. 

 
Figure 129 Confirm Data Writing dialog box 

9. When done, click the Disconnect button. 

The loaded data become available for analysis. 

If you activated manual input of fundamental frequencies and/or operating mode 

parameters (see ―Manual input of fundamental frequencies and mode parameters‖), the 

Input Parameter Values Manually dialog box is displayed after loading the route data. 

In the fundamental frequency cells, average values are displayed. Enter values of each 

parameter and click ОК. 
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Figure 130 Input Parameter Values Manually 

Processing STD-500/STD-510/STD-3300 Out-of-route Points 

To load out-of-route points: 

1. On the Connecting Device tab, click the Read data button. 

When the data are loaded, the Confirm Data Writing dialog box appears. 

 
Figure 131 Confirm Data Writing dialog box 

In this dialog box, you must link each out-of-route point to a plant machine train. 

2. To link a point to the machine, select the point of interest in the left pane, then select 

the machine the point is linked with. 

3. Click Save to DB button. 
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The changes are saved in the database. In the Analysis mode, the out-of-route points 

are displayed as a folder at the machine elements level. 

Working with Stationary (Online) Devices 

Working with stationary devices is shown with the CTD-2060 monitor. Use the same 

procedure for CTD-2160. 

To collect data with CTD-2060: 

1. Connect your CTD-2060 to a serial port of your workstation. 

2. Switch to the Analysis mode. 

3. In the plant hierarchy, select the device you want to connect to. 

On the Communication tab on the right, you may see the parameters for establishing 

connection. 

 
Figure 132 Communication tab 

4. Select the COM port the device is connected to, and then specify the connection 

speed. 

5. Click the Connect button. 

The connection session is established. In the Connection state section, the current 

device settings are displayed. 
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Figure 133 CTD-2060 Connection established 

Important! You will fail to establish a connection session if you have 

previously entered incorrect CTD-2060 version and serial number. 

6. Click the Read Inspection button. 

If the device configuration and the database configuration are the same, the 

inspection data are loaded into the database. If not, the warning message is 

displayed. 

Note: To detect discrepancies between the device and database 

configurations, click the Show Configuration button. You will see the 

dialog box containing a table of configured point and links to the device 

channels. For more information about this dialog box, see ―Comparing 

Stationary Device and Database Configurations.‖ 

7. When done, click the Disconnect button. 

The loaded data become available for analysis. 

Auto Acquisition 

If you have configured scheduled auto acquisition from remote online monitors (see 

―Configuring Auto Acquisition‖), saving inspection data will be started automatically 

when specified time comes. This operation will be started in case the operator’s 

computer is turned on. The following dialog box is displayed. 
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Figure 134 Auto acquisition from online monitors 

Important! When the auto acquisition has been started, it is not 

recommended to work with Vibrodesigner-Standard or other 

applications. Please wait until this operation completed. 

Inspection Data Import and Export 

Vibrodesigner enables you to exchange measured data between the databases with 

identical structure. For this purpose, inspection import/export mechanism is used. The 

inspection data is imported/exported in ZIP format. 

Importing Inspection Data 

You can import inspections that have been previously exported from Vibrodesigner into 

ZIP files. Import operation allows you to load data received from a remote online data 

collector systems. 

To import an inspection: 

1. On the File menu, click Import Inspections. 

The Load inspection data dialog box appears. 
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Figure 135 Load inspection data dialog box 

2. Select the file to be imported into Vibrodesigner and click the Open button.  

Important! The inspection file contents must match the structure of the 

database where the inspection is imported. The imported files must be 

obtained by exporting inspections from the database with the same 

logical structure. 

You are prompted to confirm the operation. 

 
Figure 136 Inspection import confirmation 

3. Click Yes. 

Loading inspection data is started. Depending on the file size, it may take from 

several seconds to several tens of minutes. The status bar displays the progress. 

When completed, the successful message is displayed. 

4. Click Yes. 

You can now start analyzing the imported inspection. 

Exporting Inspection Data 

Exporting inspections into file is performed for the selected machine shop or a machine. 

To export an inspection: 

1. In the plant hierarchy, select the machine shop or machine which inspections you 

need to export. 
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2. On the File menu, click Export Inspections. 

The Data Export dialog box appears. 

 
Figure 137 Data Export dialog box 

3. Specify the data to be exported. 

You can export: 

 The last inspection (by selecting the Copy last data option). 

 All measured data of the selected object, which are stored in the database (by 

selecting the Copy all measurement data option). 

 Data in the specified interval (by selecting the Copy time interval data option 

and specifying the interval you need). 

4. Select the output file format. You can select either the Vibrodesigner internal format 

(.dat) or Excel format. For more information about output Excel format, see ―Excel 

File Format When Exporting Inspections.‖ 

5. In the Target folder box, specify a path to the folder where the inspection are to be 

exported. 

You can also click the  button and select the target folder in the appeared dialog 

box. 

6. Click OK. 

The following message is displayed. 
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Figure 138 Export prompt 

7. Click Yes. 

 
Figure 139 Export confirmation 

8. Click Yes. 

The export is started. When finished, a new ZIP file appears in the specified folder. 

Note: It is recommended to rename the saved inspection file so that it 

has a meaningful name (for example, ―inspection2006July‖). 

If an error occurred, the error message is displayed, as shown below. 

 
Figure 140 Export error 

To troubleshoot such problems, use the event log. For more information, see Chapter 8. 

Adjusting mode parameters values 

You can view a list of existing inspections. When viewing the list, you can specify 

comments on the inspections and modify values of mode parameters and machine 

fundamental frequencies of selected inspections. 

To view the list of inspections: 

1. In the plant hierarchy, select the machine of interest. 

2. Select the Inspection List tab on the right. 

The list of machine inspections is displayed. 
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Figure 141 Inspection list 

To modify comments of an inspection: 

1. Click the inspection of interest and click the Edit Commentaries button. 

The Inspection Commentaries dialog box appears. 

 
Figure 142 Inspection commentaries dialog box 

2. Enter any relevant comments and click the Save button. 

The entered comments are displayed in the list of inspections. 

To modify values of mode parameters and fundamental frequencies: 

1. Select the inspection of interest and click the Edit Parameter Values button. 

The Machine Parameter Values dialog box appears. 
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Figure 143Machine parameters values dialog box 

2. Specify the values you need and click Save. 

Note After saving new parameter values in the database, calculation of 

bands and parameters will be performed automatically. 

Recalculating Bands and Parameters 

When recording the measured data from a data collector or importing data from an 

inspection file, the values of calculated absolute and relative bands and calculated 

parameters are computed automatically. If you have created new bands or calculated 

parameters, or modified properties of the existing ones, the old data of the bands and 

parameters will be deleted as they do not match the current parameters. When recording 

new inspection data, the values for such new or modified bands (parameters) will be 

automatically calculated and saved, but the values in these bands and parameters for all 

inspections made before are not saved. If you need to have these values, you may use the 

Calculate bands and parameters operation. 

Recalculating bands and parameters may take much time, depending on 

 The number of new or modified bands (parameters). 

 The number of machines in the machine shops. 

 The measured data size in the database. 

You can select for which plant hierarchy elements to apply this operation. You can 

recalculate bands and parameters for: 

 A complete plant (all measurement points of all machines are processed). 

 A plant station (all measurement points of all machines of the selected station are 

processed). 
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 A plant division (all measurement points of all machines of the selected division are 

processed). 

 A plant machine shop (all measurement points of all machines of the selected 

machine shop are processed). 

 A machine (all measurement points of the selected machine are processed). 

 A machine element (all measurement points of the selected machine element are 

processed). 

 A measurement point of the machine element (a selected measurement point on the 

machine element is processed). 

To recalculate bands and parameters: 

1. In the plant hierarchy on the left, select the object you need. 

2. On the File menu, click Calculate bands. 

You are prompted to confirm the operation. 

3. Click Yes. 

Recalculating bands and parameters is started. The status bar displays the progress. 

Data Analysis 

Introduction 

Analysis is the process of condition monitoring using visual data. The main purpose of 

analysis is detecting causes of machinery condition changes. The results of analysis are 

diagnoses, recommendations, reports, and collected measurement results. The analysis 

procedure is performed in the Analysis mode. In this mode, the left Vibrodesigner panel 

displays the Plants tab. You cannot modify the plant hierarchy in the Analysis mode. 

During analysis, you can work with inspection reports and view measurement results. 

The standard analysis procedure comprises six primary steps: 

1. Alarms/warnings analysis. 

Right after loading an inspection data, you need to verify whether new active 

warnings/alarms appear in the plant hierarchy. If appeared, you need to monitor 

machines where the warning/alarm levels have been exceeded. 

2. Generating and analyzing an inspection report. 

You need to mark points with active alarms/warnings and pay attention to warnings 

for change, as well as analyze the vibration growth trend. Then you estimate 

remaining time before failure for the parameters. 

3. Analyzing trends of frequency bands and operational parameters with active 

alarms/warnings. 

You need to visually estimate vibration change trends. 
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4. Analyzing trends of calculated parameters. 

Analyzing trends of calculated parameters allows you to monitor data tendencies and 

predict subsequent data changes. 

5. Analysis of original signals. 

You may want to view spectra and waveforms in the measurement points for 

in-depth analysis of vibration change trend. If necessary, you can compare these 

spectra and waveforms with signals in other points or in the same points on other 

machines in the Comparison mode. 

6. Orbit analysis (optional). 

In case of suspecting certain defects, you need to analyze orbits in 2-channel 

measurement points. 

7. Analyzing Nyquist diagram (optional). 

Analyzing a Nyquist diagram allows monitoring how magnitude/phase of the 

selected signal harmonic is changing during period in case of permanent machine 

working mode. 

8. Analyzing coast-downs and daily trend retrospect (if necessary and if such data are 

available). 

Viewing daily trends retrospect and coast-downs enables a maintenance engineer to 

perform effective analysis based on historical data. 

9. Diagnostics, i.e. locating places and causes of faults. 

On the basis of acquired information, you need to locate the places and possible 

causes of faults (imbalance, bearing defects, gear defects and so on), estimate fault 

severities and the machinery remaining time before failure, and finally estimate a 

current machinery condition and make recommendations on machinery operation. 

Detecting Machinery Faults 

When an inspection data are recorded, you may start to view and analyze the collected 

data. Typically, the first step is to determine the changes effected in the machinery 

condition. These changes may be located by warning indicators in the plant hierarchy 

and in inspection reports. 

Analysis of Active Alarms/Warnings 

You can promptly trace exceeding the alarm/warning levels in measurement points. If the 

parameter exceeded the warning for absolute value or for change thresholds, a yellow 

exclamation mark is displayed for this object in the plant hierarchy. 

 
Figure 144 Active warning 

If the parameter exceeded the failure threshold, a red exclamation mark is displayed in 

the plant hierarchy. 
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Figure 145 Active failure 

Exclamation mark indication is shown for all measurement points with active 

alarms/warnings. The same indication is displayed on the upper hierarchy levels 

(machine element > machine > machine shop > division > station > plant) which the 

point with active alarm/warning is belonged to. By expanding the plant hierarchy tree, 

you can quickly locate the point with the active alarm/warning. 

 
Figure 146 Tracing warnings in hierarchy 

Note: If both failure and warning levels were exceeded, the red 

exclamation mark is displayed for all parent objects. 

Creating and Viewing Inspection Reports 

You can generate a report for the following plant hierarchy levels: 

 Plant 

 Station 

 Machine shop 

 Machine 

In the Alarm levels columns of the report, the maintenance engineer must note points 

with active alarms and pay attention to absolute and relative change levels, as well as 

analyze vibration tendency. Then, the machinery remaining time before failure 

estimations must be made. Keep in mind that these estimations are forecasting. A name 

of the point in the plant hierarchy is displayed in the Point code column of the report. 

For more information about creating reports, see ―Inspection Reports‖ later in this 

chapter. A report example is given in Chapter 11, ―Inspection Report Example.‖ 
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Viewing Measurements 

When you found the machines, points and parameters with vibration changes, you may 

proceed with viewing data of these objects. To view data, you need first to select in the 

left Vibrodesigner panel the object that contains the data of interest. You can view 

measurement data on the following levels: 

 Measurement point 

 Machine 

Viewing Data in Measurement Points 

To view measured or calculated data in a machine point: 

1. In the Analysis mode, expand the plant hierarchy and select the measurement point 

you need. 

The panel containing the inspection list and signal graphs is displayed in the 

workspace on the right. 

 
Figure 147 Properties of measurement point in Analysis mode—measured 

signal are displayed on the right 

If you selected a 1-channel point or a channel of the 2-channel point, you can see the 

following tabs: Trends (if calculating bands for the point has been configured), 

Locus, Signals and Stopways. If you selected a 2-channel point containing 

measured waveforms on its channels, the Orbits tab is displayed on the right. Thus, 

you can see only those tabs in the workspace that correspond to configured measured 

and calculated signals. 

2. In the inspection list, select the inspection you need. 

3. View the graphs on the tab you need. 
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On the Trends tab, spectral bands in the form of trends are at your disposal. On the 

Locus tab, the Nyquist diagram is displayed. On the Signals tab, you can view 

waveforms, spectra and envelope spectra. On the Stopways tab, the archive coastdowns 

may be displayed.  On the Orbits tab, you can view signal orbits. If a waveform 

measurement is configured in a point, spectra in this point are calculated automatically. 

You can view in the workspace: 

 A signal in the form of waveform (by clicking ). 

 A signal in the form of spectrum (by clicking ) 

 An envelope spectrum of the signal ( ) 

 A signal cepstrum ( ). 

Above graphs on the Orbits and Signals tabs, the  buttons are located that 

allow you to quickly switch measurement unit of waveforms and spectra, that is, 

integrate and differentiate signals (SVA transformation.) SVA transformation can also be 

done by using: 

 The settings panel 

 Y-Scale context menu 

 Main menu commands 

For more information about viewing graphical data, see ―Working with Graphical Data‖ 

later in this chapter. 

Viewing Machine Data 

When you select any machine in the plant hierarchy, the following tabs are displayed on 

the right: 

 Inspection report tab 

For information on inspection reports, refer to ―Inspection Reports‖ later in this 

chapter. The report example generated by Vibrodesigner is shown in Chapter 11, 

―Inspection Report Example.‖ 
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Figure 148 Viewing inspection report 

 Trends tab 

For information about trend analysis specifics, see ―Viewing Trends‖ later in this 

chapter. 

 
Figure 149 Viewing trends 

 ACTD Daily Trends tab 

For information about daily trends, see ―Viewing Daily Trends Retrospect‖. 



Vibrodesigner User's Guide 

132 

 
Figure 150 Viewing ACTD daily trends 

 Inspection List tab 

For more information, see ―Adjusting mode parameters values‖. 

 
Figure 151 Inspection list 

 Measurement points tab 

For more information, see ―Measurement Point Editor‖. 
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Figure 152 Viewing measurement points 

 Monitoring Formulas tab 

For more information on how to work with monitoring formulas, see ―Configuring 

Calculated Parameters‖. 

 
Figure 153 Monitoring formulas tab 

 Properties tab 
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Figure 154 Viewing machine properties 

You can also view the following parameters: 

 Machine name 

 Machine model 

 Machine code 

 Machine serial number 

 Comments 

 Machine manufacturer 

 Machine description 

 Machine scheme 

These parameters cannot be modified in the Analysis mode; they are specified in the 

Configuration mode for a machine and a machine model. 

Inspection Reports 

Vibrodesigner allows you to create inspection reports. Creating reports is the essential 

part of the entire condition monitoring procedure of a plant machinery. When inspection 

is finished, you can create the report containing data on current machinery condition. 

Reports allow you to analyze the measured data. The information about active 

warnings/alarms on the monitored machines are presented in every report. After 

analyzing, the report is turned over to the responsible department in accordance with the 

plant regulations. 

To generate an inspection report: 

1. In the plant hierarchy, select one of the following objects: 



   Vibrodesigner User's Guide 

  135 

 Plant 

 Station 

 Machine shop 

 Machine 

The Inspection report tab is displayed in the workspace. 

 
Figure 155 Inspection report tab 

On this tab, you can view the report saved for the last time. If the report has not been 

created yet, this tab displays the following text: ―No report has been created yet.‖ At 

the top of the Inspection report tab, you can see the toolbar that provides buttons 

for zooming a report in the workspace and navigating through report pages. The table 

below describes toolbar buttons. 

Report toolbar 

BUTTON BUTTON NAME DESCRIPTION 

 
Zoom to fit Automatically adjust the zoom so that the image will fit to 

the workspace. Thus, the workspace displays the 
complete page of the report. 

 
100 % Display the report page at its actual size. 

 
Zoom to width Display the report page in the width of the workspace. 

 
First page Scroll to the first report page. 

 
Previous page Scroll to the previous report page, if any. 

 
Next page Scroll to the next report page, if any. 
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BUTTON BUTTON NAME DESCRIPTION 

 
Last page Scroll to the last report page. 

 

2. Right-click in the workspace and select Create report from the menu, or use the 

Create button on the Vibrodesigner toolbar. 

The report is being generated. The status bar displays the progress. When completed, 

the report is displayed in the workspace. You can view the report example in the 

Chapter 11, ―Inspection Report Example.‖ 

Note: A report is created with regard to report parameters and current 

plant configuration. For example, creating a report for a plant extracts 

station and machine shop data, whereas generating a report for a 

machine shop extracts machines of the selected machine. 

To set report parameters: 

1. Right-click in the workspace and select Report parameters from the menu. 

 
Figure 156 Modifying report parameters 

The Report parameters dialog box appears. 
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Figure 157 Report parameters dialog box 

2. If the Data from the latest machine inspection option is selected, only the data 

collected during the last machine inspection  are included into your report. The 

report will not contain data from the measurement points that were skipped during 

the last inspection. 

3. If the The latest information on machine option is selected, the latest data for each 

point on the machine are included into a report. If a point was skipped during the last 

inspection, the data from the previous inspection are included into your report, and 

so on. 

4. If the Data within the following interval option is selected, the data collected in the 

interval specified in the from and to fields are included into your report. 

5. If necessary, select the Operating mode parameters check box. 

If the check box is not selected, the machine report will include vibration 

measurement points only. If the check box is selected, in addition to vibration points, 

the measurement points with operating parameters (temperature, pressure, and so on) 

will be included as well. 

6. If necessary, select the Monitoring formulas check box. 

In this case, the table with calculated parameters values will be added into a report. 

7. If the Show only points with alarms and warnings option in the Alarm level 

section is selected, the report will include only active alarms/warnings in the 

specified data range. 

8. If the Show all measurement points option in the Alarm level section is selected, 

the report will include the information about all machine points. 

9. Click OK. 
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The report parameters are saved. 

You can save your report in RTF format of print it out on the printer. 

To save a report: 

1. Right-click in the workspace and select Save report from the menu. 

The Save report dialog box appears. 

 
Figure 158 Save report dialog box 

2. Select the destination folder where you want to save your report, type the a report 

name in the File name box, and then click the Save button. 

The report is saved in RTF format. 

To print out a report: 

1. Right-click in the workspace and select Print report from the menu. 

The Print dialog box appears, prompting you to confirm printing the report on the 

printer specified in the Vibrodesigner print settings. 

Note: To specify a printer in Vibrodesigner settings, select Print from 

the File menu. In the Print dialog box, select the printer you need. If you 

have not specified a printer in Vibrodesigner, the report is printed on the 

Windows default printer. 

 
Figure 159 Print dialog box 

2. Click Yes. 

The report is printed out. 

To set a printer as default: 

1. On the Windows Start menu, click Control Panel, and then double-click Printers 

and faxes. 
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2. Right-click the printer you want to use as the default printer, and then click Set as 

Default Printer.  

A check mark appears next to the printer icon in Printers and Faxes. 

Working with Graphical Data 

Introduction 

Vibrodesigner is a comprehensive tool that provides many features for displaying and 

analyzing scalar and vector data. Graphical data are used in the following cases: 

 When working with 1-channel points and with 2-channel point channels, you can 

view and analyze: 

 Waveforms 

 Envelopes 

 Spectra 

 Envelope spectra 

 Cepstra 

 Coast-downs 

 Nyquist diagram 

 Trends 

 When working with 2-channel points, you can view orbits. 

 When working with a machine, you can analyze trends in the points. 

 When working in the Comparison submode, you can compare spectra, waveforms 

and trends in various machine points for different machines of a plant. 

Thus, you can view waveforms, envelopes,  spectra, envelope spectra, and trends of 

scalar and calculated parameters. 

First of all, the standard techniques used while working with graphs are described. Then, 

specifics for each graph type are considered. 

Standard Techniques 

Zooming 

You can view graphs at various levels of magnification to make it easier to see details or 

to get a broader view of the graph's contents. You can edit X-Scale and Y-Scale manually 

or using context menu commands. You can also autoscale graphs to set full value ranges 

for both X and Y axes. 



Vibrodesigner User's Guide 

140 

To scale the X axis manually: 

1. Place the cursor under the X axis. 

The mouse cursor mode is changed. 

2. Holding down the left mouse button, drag to the right or left. 

The selected part of the X scale is marked as yellow. 

 
Figure 160 X-axis is marked in yellow to zoom 

3. Release the left mouse button. 

The X axis is scaled by the specified interval. 

 
Figure 161 Zooming by selected interval 
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To scale the Y axis manually: 

1. Place the cursor to the left of the Y axis. 

The mouse cursor mode is changed. 

2. Holding down the left mouse button, drag up or down. 

The selected part of the Y scale is marked as yellow. 

3. Release the left mouse button. 

The Y axis is scaled by the specified interval. 

To autoscale the axes, do one of the following: 

 Click  on the toolbar. 

 Right-click in the workspace and select Autoscale from the menu. 

The axes are automatically autoscaled (extended to include all points of the graphs). 

Use the X-Scale menu (  on the toolbar) to change the scale of the X axis. 

To display a full X-axis range: 

 Click  on the right of the X-Scale button on the toolbar, and select Full size from 

the menu. 

The X-scale is extended to a full range. 

To extend X-axis view range twice, do one of the following: 

 Click  on the right of the X-Scale button on the toolbar, and select Expand from 

the menu. 

 Right-click under the X-Scale and select Expand from the menu. 

The X-axis value range is extended twice. 

To shrink X-axis view range twice, do one of the following: 

 Click  on the right of the X-Scale button on the toolbar, and select Compress from 

the menu. 

 Right-click under the X-Scale and select Compress from the menu. 

The Y-axis value range is shrank twice. 

To set a particular X-axis view range: 

1. Right-click under the X-Scale and select More from the menu. 

The X Axis tab of the Data parameters dialog box is displayed.  This tab view 

depends on the current signal representation (either waveform or spectrum). 

2. In the View range section, specify the time interval you need, and click OK. 

The X-Scale view range is changed. 
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Use the Y-Scale menu (  on the toolbar) to change the scale of the Y axis. 

To display a full Y-axis range: 

 Click  on the right of the Y-Scale button on the toolbar, and select Full size from 

the menu. 

The Y-scale is extended to a full range. 

To fill graphs to fit to the workspace, do one of the following: 

 Click  on the right of the Y-Scale button on the toolbar, and select Fit into the 

menu. 

 Right-click on the left of the Y-Scale and select Fit into from the menu. 

The Y-Scale view range is set in accordance with data on the graphs. This operation 

is more recommended than autoscaling as only visible data are displayed. 

To extend Y-axis view range twice, do one of the following: 

 Click  on the right of the Y-Scale button on the toolbar, and select Expand from 

the menu. 

 Right-click on the left of the Y-Scale and select Expand from the menu. 

The Y-axis value range is extended twice. 

To shrink Y-axis view range twice, do one of the following: 

 Click  on the right of the X-Scale button on the toolbar, and select Compress from 

the menu. 

 Right-click on the left of the Y-Scale and select Compress from the menu. 

The Y-axis value range is shrank twice. 

To set a particular X-axis view range: 

1. Right-click on the left of the Y-Scale and select Y-Scale Setup from the menu. 

The Y Axis tab of the Data parameters dialog box is displayed.  his tab view 

depends on the current signal representation (either waveform or spectrum). 

3. In the View range section, specify the range you need, and click OK. 

The Y-Scale view range is changed. 

Cursor 

The cursor is the yellow vertical line in the workspace. It helps you trace X and Y values, 

which are displayed on the panel above the graphs. 
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Figure 162 Cursor 

Using the cursor, you can: 

 Monitor X and Y values of the graph. 

 Zoom graphs. 

 Set labels (see ―Labels‖ later in this chapter). 

Supplementary cursor features for a particular graph types are described later in this 

section. 

To move the cursor, apply one of the following techniques: 

 Using the LEFT ARROW and RIGHT ARROW keys. Pressing the key shifts the 

cursor by one point along the X scale (either to the left or right.) While holding the 

key, the cursor moves along the X scale with acceleration. 

 Using the HOME and END keys. Pressing HOME moves the cursor to the X scale 

zero point. Pressing END moves the cursor to the end of the X scale. 

 Using the mouse. 

To adjust cursor parameters: 

 Click  on the toolbar. 

The cursor menu is displayed. 

 
Figure 163 Cursor menu 

You can use one of the following cursor mode to move the cursor: 
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 Non-fixed cursor 

In this mode, moving the mouse pointer above the X-scale moves the cursor in the 

workplace. The cursor follows the mouse pointer without stop. The non-fixed cursor 

is the default mode. 

 Fixed cursor 

In this mode, clicking the left mouse button above the X-scale moves the cursor in 

the workspace. The cursor is set in the nearest point of the active graph. 

If necessary (for example, when you are printing screen), you can remove the cursor 

from the workspace. To do so, clear the Show cursor check box. 

A cursor specifics for spectrum and waveform graphs is described in the following 

sections. 

Labels 

You can set labels on the graphs in the workspace to facilitate data analysis. Labels can 

be set either manually or automatically. In the latter case, maximums and minimums of 

the active graph (or all graphs) are labeled. 

To add a label manually, do one of the following: 

 Holding the CTRL key down, double-click the point in the workspace where you 

want to set a label. 

 Place the cursor on the X scale where you want to set a label and press 

CTRL+INSERT (or select Labels > Add label from the context menu). 

A new label is displayed in the workplace. 

Note: To facilitate setting labels correctly, use the fixed cursor. 

To add labels automatically: 

1. Click  on the right of the Labels button on the toolbar, and then select Extremums 

from the menu. 

The Extremums dialog box appears. 

 
Figure 164 Extremums dialog box 
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2. Select either Maximums or Minimums to display the extremum types to be labeled 

on the graph. 

3. Select the graphs to be labeled. To display extremums of the active graph only, select 

Active graph. To display extremums of all graphs in the workspace, select All 

graphs. 

4. To set labels in the entire graph interval, select Full. If you want to set labels for the 

displayed interval only, select Selected. 

5. In the Number of labels box, specify the maximum number of labels displayed in 

the workspace at a time. 

6. Click OK. 

The labels with specified parameters are displayed in the workspace. The picture 

below shows spectrum graphs, one of which was autolabeled in first six maximums. 

 
Figure 165 Autolabels that corresponds to first six maximums of selected 

spectrum 

Besides, you can adjust the label appearance in the workspace. Labels can be displayed 

either vertically or horizontally about the X axis. A label can display: 

 A function value 

 An argument value 

 Function and argument values 
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To adjust label appearance: 

1. Click  on the right of the Labels button on the toolbar and select View from the 

menu. 

The popup labels menu appears. 

 
Figure 166 Labels menu 

2. Select the label displaying orientation you need (either vertical or horizontal). 

3. To display on the label the Y-scale value of the labeled point, select the Show value 

check box. 

4. To display on the label the X-scale value of the labeled point, select the 

Show argument check box. 

To delete a label: 

1. Using the cursor, point to the label to be deleted. 

2. Do one of the following: 

 Press CTRL+DEL. 

 Right-click the label and select Delete label from the Labels context menu. 

The label is removed from the workspace. 

To delete all labels displayed in the workspace, do one of the following: 

 Press SHIFT+DEL. 

 Click  on the right of the Labels button on the toolbar and select Clear all labels 

from the menu. 

 Right-click in the workspace and select Delete all labels from the Labels context 

menu. 

All labels are removed from the workspace. 

Screen View Options 

You can specify how lines, cursor and labels are displayed in the workspace separately 

for screen and printing. The procedure below describes how to specify screen view 
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option. Use the same procedure for printing view options (after selecting View > Printer 

view options on the toolbar). 

To specify screen view options: 

1. Click  on the right of the View button on the toolbar and select Screen view 

options from the menu. 

The Screen view parameters dialog box appears. 

 
Figure 167 Screen view parameters—Pane tab 

2. To display grid lines in the workspace, select the Grid check box. 

3. You can specify colors of the workspace background and frames, as well as graph 

area colors. To set the color of interest, click the rectangle on the right of the 

parameter name. 

The Edit Colors dialog box appears. 
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Figure 168 Edit Colors dialog box 

4. Select the color you need and click OK. 

The color of the rectangle is changed. 

5. Click the Apply button and then click the Axes tab. 

 
Figure 169 Screen view parameters—Axes tab 

6. Specify the font size of the text displayed along the axes. 

The selected font size is applied to the digits in the Text rectangle. 
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7. In the Colors section, specify colors of axes lines, filling lines, the text displayed 

along the axes. 

8. Click the Apply button and then click the Lines tab. 

 
Figure 170 Screen view parameters—Lines tab 

9. This tab is used to specify colors of various lines displayed in the workspace. To 

save the changes, click the Apply button and click the Labels tab. 

 
Figure 171 Screen view parameters—Labels tab 
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10. To adjust parameters of manual labels, click Hand. 

11. Specify the font size of the text displayed in labels. 

12. In the Colors section, specify colors of label background, text and marks. 

13. Click the Auto option and repeat Steps 11-12 to specify parameters of autolabels. 

14. Click OK to save the changes. 

Printing Screen 

You can print out the graphs displayed in the workspace. Before printing, you can set the 

page size and preview the output. 

To set the page size: 

1. Click  on the right of the Print button on the toolbar and select Page setup from 

the menu. 

The Page Setup dialog box appears. 

2. In the Margins boxes, specify the page margins you need. 

3. From the Printer list, select the printer of interest. 

4. Specify the paper size and orientation you need. 

5. Click OK to save the page parameters. 

To preview the page: 

1. Click  on the right of the Print button on the toolbar and select Print preview 

from the menu. 

The Print preview dialog box appears. 
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Figure 172 Print preview 

2. On the toolbar, specify the page size. 

3. To print out the page, click the Print button on the toolbar. 

To print graphs: 

1. Click the Print button on the toolbar. 

The Parameters of printing dialog box appears. 

 
Figure 173 Parameters of printing dialog box 
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2. In the Comments box, type any pertinent comments to be printed along with the 

graphs and click OK. 

The Print dialog box appears. 

 
Figure 174 Print dialog box 

3. From the Name list, select the target printer and click OK. 

The graphs displayed in the workspace are printed. 

Saving Pictures to File 

You can save the data displayed in the workspace in one of the following formats: 

 BMP 

 Excel 

 CSV 

To save graphs in BMP format: 

1. Click  on the right of the Save button on the toolbar and select Save picture to 

BMP file from the menu. 

The Parameters of saving to BMP file dialog box is displayed. 
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Figure 175 Parameters of saving to .bmp file dialog box 

2. If necessary, type any relevant text in the Comments box and click OK. 

The Save As dialog box is displayed. 

3. Specify a name of the file and click the Save button. 

The graphs displayed in the workspace are saved into the BMP file. 

To save data in Excel format: 

1. Click  on the right of the Save button on the toolbar and select Save data to Excel 

file from the menu. 

The Parameters of saving to .xls file dialog box is displayed. 

 
Figure 176 Parameters of saving to .xls file dialog box 

2. Select either all graphs or an active graph to be saved. 

3. If necessary, type any relevant text in the Comments box and click OK. 
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The Save As dialog box is displayed. 

4. Specify a name of the file and click the Save button. 

The graphs displayed in the workspace are saved into the Excel file. 

To save data in CSV format: 

1. Click  on the right of the Save button on the toolbar and select Save data to CVS 

file from the menu. 

The Parameters of saving to CSV file dialog box is displayed. 

 
Figure 177 Parameters of saving to .csv file dialog box 

2. Select either all graphs or an active graph to be saved. 

3. If necessary, type any relevant text in the Comments box and click OK. 

The Save As dialog box is displayed. 

4. Specify a name of the file and click the Save button. 

The graphs displayed in the workspace are saved into the CSV (comma separated 

values) file. 

Viewing Trends 

Introduction 

You can view trends for: 

 A separate measurement point if measurement of bands and/or parameters have been 

configured in these points. 

 A separate non-vibration measurement points 

 Calculated parameters. 
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 Complete machines. 

In this case, trends of spectrum characteristics in bands or parameter trends in 

machine points are displayed. 

Thus, the Trends tab is displayed on the right panel if a machine or a point of any type  

is selected in the plant hierarchy on the left. 

Managing Trend View in Vibration Point 

When selecting any measurement points in the plant hierarchy on the left, all the trends 

configured in the point are displayed on the Trends tab on the right. 

 
Figure 178 Viewing trends in vibration point 

If necessary, you can clear the check box on the right of the trend in the list and 

consequently this trend will not be displayed in the workspace. 

When viewing trends in vibration points, there is one additional button on the toolbar: 

View Spectrum. Clicking the View Spectrum button shows the Signals tab displaying 

the signal that corresponds to the selected trend point. 

Managing Trend View in Non-Vibration Point 

When selecting a calculated parameter in the plant hierarchy on the left, all the trends 

configured for this parameter are displayed on the Parameter tab on the right. 



Vibrodesigner User's Guide 

156 

 
Figure 179 Viewing trends of calculated parameter 

Managing Machine Trend Views 

When viewing trends, the workspace consists of two parts: names of the displayed trends 

with a color of the corresponding graph are displayed on the left; the graphs are shown 

on the right. 

Vibrodesigner provides you with so called trend sets. The picture below shows the trend 

set which name is shown in the drop-down list above the graphs. 

 
Figure 180 Viewing machine trend 
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To display one of the predefined trend sets, select the trend set of interest from the drop-

down list. 

Viewing Trends Settings 

To adjust trend viewing parameters: 

1. To show alarm/warning levels in the workspace, click  on the right of the View 

button on the toolbar and select Level lines from the menu. These levels are shown 

as horizontal lines. 

 
Figure 181 Warning and alarm levels on trend 

2. To show approximation line in the workspace, click  on the right of the View 

button on the toolbar and select Approximation line from the menu. As a result, the 

least squares linear approximation of the trend is displayed in the workspace. This 

approximation is displayed as a dot line. 

 
Figure 182 Linear trend approximation (dot line) 

3. To show prediction line in the workspace, click  on the right of the View button on 

the toolbar and select Prognosis line from the menu. As a result, a trend is 

extrapolated by least squares method. In this case, the approximating line is extended 

beyond the graph X-Scale range. It is recommended to view prediction along with 
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alarm and warning levels. You can estimate the machinery remaining time before 

failure at the crossing of prediction line and failure and warning levels. 

 
Figure 183 Linear trend prediction (dot line)—recommended to view along 

with A/W levels 

4. To adjust trend viewing parameters, click  on the right of the View button on the 

toolbar and select Picture ranges from the menu.  

The Data view parameters dialog box appears. 

 
Figure 184 Data view parameters dialog box—Axis Y tab 

5. Select the measurement unit you need. 

6. Specify the Y-Scale view range you need. 

7. Click the Axis X tab. 
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Figure 185 Data view parameters dialog box—Axis X tab 

8. Specify the X-Scale view range you need. 

9. Click OK. 

Viewing Spectra 

Introduction 

The picture below shows an example of displaying spectra. To display spectra, you select 

a spectrum from a certain inspection in the panel on the left of the graphs, and this 

spectrum is shown in the workspace on the right. 

 
Figure 186 Viewing spectra 
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You can select multiple measurement points on the left of the graphs, holding down 

CTRL or SHIFT. As a result, multiple spectrum graphs will be displayed in the 

workspace. 

 
Figure 187 Viewing waterfall spectra 

Spectrum Window Interface 

The spectrum window interface is shown in the picture below. 

 
Figure 188 Spectrum window interface 
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The spectrum window interface consists of the elements described below. 

Waveform window interface 

ELEMENT DESCRIPTION 

1 Y axis.  

2 Y axis measurement unit. 

3 Y axis graduation marks. 

4 X axis. 

5 X axis graduation marks. 

6 Х axis measurement unit. 

7 Horizontal scroll bar. 

8 Vertical scroll bar. 

9 Grid lines (can be disabled) 

10 Spectrum graphs. 

11 Active spectrum graph. The cursor [14] is moved along the active graph. 
The data in zones [15], [16] and [17] are displayed for the active graph. 

12 One band of the active graph. Can be enabled/disabled. 

13 Cursor. The cursor view and behavior are specified via the toolbar drop-
down menu. The cursor is moved along the active graph. The current Y 
value under the cursor is marked with horizontal line on the Y axis [13.1]. 
The color of this mark matches the cursor color. 

14 Label. 

15 Active spectrum RMS within the current X. 

16 Current X value under the cursor. 

17 Current Y value under the cursor. 

18 Active spectrum RMS within the specified range. 

19 Selection list (19.1) and the value (19.2) of the fundamental frequency of 
the active graph. 

 

Overview of Spectrum Window Features 

Besides the standard techniques applied to any graphs in Vibrodesigner-Standard 

(zooming, labeling, printing screen, saving data in BMP, CSV and Excel formats), you 

can perform the following operations with spectrum graphs: 

 Display spectra in waterfall and 2D views 

 Display spectrum profile in waterfall view 

 Display absolute and relative bands in the workspace 
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 Adjust Fourier transformation settings 

 Use linear and logarithm axes scale 

 Modify X and Y measurement units 

 Modify X and Y display ranges 

 Display active spectrum RMS within the specified frequency range 

 Display fundamental frequencies values 

 Use harmonic cursor 

 Set and change fundamental frequencies 

 Set exact peak values 

Viewing Spectrum Settings 

You can change the view of 3D spectrum graphs. To adjust waterfall spectra in 3D, use 

the mouse to move the cube diagonal. 

 
Figure 189 Changing 3D spectra orientation 

To adjust spectrum viewing parameters: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Spectrum data parameters dialog box appears. 
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Figure 190 Spectrum data parameters dialog box—Data view parameters 

tab 

2. To apply waterfall data view, select the 3D-Waterfall option. 

3. If you want to display spectrum profile, select the Show profile check box and 

specify the bandwidth for calculating RMS when displaying profile. For more 

information on spectrum profiles, see ―Viewing Profiles.‖ 

4. To apply 2D data view, select the 2D Plain option. 

5. To display absolute bands in the workspace, select the Show absolute bands check 

box. 

6. To display relative bands in the workspace, select the Show relative bands check 

box. 

7. To specify Fourier transformation parameters, click the Edit button. 

The Fourier transform parameters dialog box appears. 

 
Figure 191 Fourier transform parameters dialog box 
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8. From the list at the top of the dialog box, select the signal (containing a particular 

number of samples) which Fourier transformation are to be adjusted. 

9. Specify the spectrum window of interest (rectangle or cos
2
). 

10. Specify the number of spectrum lines and overlapping percentage during averaging. 

11. Click OK top save the changes. 

Note: To specify the default Fourier conversion parameters, click the 

Default button.. 

To specify Y axis parameters when viewing spectra: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Spectrum data parameters dialog box appears. 

2. Click the Y-Axis tab. 

 
Figure 192 Spectrum data parameters dialog box—Axis Y tab 

3. Select the Y-Scale measurement unit you need. 

4. Specify the Y-Scale type (linear or logarithmic) you need. 

5. Specify the Y-Scale view range you need. 

6. You can also specify the data viewing limits. If the Setup according to data option 

is selected, the maximum Y value will correspond to maximum value of actual data. 

If the Setup manually option is selected, you may set the limits that will exceed the 

specified view range. 

7. Click OK. 
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The changes are saved. 

To specify X axis parameters when viewing spectra: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Spectrum data parameters dialog box appears. 

2. Click the X-Axis tab. 

 
Figure 193 Spectrum data parameters dialog box—Axis Y tab 

3. Select the X-Scale measurement unit you need (Hz, RPM, or run speed). 

4. Specify the X-Scale type (linear or logarithmic) you need. 

5. Specify the X-Scale view range you need. 

6. You can also specify the data viewing limits. If the Setup according to data option 

is selected, the maximum X value will correspond to maximum value of actual data. 

If the Setup manually option is selected, you may set the limits that will exceed the 

specified view range. 

7. Click OK. 

The changes are saved. 
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Specifying Measurement Unit of Rotation Frequency 

To specify measurement unit used to display fundamental frequency: 

 Right-click in the workspace and select the measurement unit of interest (Hz or 

RPM) from the Rotation frequency menu. 

The selected unit will be used when displaying fundamental frequencies in the list of 

parameters at the workspace bottom and on the upper panel. 

Cursor Settings 

You can set a special cursor option named the Harmonic cursor. If this option is set, the 

cursor is multiplied, i.e. shows spectrum harmonics, half of the current frequency, as 

well as the current frequency. 

 
Figure 194 Harmonic cursor displays multiple frequencies 

To set the harmonic cursor: 

 Right-click in the workspace and select Cursor > Harmonic from the menu. 

Correcting Signal Peak 

In some cases, you may encounter with a signal peak smearing when displaying spectra. 

Use the following procedure to define an actual peak value. 

To correct a signal peak: 

1. Set the cursor on the peak of interest. 

Note: Use the fixed cursor to set the cursor accurately. 

2. Press CTRL+A. 
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The magnitude and frequency of the signal are corrected. In the right upper corner of 

the window, you can see the corrected values in red. 

 
Figure 195 Correcting peak value 

Assigning and Modifying Fundamental Frequencies 

When displaying spectra, you can assign fundamental frequencies or modify values of 

existing fundamental frequencies. 

To assign a fundamental frequency: 

1. Correct the peak value of the signal that correspond to the fundamental frequency. 

For more information, see ―Correcting Signal Peak.‖ 

2. Press CTRL+B. 

The Enter run speed value dialog box appears. 

 
Figure 196 Enter Run Speed Value dialog box 

3. Select the measurement unit of interest and type the fundamental frequency value. 

4. Click OK. 
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The fundamental frequency value is saved. 

To modify a fundamental frequency value: 

1. From the list above the spectrum graphs, select the fundamental frequency of 

interest. 

2. Press CTRL+C. 

The Enter run speed value dialog box appears. 

3. Select the measurement unit of interest and type the new value of the fundamental 

frequency. 

4. Click OK. 

The fundamental frequency value is saved. 

Viewing Profiles 

Vibrodesigner allows you to display so-called spectrum profiles. A profile represents the 

cross-section of 2D and 3D spectra. Each spectrum in waterfall view represents a time-

extended vibration portrait of a certain measurement point. So, cross-section of waterfall 

spectra represents a trend which is similar to a trend in the frequency band. 

To show a profile of the selected spectrum: 

 Right-click in the workspace, select Data view options from the menu and then select 

the Show profile check box. 

A profile is displayed at the bottom of the workspace. It refers to the spectra section 

above which the cursor is placed. 

 
Figure 197 Waterfall spectra profile 
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Viewing Waveform Graphs 

Introduction 

The picture below shows an example of displaying waveforms. To display waveforms, 

you select a waveform from a certain inspection in the panel on the left of the graphs, 

and this waveform is shown in the workspace on the right. 

 
Figure 198 Viewing waveform 

You can select multiple measurement points on the left of the graphs, holding down 

CTRL or SHIFT. As a result, multiple waveform graphs will be displayed in the 

workspace. 
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Figure 199 Viewing four waveforms simultaneously 

Common commands to manage graphs are accessible: 

 From the context menu 

 From the main menu 

 On the toolbar 

 
Figure 200 Waveform context menu 

Waveform Window Interface 

The waveform window interface is shown in the picture below. 
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Figure 201 Waveform window interface 

The waveform window interface consists of the elements described below. 

Waveform window interface 

ELEMENT DESCRIPTION 

1 Y axes. The number of Y axes depends on the number of graphs in the 
workspace. 

2 Y axis measurement unit (the same for all graphs). 

3 Y axes graduation marks (the same for all graphs). 

4 X axis. 

5 X axis graduation marks 

6 Х axis measurement unit. 

7 Horizontal scroll bar. 

8 Vertical scroll bar. 

9 Single graph frame. 
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10 Single graphs areas. The area is displayed as light-grey for filtered signals. 
The order of areas depends on specified signal sorting. 

11 Zero-values axis displayed for each single graph area. 

12 Single waveform graph. 

13 Active waveform graph. The cursor [14] is moved along the active graph. 
The data in zones [15], [16], [17], [18] and [19] are displayed for the active 
graph. 

14 Cursor. The cursor view and behavior are specified via the toolbar drop-
down menu. The cursor is moved along the active graph. The current Y 
value under the cursor is marked with horizontal line on the Y axis [14.1]. 
The color of this mark matches the cursor color. 

15 Active waveform or filtered signal RMS within the specified range [17] for 
the specified time period [16]. 

16 X axis limits of the active waveform. 

17 Active waveform type (original or filtered) and the waveform frequency 
range. 

18 Current X value under the cursor. 

19 Current Y value under the cursor. 

20 Label. 

21 X axis viewing range of the active waveform. 

22 Active waveform or filtered signal RMS within the specified range [17] for 
the specified time period [21]. 

 

Overview of Waveform Window Features 

Besides the standard techniques applied to any graphs in Vibrodesigner-Standard 

(zooming, labeling, printing screen, saving data in BMP, CSV and Excel formats), you 

can perform the following operations with waveform graphs: 

 Filter an original waveform with one or more than one filters so all the graphs are 

displayed in the workspace. 

 View envelopes 

 Modify Y axis measurement unit. 

 Modify X and Y display ranges. 

 Display active waveform or filtered signal RMS within the specified range for the 

specified time period. 

 Specify measurement unit of fundamental frequency 

 Use the locator cursor. 
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Filters and Viewing Parameters 

To apply a filter: 

1. Click  on the right of the View button on the toolbar and select Data view options 

from the menu. 

The Wave data parameters dialog box appears. 

 
Figure 202 Wave data parameters dialog box 

2. Select the Show filters check box. 

3. Select the check box on the left of the filter and click OK. 

The filtered waveform is displayed in the workspace. 

Note: If the Show original signal check box is selected, the original 

waveform is also displayed in the workspace. 

Selecting multiple filters results in displaying multiple filtered waveforms. The picture 

below shows a waveform filtered by three different filters. 
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Figure 203 Viewing three filtered waveforms 

As a result, you can compare the waveforms filtered by various filters. 

To add a new filter: 

1. On the Data view parameters tab, select the Show filters check box and click the 

Add button. 

The Filter parameters dialog box appears. 

 
Figure 204 Filter parameters dialog box 

2. Type a name of the filter. 

3. Specify the band range and click OK. 

The created filter appears in the list of available filters. 

To modify filter parameters: 

1. In the Filters list, click the filter of interest and then click the Edit button. 

The Filter parameters dialog box appears. 

2. Modify the parameters you need and click OK. 
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To delete a filter: 

1. In the Filters list, select the filter to be deleted and then click the Edit button. 

2. Click Yes to confirm the deletion. 

The selected filter is deleted. 

Viewing Envelopes 

To view an envelope: 

1. On the Data view parameters tab, select the Show envelopes check box and click 

the Add button. 

The Filter parameters dialog box appears. 

4. Type a name of the filter. 

5. Specify the band range of the envelope filter and click OK. 

The created filter appears in the list of available envelope filters. 

6. Select the check box on the left of the filter you need and click OK. 

The envelope is displayed in the workspace as a separate graph. 

 
Figure 205 Displaying envelope 

Adjusting Waveform Parameters 

To specify Y axis parameters when viewing waveforms: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Wave data parameters dialog box appears. 
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2. Click the Y- Axis tab. 

 
Figure 206 Wave data parameters dialog box—Y-Axis tab 

3. Select the Y-Scale measurement unit you need. 

4. Specify the Y-Scale view range you need. 

5. You can also specify the data viewing limits. If the Setup according to data option 

is selected, the maximum Y value will correspond to maximum value of actual data. 

If the Setup manually option is selected, you may set the limits that will exceed the 

specified view range. 

6. Click OK. 

The changes are saved. 

To specify X axis parameters when viewing spectra: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Wave data parameters dialog box appears. 

2. Click the X-Axis tab. 
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Figure 207 Wave data parameters dialog box—X-Axis tab 

3. Specify the X-Scale view range you need. 

4. You can also specify the data viewing limits. If the Setup according to data option 

is selected, the maximum X value will correspond to maximum value of actual data. 

If the Setup manually option is selected, you may set the limits that will exceed the 

specified view range. 

5. Click OK. 

The changes are saved. 

Specifying Measurement Unit of Rotation Frequency 

To specify measurement unit used to display fundamental frequency: 

 Right-click in the workspace and select the measurement unit of interest (Hz or 

RPM) from the Rotation frequency menu. 

The selected unit will be used when displaying fundamental frequencies in the list of 

parameters at the workspace bottom and on the upper panel. 

Adjusting Cursor 

You can set a special cursor option named Locator. If this option is set, the function 

value and argument (T) value will be displayed next to the cursor. 
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Figure 208 Locator cursor 

To apply the locator cursor: 

 Right-click in the workspace and select Cursor > Locator from the menu. 

Viewing Envelope Spectra 

The picture below shows an example of displaying envelope spectra. To display 

envelope spectra, you select a signal from a certain inspection in the panel on the left of 

the graphs, and envelope spectrum of this signal is shown in the workspace on the right. 

Besides the standard techniques applied to any graphs in Vibrodesigner-Standard 

(zooming, labeling, printing screen, saving data in BMP, CSV and Excel formats), you 

can also perform operations specific for spectrum graphs (see ―Overview of Spectrum 

Window Features‖). 

To view envelope spectra: 

 Click  located on the right of the Envelope Spectra button ( ) at the top of the 

workspace and select the envelope filter of interest (envelope filters have to be 

configured beforehand—for more information, see ―Filters and Viewing 

Parameters.‖) 

The spectrum of the selected signal envelope is displayed in the workspace. 
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Figure 209 Viewing envelope spectra 

Viewing Orbit Graphs 

Introduction 

An orbit is a shaft’s kinetic trajectory that represents quick in-bearing shaft’s 

movements. A maintenance engineer can detect machine defects and their causes by 

analyzing orbit’s shape, orbit’s changes during operation time, maximum deviation and 

phase angle turn. Shaft cracks and changes of bearing and footing stiffness become 

apparent when analyzing changes of shaft’s kinetic trajectory. 

From the visual presentation viewpoint, an orbit is two waveforms recorded 

synchronously and displayed in a common coordinates—both coordinates of points are 

taken from waveform magnitudes (Y is taken from the first waveform; X is taken from 

the second waveform). Typically, an orbit measurement unit is mkm (vibration 

displacement). As a rule, an orbit is represented as two waveforms measured with two 

transducers in orthogonal directions in one machine point.  

A phase label and a phase label trajectory (time-ordered phase labels connected with a 

line) are often shown on an orbit. A phase label is an orbit point that corresponds to the 

sync pulse from a tachometric transducer in case of shaft’s complete rotation. Analyzing 

phase labels is an important part of orbit observation. A phase label trajectory allows you 

to assess misalignment relative to rotation axis. 

Orbit Window Interface 

The orbit window interface is shown in the picture below. 
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Figure 210 Orbit window interface 

The orbit window interface consists of the elements described below. 

Orbit window interface 

ELEMENT DESCRIPTION 

1 Orbit type (orbit of original or filtered signal). 

2 Maximum orbit deviation. Defined by the time span specified by the user 
in display options. 

3 Maximum magnitude of signals comprising the orbit. Defined by the time 
span specified by the user in display options. 

4 Date and time when the orbit was captured. 

5.1, 5.2 The rotation speed of selected machine shaft while measuring 
waveform. 

6 Orbit deviation value for current orbit point. 

7 Time span of displayed data. 

8 Time label for current orbit point. 

9 Signal peaks for current orbit point. 

10 Orbit graph area (rectangular coordinate system). 

11 Delimiter of zones 10 and 12.  

12 Area of two waveforms comprising an orbit. 

13.1, 13.2 Names of original signals. 
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14.1, 14.2 Original signals areas. 

15.1, 15.2 Original signal frames. 

16.1, 16.2 Zero-values axis for original signal graphs. 

17.1, 17.2 Original signal graphs. 

18 Cursor. 

19 Time axis. 

20 Time axis graduation marks. 

21 Time axis measurement unit (typically, ms or sec). 

22 Horizontal scroll bar. 

23 Vertical scroll bar. 

24.1, 24.2 Measurement unit of orbit magnitude axis. Displayed on both signal and 
orbit graphs. 

25 Magnitude axis for signals and orbit. 

26 Y axes graduation marks. Displayed on both signal and orbit graphs. 

27 Circular grid of an orbit graph (displays equal magnitude levels). 

28 Orbit graph. 

29.1, 29.2 Labels. 

 

Analyzing Orbits 

Orbits in the 2-channel measurement points are displayed only if waveform type of 

signal has been specified for the channels in the Configuration mode. The picture below 

shows an example of the orbit displayed in the workspace. 
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Figure 211 Viewing orbit 

You can work with the waveforms that form the orbit in the same way as with the normal 

waveforms, except for filtering. You can apply only one filter to the initial orbit. The 

picture below shows the filtered orbit and the waveforms that form the orbit. Above the 

graphs, which filter has been applied (in this case BPF 0-200 Hz). 

 
Figure 212 Filtered orbit 

The dialog box for adjusting filters can be called using: 

 The context menu command (Data view options) 

 The toolbar button (View > Data view options) 
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Only one orbit can be displayed in the workspace at a time. You are not allowed to select 

more than one element from the inspection list. 

Besides, from the list above the orbit graph you can select fundamental frequency and 

thus view the value on the right of the list.  

If synchronous waves are presented, the vertical lines are displayed on the original 

waveforms graph and phase labels and their trajectories are shown on the orbit graph. 

The vertical lines correspond to synchronous pulses used for retrieving phase labels. 

Viewing Cepstra 

Cepstra is a spectrum of original signal spectrum logarithm. In some cases, analyzing 

cepstra helps locate not obvious sequences in original signal. 

The picture below shows an example of displaying cepstra. To display cepstra, you select 

a signal from a certain inspection in the panel on the left of the graphs, and cepstra of 

this signal is shown in the workspace on the right. You can perform standard operations 

with cepstra graphs (zooming, labeling, printing screen, saving data in BMP, CSV and 

Excel formats). 

To view cepstra: 

 Click  at the top of the workspace. 

A signal cepstrum is displayed in the workspace. 

 
Figure 213 Viewing cepstra 
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Viewing Cepstra Settings 

To specify Y axis parameters when viewing cepstra: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Cepstrum data parameters dialog box appears. 

 
Figure 214 Cepstrum data parameters dialog box—Axis Y tab 

2. Select the Y-Scale measurement unit you need. 

3. Specify the Y-Scale view range you need. 

4. You can also specify the data viewing limits. If the Setup according to data option 

is selected, the maximum Y value will correspond to maximum value of actual data. 

If the Setup manually option is selected, you may set the limits that will exceed the 

specified view range. 

5. Click OK. 

The changes are saved. 

To specify X axis parameters when viewing cepstra: 

1. Click  on the right of the View button on the toolbar, and select Data view options 

from the menu. 

The Cepstrum data parameters dialog box appears. 

2. Click the X-Axis tab. 
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Figure 215 Cepstrum data parameters dialog box—Axis Y tab 

3. Specify the X-Scale view range you need. 

4. You can also specify the data viewing limits. If the Setup according to data option 

is selected, the maximum X value will correspond to maximum value of actual data. 

If the Setup manually option is selected, you may set the limits that will exceed the 

specified view range. 

5. Click OK. 

The changes are saved. 

Viewing Hodographs 

The Locus tab contains a Nyquist diagram in a special stationary mode. In this mode, all 

data are captured on the same rotation frequency. Each curve (hodograph) on such a 

graph is degenerated and consists the only point. 

The Nyquist diagram displays in polar coordinates a set of shaft vectors. Each point on 

the diagram corresponds to latest measure of the same signal harmonic performed during 

latest inspection. Data for Nyquist diagram are taken from archive database (all 

measurements are to be made in the same machine operating mode). Thus, the Nyquist 

diagram shows how amplitude/phase of the selected harmonic is changing in time when 

the operating mode is stable. 

If starting from a certain instant the signal amplitude and phase significantly differ from 

previous measures (or from a reference measure that was made when the machine was 

working properly), it indicates some machinery changes and should attract your 

attention. Typically, to define allowable levels, the uncertainty zone (circle) is drawn for 

the reference measure. If all measurement are within this zone, there are no progressive 

defects at the moment. 

The picture below shows an example of hodograph. 
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Figure 216 Viewing hodographs 

The panel on the left displays the list of relative bands that contain phase data. Selecting 

one of the relative bands refreshes the diagram. 

Note: For more information on Nyquist diagram, see ―Working with 

Nyquist Diagram.‖ 

Comparison Submode 

Introduction 

Vibrodesigner has a special Comparison mode designed to help you analyze graphical 

data. In the Comparison submode, all the features described above are at your disposal. 

The main difference from the normal mode is that you can simultaneously view 

spectra/waveforms from various machines that may belong to the different machine 

shops.  

There are some limitations on viewing spectra in a machine measurement point. There is 

no use in viewing profiles due to a profile of the waterfall spectrum is useful only when 

all spectra were measured in the same point at different times. Generally, a waterfall 

spectrum in the Comparison submode may contain the spectra from different machine 

points and even different machines. Thus, you cannot view profile in the Comparison 

submode. 

To switch to the Comparison mode: 

 From the View main menu, select Mode > Comparison. 
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Figure 217 Comparison submode 

In the Comparison submode, the Signals and Trends tabs are displayed in the 

workspace. These tabs allow you to view spectra, waveforms, and trends from various 

points of different machines. It facilitates the analysis and comparing vibration on 

different machines. 

Note: In this mode, you can display less than 36 trends at the same time. 

If the workspace displays spectra (waveforms/trends) in the normal mode, the same 

graphs are displayed after switching to the Comparison submode. On quitting the 

Comparison submode, the workspace displays the same data as before switching to the 

Comparison mode. 

Changing Structure of Waveforms, Spectrums and Trends 

This section describes how to add waveforms into the view pane on the Signals tab. 

Unless specified otherwise, use the same procedures for spectra. 

The Vibrodesigner screen in the Comparison submode consists of five panes: 

 The plant hierarchy is displayed on the left. The machines and measurement points 

where at least one waveform has been measured are available. 

 The middle upper pane contains the list of waveforms for the selected measurement 

point. 

 The middle lower pane allows you to preview the waveform that can be added in the 

view pane. 

 The right upper pane displays the selected waveform graphs (the View pane). 

 The right lower pane shows the list of selected waveforms. 
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To add a signal into the view pane: 

1. In the Comparison mode, click the Signals tab. 

2. In the plant hierarchy on the left, select the measurement point you need. 

3. In the middle upper pane, select one or more waveforms. 

4. Drag the selected waveform(s) in the view pane (or use the  button.) 

5. If necessary, select other measurement points of the same or different machine and 

add them in the view pane in the same way. 

Trends on the Trends tab are added in the view pane in the same way as for signals. 

To delete the selected spectra, waveforms, and trends from the list: 

 Click  above the inspection list. 

Viewing Coast-downs 

A machine coast-down is a non-steady operating mode when the shaft frequency is 

steady decreasing after engine has been switched off. Coast-downs are analyzed on the 

Stopways tab after selecting the point of interest. You can view data on three tabs: 

 The F (t) tab displays how a certain parameter is changing during period. 

 The F (n) tab displays how a certain parameter depends on a shaft rotation 

frequency. 

 The Response tab displays amplitude-frequency response and phase-frequency 

response as Bode and Nyquist diagrams. 

The main purpose of the Stopways window is displaying machinery vibration 

characteristics for analysis. The changes of selected harmonic or operating parameters 

are displayed in the workspace, and each graph displays characteristics of one parameter, 

but for different coast-downs. 

Note It should be noticed that the workspace contains only those data 

that correspond to strictly decreasing rotation frequency, that is, to the 

coast-down event. 

The coast-down analysis allows you to resolve various diagnostics issues, e.g., defining 

rotor self-resonance frequencies. The coast-down pattern help to define rotor bearing 

condition, gaps between rotatory and non-rotatory parts and so on. You can view on a 

single screen one or more graphs captured for different coast-downs. 

To start working with coast-downs: 

1. In the Analysis mode, select the machine point of interest. 

2. Select the Stopways tab on the right. 

The workspace displays how a certain parameter is changing during period (the F (t) 

tab). You can perform standard operations applicable to every graph (zooming, 
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labeling, printing screen, saving data in BMP, CSV and Excel formats). For more 

information, see ―Standard Techniques.‖ 

 
Figure 218 Viewing coast-downs—F(t) tab 

3. Select the check box on the left of the latest coast-down on the list. 

4. From the Parameter list, select the parameter of interest and click the Refresh 

button. 

The graph in the workspace refreshes. 

5. To display how a certain parameter depends on rotation frequency, select the F (n) 

tab. You can perform standard operations applicable to every graph (zooming, 

labeling, printing screen, saving data in BMP, CSV and Excel formats). For more 

information, see, ―Standard Techniques.‖ 
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Figure 219 Viewing coast-downs—F(n) tab 

6. Select the check box on the left of the latest coast-down on the list. 

7. From the Parameter list, select the parameter of interest. 

8. In the Shaft list, select the machine shaft which frequency will be displayed on the X 

axis and click the Refresh button. 

The graph in the workspace refreshes. You can view multiple coast-downs at the 

same time. If curves behavior has remarkable distinctions, you need to proceed with 

in-depth analysis. 

9. To view Nyquist and Bode diagrams, click the Response tab. For more information 

on these diagrams, refer to next sections. 

Working with Nyquist Diagram 

The Nyquist diagram displays vibration amplitude and phase as a vector in polar 

coordinates. Each diagram point is defined by length of vector (vibration amplitude) 

drawn from coordinates origin, and by counter wise phase. The line that connects 

diagram points in rotation frequency change sequence is a hodograph. The point order 

corresponds to a shaft rotation frequency. 

Note: The Nyquist diagram data are taken from files received from a 

ASTD-2 machine shop system. 

To start viewing a Nyquist diagram: 

 Click  on the Response tab. 
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Note: A special type of Nyquist diagram (stationary data mode) is 

displayed on the Locus tab. For more information, see ―Viewing 

Hodographs.‖ 

Interface of Nyquist Diagram Window 

The Nyquist diagram  window interface is shown in the picture below. 

 
Figure 220 Interface of Nyquist diagram window 

The Nyquist diagram window interface consists of the elements described below. 

Nyquist diagram window interface 

ELEMENT DESCRIPTION 

1 Toolbar. 

2 Information panel. 

2.1 Name of displayed parameter. 

2.2 Full and displayed data ranges (by rotation frequency). 

2.3 Full and displayed data ranges (by amplitude). 

2.4 Full and displayed data ranges (by phase). 

2.5 Current date and time of current graph.  

2.6 Current rotation frequency of current graph. 

2.7 Current vibration vector value of active graph. In brackets—corresponding 
vibration vector value of reference graph. 

3 Graphical window. 
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4 Parameters list. 

 

Main elements of a Nyquist diagram are shown in the picture below. 

 
Figure 221 Main elements of Nyquist diagram window 

Main elements of Nyquist diagram window 

ELEMENT DESCRIPTION 

1 Circular area of Nyquist diagram. 

2 Arrow indicating angle count direction. 

3 Measurement unit of vibration vector amplitude. 

4 Amplitude axis. 

5 Amplitude axis graduation marks. 

6 Circular grid (represents equal amplitude levels). 

7 Radial grid (represents equal phase values). 

8 Phase axis graduation marks (in degrees). 

9 Non-active graph (can be more than one). 

10 Active graph. 
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11 Cursor. 

11.1 Current vibration vector. 

12 Reference graph. 

13 Reference graph cursor. 

13.1 Reference vibration vector. 

14 Uncertainty circle. Defines an allowable uncertainty zone of vibration vector 
for this rotation frequency. 

15 Change vector (vector subtraction between current and base vibration 
vectors). 

16 Label. 

17, 18 Circles that correspond to alarm and warning amplitudes of vibration 
vector. 

 

Overview of Nyquist Diagram Window Features 

Besides the standard techniques applied to any graphs in Vibrodesigner-Standard 

(zooming, labeling, printing screen, saving data in BMP, CSV and Excel formats), you 

can perform the following operations with Nyquist diagrams: 

 Modify X axis measurement unit 

 Modify contents of displayed data 

 Specify/discard a reference measure 

To specify X axis measurement unit: 

 On the toolbar, click the Hz button (Hertz will be displayed on the X axis) or the 

rpm button (rotations per minute will be displayed on the X axis). 

To change contents of displayed data: 

 To remove original measurements from vibration vector, select check boxes on the 

left of the measurements. 

 To add measurements into vibration vector, clear check boxes on the left of the 

measurements you need. 

To specify a reference measure: 

1. Select the graph that will be displayed as referenced. 

2. Right-click in the workspace and select Assign reference graph from the menu. 

The selected graph will be displayed with green mark on the left in the parameters 

list. 
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To discard a reference measure: 

 Select the graph of interest, right-click in the workspace and select Assign reference 

graph from the menu. 

The green mark for the selected graph will be discarded. 

Viewing Nyquist Diagram Settings 

1. Right-click in the workspace and select Data view options from the menu. 

The Data view options – Nyquist diagram dialog box appears. 

2. If you need to display labels, select the Show labels check box and select the label 

type of interest. 

3. You can display current vibration vector, reference vector, uncertainty zone, change 

vectors and alarm vibration levels having selected the check box you need. 

Working with Bode Diagram 

The Bode diagram shows how vibration harmonic amplitude and phase depends on shaft 

rotation frequency. The Bode diagram analysis allows you to resolve various diagnostics 

issues. Analyzing amplitude-frequency and phase-frequency curves obtained by 

measuring vibration parameters on engine bearings during rotor coast-down is the main 

criteria for locating transverse crack on the engine rotor shaft. 

To start viewing a Bode diagram: 

 Click  on the Response tab. 
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Interface of Bode Diagram Window 

The Bode diagram window interface is shown in the picture below. 

 
Figure 222 Main elements of Bode diagram window 

Bode diagram window interface 

ELEMENT DESCRIPTION 

1 Rectangular area for displaying amplitude-frequency response. 

2 Rectangular area for displaying amplitude-phase response. 

3 Measurement unit of amplitude-frequency response Y axis. 

4 Amplitude-frequency response Y axis. 

5 Graduation marks of amplitude-frequency response Y axis. 

6 Amplitude-frequency response zero-values axis. 

7 Measurement unit of amplitude-phase response Y axis. 

8 Amplitude-phase response Y axis. 

9 Graduation marks of amplitude-phase response Y axis. 

10 Amplitude-phase response zero-values axis. 

11 X axis. 

12 X axis graduation marks. 
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13 Measurement unit of X axis. 

14 Rectangular area frames. 

15 Vertical scroll bar. 

16 Horizontal scroll bar. 

17 Amplitude-frequency response graphs.  

18 Amplitude-phase response graphs. 

19 Cursor. 

20 Label. 

21 Lines of reference Bode diagram. Used to compare two diagrams. 

 

Overview of Bode Diagram Window Features 

Besides the standard techniques applied to any graphs in Vibrodesigner-Standard 

(zooming, labeling, printing screen, saving data in BMP, CSV and Excel formats), you 

can perform the following operations with Nyquist diagrams: 

 Modify X axis measurement unit 

 Modify contents of displayed data 

 Specify/discard a reference measure 

 Use the locator cursor 

To specify X axis measurement unit: 

 On the toolbar, click the Hz button (Hertz will be displayed on the X axis) or the 

rpm button (rotations per minute will be displayed on the X axis). 

To change contents of displayed data: 

 To remove original measurements from vibration vector, select check boxes on the 

left of the measurements. 

 To add measurements into vibration vector, clear check boxes on the left of the 

measurements you need. 

To specify a reference measure: 

1. Select the graph that will be displayed as referenced. 

2. Right-click in the workspace and select Assign reference graph from the menu. 

The selected graph will be displayed with green mark on the left in the parameters 

list. 
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To discard a reference measure: 

 Select the graph of interest, right-click in the workspace and select Assign reference 

graph from the menu. 

The green mark for the selected graph will be discarded. 

To apply the locator cursor: 

 Right-click in the workspace and select Cursor > Locator from the menu. 

Viewing Daily Trends Retrospect 

The ASTD-2 machine shop system enables you to save so called machine daily trends—

slices of scalar vibration and monitoring parameters (band RMS, shaft amplitudes and 

phases, signal peak-peak values, rotations, operating parameters). Each slice is saved into 

a high-resolution (up to 1 sec) daily trend file. Typically, data for previous 1-3 months 

are stored. Retrospect of such daily tends allows locating fast-developing or accidental 

process on machines. This significantly helps a maintenance engineer to monitor 

machinery condition effectively. On the contrary, analyzing archive inspection data 

allows detecting steady-developing processes that usually affected by: 

 Gradual machinery aging 

 Operating conditions 

 Steady minor defects affecting the entire machinery condition. 

To display daily trend retrospect: 

1. In the Analysis mode, select the machine of interest. 

2. Click the ACTD Daily Trends tab on the right. 

Archive daily trends are displayed in the workspace. 



Vibrodesigner User's Guide 

198 

 
Figure 223 Viewing daily trends retrospect 

3. Select the trend of interest in list above the workspace. 

This list contains date and time when the trend was archived. 

4. Select the trend set of interest and click the Refresh button. 

Real-time Monitoring 

Introduction 

Having installed the Vibrodesigner-RT patch, you can monitor real-time vibration data 

received from ASTD-2 machine shop systems or CTD-2060/2160/3168 monitors via 

LAN. This significantly expand abilities of real-time machine diagnostics. On request, 

the program enables you to view current spectra, waveforms, orbits, and trend sets of 

machine parameters. In Real Time mode, request are directed to a ASTD-2 server or 

CTD-2060/2160/3168 monitors (but not to the Vibrodesigner database). 

To switch to the Real Time mode: 

1. On the View menu, select Mode > Real Time. 
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Figure 224 Switching to Real Time mode 

Note: When working with real-time data, the Comparison mode becomes 

disabled. 

The Vibrodesigner-RT window appears. 

 
Figure 225 Vibrodesigner-RT window 

2. To establish connection, click  on the toolbar. 

3. When done, select the machine point of interest from the drop-down list and click 

 to retrieve data from the monitor. 
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The current data are displayed in the workspace. The green indicator on the toolbar 

designates that connection is established. 

 
Figure 226 Viewing signals in real time 

To display device and database configurations: 

 Click  on the toolbar. 

The Configuration Comparison dialog box appears. For more information, refer to 

Appendixes, ―Comparing Stationary Device and Database Configurations.‖ 

To synchronize the computer and device time: 

 Click  on the toolbar. 

Viewing 1-Channel Points 

When viewing 1-channel measurement points, you can: 

 Refresh the data displayed in the workspace 

 Add the most recent ASTD-2 or vibration monitor data in the workspace for viewing 

multiple graphs simultaneously 

To refresh data in the workspace: 

 In the left panel, select the machine of interest and click the Refresh button on the 

toolbar. 

The data in the workspace refreshes. 
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Important! When switching to another point, the data in the workspace 

are not saved. 

As in the normal Analysis mode, you can add a new spectrum to existing ones in one of 

the following views: 

 2D (spectra are collided) 

 3D-Waterfall 

To add data into the workspace: 

 Select the check box on the left of the measurement you need. 

The ASTD-2 request is sent and the new signal is added into the workspace and 

displayed along with the previously collected data. 

Viewing Orbits 

You can view 2-channel points as orbits. Displaying more than one orbit at a time is 

prohibited. 

 
Figure 227 Viewing orbit in Real Time mode 

Note: If a point belongs to a 2-channel point, the second channel data 

also refreshes (but are not accumulated). An orbit is formed on receiving 

either the whole orbit data or one of the orbit’s constituents. 
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Viewing Trends 

In the Real Time mode, you can view trends on the measurement point level. The trend 

set with the point name is created for each point. This trend set contains all band/phase 

configurations of this points, as well as all existing rotation frequencies (tacho channels). 

 
Figure 228 Viewing trends in Real Time mode 
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Chapter 7 Database Management 

This chapter describes how to manage Vibrodesigner databases. 

It covers the following topics: 

 Introduction 

 Archiving Databases 

 Restoring Databases 

 Deleting Databases 

Introduction 

The Vibrodesigner database management system is a single utility that enables you to: 

 Backup databases 

 Restore databases from archives 

 Delete Databases 

A database archive is stored in ZIP format. 

To start working with databases: 

 On the Windows Start menu, point to Programs, and select Vibrodesigner > 

Standard > Manage Databases. 

The Vibrodesigner-Standard Database Manager dialog box appears. 
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Figure 229 Vibrodesigner-Standard Database Manager dialog box 

You can now choose one of the following actions: 

 Create a database archive 

 Restore a database 

 Delete a database. 

To automatically perform needed actions, you can also use command prompt parameters 

when running the database management utility (BackupRestore.exe). The table below 

describes command prompt parameters. 

Command prompt parameters 

PARAMETER  DESCRIPTION 

/OPERATION:A Start a database backup. 

/OPERATION:R Start restoring a database. 

/OPERATION:D Start deleting a database. 

/CONTAINER:<db_name> The database for which you need to perform the 
operation. 

/NETPATH:<server_name> A name of the server where the database resides. If the 
parameter is not specified, the operation is carried out 
locally. 

/ZIPFILE:<file_name> A name of the file used either to store the archive or to 
restore the database. 

/GUI:1 Display the progress bar only. 

/GUI:2 Display the progress bar and errors. 

/GUI:3 Display full graphical interface. 
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Note: To view information about all parameters, run 

backuprestore.exe /?. 

Archiving Databases 

Database archiving is used to create backup copies to avoid failures and to transfer the 

database on a remote computer. 

Important! Close the target Vibrodesigner database before archiving. 

To create a database archive: 

1. On the Windows Start menu, point to Programs, and select Vibrodesigner > 

Standard > Manage Databases. 

The Vibrodesigner-Standard Database Manager dialog box appears. 

2. Click Archive a database and then click Next. 

A dialog box appears, prompting you to select the database to be archived. 

 
Figure 230 Selecting database 

3. If the database resides on a remote computer, clear the This computer check box 

and select the database server of interest from the drop-down list. 

4. Click the Existing Databases button. 

In the Select database list, you can view the list of existing databases on the 

specified computer. 

5. From the Select database drop-down list, select the database to be archived. 
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Note: To delete the database when the archiving procedure is complete, 

select the Delete DB after archive check box. 

6. In the Destination zip-file choice box, specify a path to the file used to store the 

database archive. 

7. Click Next. 

Note: If a file with the same name exists at the specified location, you 

are prompted to either overwrite this file or cancel and then enter another 

file name. 

The selected backup parameters are displayed. 

 
Figure 231 Backup parameters 

8. Click Next. 

The archiving procedure is started. 
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Figure 232 Archiving in progress 

When completed, the successful message is displayed. 

 
Figure 233 Archiving completed 

9. Click OK. 

Restoring Databases 

You can restore a full database from the previously created archive. 

To restore a database: 

1. On the Windows Start menu, point to Programs, and select Vibrodesigner > 

Standard > Manage Databases. 

The Vibrodesigner-Standard Database Manager dialog box appears. 

2. Click Restore a database and then click Next. 

A dialog box appears, prompting you to select the archive to be restored. 
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Figure 234 Selecting archive 

3. If the database to be restored is located on a remote computer, clear the This 

computer check box and select the database server of interest from the drop-down 

list. 

4. Click . 

The Source zip-file choice dialog box appears. 

 
Figure 235 Selecting archive file 

5. Select the archive file of interest and click Open. 

A path to the selected archive file is displayed in the Source zip-archive box, and a 

file name appears in the Restore database as: box. 
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Figure 236 Choosing database name 

By default, a database name is the same as the archive file name. You can also specify 

another name of the database to be restored in the Restore database as: box. To view a 

list of existing databases on the specified computer, click the Existing Databases button. 

Vibrodesigner does not allow restoring a database with the name of the existing 

database. 

6. Click Next. 

The selected restoring parameters are displayed. 

 
Figure 237 Restoring parameters 

7. Click Next. 

The restoring procedure is started. 
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Figure 238 Restoring in progress 

When completed, the successful message is displayed. 

 
Figure 239 Restoring completed 

8. Click OK. 

Deleting Databases 

If necessary, you may delete Vibrodesigner databases. 

To delete a database: 

1. On the Windows Start menu, point to Programs, and select Vibrodesigner > 

Standard > Manage Databases. 

The Vibrodesigner-Standard Database Manager dialog box appears. 

2. Click Delete database(s) and then click Next. 

A dialog box appears, prompting you to select the archive to be deleted. 
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Figure 240 Selecting database 

3. If the database to be deleted is located on a remote computer, clear the This 

computer check box and select the database server from the drop-down list. 

4. Click the Existing Databases button. 

A list of existing databases is displayed on the right. 

5. Click a name of the database you need. 

You can also select more than one database at a time, holding CTRL or SHIFT 

down. 

6. Click Next. 

You are prompted to confirm the deletion. 

7. Click Yes. 

The deletion procedure is started. When completed, the successful message is 

displayed. 

 
Figure 241 Deletion completed 

8. Click OK. 
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Chapter 8 Event Log 

The event log is the record of system events, which is used as a troubleshooting tool to 

fix Vibrodesigner problems. All the errors occurred while working with the system are 

registered in the event log. For example, if an error occurred while exporting inspections, 

the event log will help you easily locate a cause of the problem. 

To view the event log: 

1. Select View Database Event Log from the File menu or click  on the toolbar. 

The Database Event log dialog box appears. 

 
Figure 242 Database event log 

2. Click the Refresh button. 

The last 256 event are displayed in the event list. 

Vibrodesigner provides you with three event types. The event type is indicated as a 

special icon in the Event field. 

Event message types 

ICON  NAME DESCRIPTION 

 

Information 
message 

This message informs you about events that do not affect 
the program operation. Not used in the current version. 

 

Warning A configuration error. If such an error occurred, view the 
event description in the lower pane. If necessary, ask the 
system engineer to help you solve this problem. 
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ICON  NAME DESCRIPTION 

 

Error A critical error. For example, such an error may occur 
when you try to modify a ―Read Only‖ file. 

 

The table below describes the fields displayed in the event list. 

Description of event log fields 

FIELD DESCRIPTION 

Event A brief description of the error. 

Error code A system error code in decimal and hexadecimal formats. This 
information may help the developer fix the problem. 

Date/Time (local) The local date and time on the operator’s workstation, which 
depends on the current time zone. The time displayed in the event 
log for the event occurred simultaneously in Moscow and London is 
not the same. 

Source A path to the object caused an error. If the \\XML_CONVERTER 
value is displayed, the error occurred while importing/exporting 
inspections. 

 

In the lower pane of the Database Event Log dialog box, the description of the selected 

event is displayed. 

 
Figure 243 Selected event description 

Selected event fields 

FIELD DESCRIPTION 

Date Date and time on the operator’s workstation at the moment of an 
error. 

Source A path to the object caused an error. 

Error code A system error code in decimal and hexadecimal formats. 

Message heading A Windows interpretation of the error, which depends on the 
system localization. This information may help the system engineer 
or the developer fix the problem. 
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FIELD DESCRIPTION 

Description A brief description of the error, which depends on the program 
localization. 

Additional 
description 

An additional description may contain a name of the function which 
handling caused the bug. This information may help the developer 
fix the problem. 

 

To refresh the event list: 

 Click the Refresh button. 

The request to a database is performed, and the last 256 events are displayed. 

To remove all records of the event log: 

1. Click the Clear button. 

You are prompted to confirm the operation. 

 
Figure 244 Confirmation of event log deletion 

2. Click Yes. 

All the messages stored in the server database are deleted. 

To close the event log: 

 Click  in the upper right corner of the event log, or click any other window. 

The event log is closed. 
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Chapter 9 Program Settings 

This chapter describes how to customize program settings. 

It covers the following topics: 

 Introduction 

 Program Interface Size 

 Display Ranges 

 Default Device 

 Graph Settings 

Introduction 

In the current Vibrodesigner version, you can customize GUI element size, data display 

ranges, graph display settings, as well as select the default data collector and system of 

units. 

To start customizing the program settings: 

 On the main menu, click Settings > Screen. 

The Settings dialog box appears. 
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Figure 245 Settings dialog box—Screen tab 

For detailed information on the program settings, see the following sections. 

Program Interface Size 

On the Screen tab (see Figure 245), you can specify the size of the program interface 

elements. To do so, select the option you need in the Program Interface Size section. 

You may select the largest, large, or system (recommended) element size. 

Display Ranges 

On the Data tab, you can customize the intervals used to display data in the workspace. 
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Figure 246 Settings dialog box—Data tab 

To display all the data stored in the database, click All available data. You can also 

specify a particular time interval to display data. To do so, click Within a time span, 

and then select the needed date in the from and to fields. Selecting a date is performed in 

the standard calendar dialog box. 

 
Figure 247 Calendar 

If the With a binding to current date option is selected, you can specify the following 

intervals: 

 For the last number of days/months/years 

 Within the current month/year 

 For the previous month/year. 

Default Device 

On the Device tab, you can modify information about the default data collector in use. 

This information is used for correct operation in some Vibrodesigner modes. 
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Figure 248 Settings dialog box—Device tab 

System of Units 

To select the system of units to be used while working with Vibrodesigner-Standard, do 

as follows: 

1. On the main menu, click Settings > System of Units. 

The Vibration Unit Systems dialog box appears. 

 
Figure 249 Vibration Unit Systems 

2. Select either metric or imperial system of units. 

The dB reference level is displayed at the bottom of the dialog box. 
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Chapter 10 Troubleshooting 

This chapter describes how to troubleshoot known problems in Vibrodesigner. 

It covers the following topics: 

 Loading Data Issues 

 Printing Graph Issues 

Loading Data Issues 

PROBLEM  POSSIBLE CAUSE SOLUTION 

It’s impossible 
to load 
measured data 
from STD-
500/510/3300 

After the route 
loading, the STD-
500 (or STD-
510/3300) object 
has been changed 
in the plant 
hierarchy 

Unfortunately, modifying the database between 
the route loading and measurements may result 
in loading failure. Please avoid such a situation in 
future. 

If this situation did occur, you need to load the 
route once again (thus the measured data will be 
lost), perform measurements, and then load the 
newly measured data in the database. 

Printing Graph Issues 

In the current version, data are outputted through printing of a current window. So, 

printing out spectra, waveforms or trends on black-and-white printers may result in poor 

distinctiveness of color lines on the dark-gray background (default settings). If you use a 

black-and-white printer, you need to modify color settings (via the Settings menu in the 

main menu) to display them distinctly. Set the white color for background and graph 

frames; use dark colors for graph lines. 

It is recommended to hide the left panel containing the plant hierarchy to have more 

room for graphs. To do so, click  on the toolbar. 

If graphs displayed on the Signals, Trends, Orbits, and Locus tabs cannot be printed , 

change your printer settings, as shown below. 
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Figure 250 Additional print parameters 

Local databases are not Accessible from Network 

Computers 

If users from other computers on the local network cannot access databases on your 

workstation, check Windows security settings on your computer. For more information, 

see ―Windows Security Settings for Remote Access‖. 

Using Vibrodesigner with Antivirus Programs 

Some antivirus programs running on your computer may seriously affect the 

Vibrodesigner performance. In this case, it is recommended to use another antivirus 

software or configure existing antivirus program as appropriate. 
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Chapter 11 Appendixes 

Alarm/Warning Types 

ALARM/WARNING NAME BRIEF NAME 

Warning for absolute value AV 

Warning for absolute change AC 

Warning for relative change RC 

Remaining time before failure warning RR 

 

Measurement Directions 

# SYMBOL BRIEF NAME NAME 

1 H hor Horizontal 

2 V vert Vertical 

3 A axial Axial 

4 ― ‖ ― ‖ None 

5 T tang Tangential 

6 R rad Radial 

7 X radX Radial (X) 

8 Y radY Radial (Y) 
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Inspection Report Example 
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Report fields description 

FIELD DESCRIPTION 

1 A name of the root plant. 

2 The local date and time on the operator’s workstation in the 
following format: dd.mm.yyyy hh:mm:ss. 

3 Depending on the operator’s choice, this field shows: 
―According to the latest inspection of the machine train” 
“According to the latest data from the machine train” 
“Machine train condition according to the latest data in the 
interval from dd.mm.yyyy to dd.mm.yyyy». 

4 Depending on the operator’s choice, this field shows: 
“All machine train points are included” 
“Only point with alarms or warnings are included”. 

5 A path from the plant to the machine shop for which the 
report has been created. 

6 A name of the machine. The machine shop where the 
machine is placed is also shown. 

7 The date interval (in dd.mm.yyyy – dd.mm.yyyy format) 
when the data was collected. 

8, 9, 10 Names of measurement points and shaft rotation frequency 
as follows: 
―(<point code>) <point name>: <value> <unit>», where: 
<point code> — a code of the measurement point that is 
used to measure rotation frequency, 
<point name> — a name of the measurement point, 
<value> — a value of the shaft rotation frequency, 
<unit> — a measurement unit for the shaft rotation 
frequency. 

Up to three fundamental frequencies can be displayed. 

11 Text displayed above the table with vibration and operating 
mode parameters points 

12 Text displayed above the table with calculated parameters. 

Pont code A measurement point code. 

Monitoring parameter A name of the monitored parameter/band. 

Value A value of the monitored parameter. 

Unit A measurement unit of the monitored parameter. 

Alarm level A code of alarm level active for a certain parameter. The 
following symbols can be shown: 
«А» — failure level; 
«П» — warning level; 

« » — absolute change warning level; 

« » — relative change warning level; 
«-» — no warnings/alarms. 
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FIELD DESCRIPTION 

Time before failure A number of days before exceeding the warning level. This 
is a forecasting value calculated with the least squares 
method for three previous months. Possible values: 
«number of days» — is the prognosis was calculated and 
its accuracy exceeds the permissible level. 
«>300» — the predictable exceeding the failure level will 
occur later than in 300 days or there is no failure tendency. 
«?» — the prognosis calculation failed (for example, 
insufficient data) or the prognosis accuracy is lower than 
permissible level. 

Warning A warning level value. If two levels are set for this 
parameter (the upper and lower levels), two comma-
separated numbers are displayed. The first number is the 
lower warning level; the second number is the upper 
warning level. 

Failure A failure level value. If two levels are set for this parameter 
(the upper and lower levels), two comma-separated 
numbers are displayed. The first number is the lower failure 
level; the second number is the upper failure level. 

Abs.chg. An absolute change level value. Displayed as follows: 

“<level> / <number_of_days> days”, where  
<level> — a level value; 
<number_of_days> – the number of days used to take 
data for the reference value when calculating the level 
value. 

Rel.chg. A relative change level value. Displayed as follows: 

“<level> / <number_of_days> days”, where  
<level> — a level value; 
<number_of_days> – the number of days used to take 
data for the reference value when calculating the level 
value. 

Element A name of the element within the machine the calculated 
parameter belongs to. If the calculated parameter belongs 
to a machine (not an element), the ―-‖ sign is displayed.  

 

Main Menu 

File menu 

MENU COMMAND DESCRIPTION 

Create Database Open the Create database dialog box to create a new 
database. 

Open Database Open the Open database dialog box to open the 
database of interest. 
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MENU COMMAND DESCRIPTION 

Save Save the changes in a database. 

Export data Open the Export data dialog box to export inspections. 

Import data Open the Load inspection data dialog box to import 
inspections. 

Calculate bands and 
parameters 

Compute the values of calculated frequency bands and 
calculated parameters. This operation is used 1) after 
changing band parameters and consequently deleting 
band values; 2) after modifying monitoring formulas. 

Save picture Open the Save As dialog box to save the graphs 
displayed in the workspace. 

Print Open the Print dialog box to print out the graphs 
displayed in the workspace. 

Exit Quit Vibrodesigner. 

 

Edit menu 

MENU COMMAND DESCRIPTION 

Delete Remove the selected object of the plant hierarchy. 

Rename Rename the selected object of the plant hierarchy. 

Move up Move the selected object (or the measurement point) one 
level up in the hierarchy. 

Move down Move the selected object (or the measurement point) one 
level down in the hierarchy. 

Cut Cut the selected object to the Clipboard. 

Copy Copy the selected object to the Clipboard. 

Paste Paste the object from the Clipboard to the specified 
location. 

Export structure Export the selected data structure into a text file. 

Import structure Import the data structure from a text file. 

Undo Cancel the last operation. 

 

View menu 

MENU COMMAND DESCRIPTION 

Mode > Analysis Switch to the Analysis mode  

Mode Comparison Switch to the Comparison submode of the Analysis 
mode. 
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MENU COMMAND DESCRIPTION 

Mode > Real Time Switch to the Real Time mode. 

Mode > Configuration Switch to the Configuration mode. 

Object path Display/hide a path to the selected object. 

Control panel Display/hide the toolbar. 

Status panel Display/hide the status bar. 

Plant Display the entire plant hierarchy in the Vibrodesigner 
panel (available in the Configuration mode). 

Machine shop Display machine shops in the drop-down list (available in 
the Configuration mode). 

Machine  Display machine shops and machines in the in the drop-
down lists (available in the Configuration mode). 

 

Settings menu 

MENU COMMAND DESCRIPTION 

Data  Open the Data tab of the Settings dialog box to specify 
display ranges. 

Screen Open the Application View tab of the Settings dialog 
box to specify program’s interface. 

Default Device Open the Device tab of the Settings dialog box to 
specify the default device. 

 

Help menu 

MENU COMMAND DESCRIPTION 

Vibrodesigner-Standard Help Display the online help system. 

About Vibrodesigner-
Standard 

Display the About Vibrodesigner-Standard dialog box. 

 

Keyboard Shortcuts 

KEYBOARD COMMAND ACTION  COMMENTS 

GRAY+ 
(CTRL+GRAY+) 

Zoom In Extend the X-Scale (Y-Scale) twice. 

GRAY–  
(CTRL+GRAY–) 

Zoom Out Shrink the X-Scale (Y-Scale) twice. 
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KEYBOARD COMMAND ACTION  COMMENTS 

GRAY* 
(CTRL+GRAY*) 

Autoscale Reset the initial X-Scale (Y-Scale) 
interval. 

RIGHT ARROW, 
LEFT ARROW 

 Move the cursor along the X scale. 

UP ARROW, 
DOWN ARROW 

 Select an active graph. 

CTRL+INS Add label Add a new label at the cursor location.  

CTRL+DEL> Delete label Delete the selected label. 

SHIFT+DEL Clear all labels Remove all labels from the workspace. 

 

Measurement Point Editor 

Editor Interface 

The measurement point editor screen consists of the elements described below. 

 
Figure 251 Measurement point editor interface 

1. Toolbar 

Provides buttons for common operations with measurement points. It also has the 

Undo button to cancel the last action and the Redo button to reverse the last Undo 

operation. 

2. Editor name 
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Displays information about the data collector used to measure signals in the specified 

points. 

3. Measurement points table 

Displays measurement points in a tabulated form. Here you can edit points of a 

machine element model. For more information, see ―Measurement Points Table.‖ 

4. Information about selected cell 

Displays additional information about the selected cell. 

Measurement Points Table 

You can view the measurement points table as a common table by using the scroll bar. 

Each table row represents information about a single measurement point of the machine 

element model. 

 
Figure 252 Measurement points table 

Cell values in columns set measurement point properties. Point property names are 

displayed in column headings. All point properties are grouped and each point has three 

cell groups: 

 The Point group 

This group contains cells for editing a point name, a transducer direction, and a point 

abbreviation code name. 

 The Measurement group 

This group is used to specify measurement properties of the point. Contains the 

Averaging and Spectral Window subgroups. 

 The Bands group 

This group is used to edit frequency bands and alarms/warnings. Contains the 

Band/Parameter and A/W Levels subgroups. 

To expand/collapse a cell group, click the ―+‖ or ―-‖ icon to the left of the group name. 
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Figure 253 Expanding cell group 

Note: The group icon is displayed within the first cell of a cell group 

(for example,  for a cell group containing measurements of Waveform 

type). Clicking this icon selects the entire cell group. 

Actions with rows and cells are done with the toolbar buttons and a context menu 

commands. 

Working with Rows 

To perform any action with a row, you need first to select the row. 

To select a row (one measurement point): 

 Click the cell containing the row number. 

The row is selected. 

You can perform the following actions with an entire row: 

 Add a row (at the bottom of the table) 

 Duplicate the selected row 

 Copy a row 

 Paste a row (below the selected row) 

 Replace a row 

 Move a row up and down 

 Delete a row 

You can paste or add: 

 A 1-channel point with the default parameters 

 A 2-channel point with the default parameters 

 A point which parameters correspond to parameters of a selected point 

You can perform the following actions with a Bands sub-row of the selected point: 

 Add a sub-row (at the bottom of the Bands table) 

 Paste a sub-row (below the selected sub-row) 
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 Replace a sub-row 

 Move a sub-row up and down 

 Delete a sub-row 

You can paste or add: 

 A band with the default parameters 

 A band which parameters correspond to parameters of the selected band (of the same 

or any other measurement point) 

Working with Cells 

Measurement point parameters are specified in its row cells. Depending on the cell type, 

you can change a cell value manually or select it from the drop-down list activated by 

clicking the cell. Each cell in the editor has its own format and permitted value range. 

Thus, Vibrodesigner prohibits entering inappropriate values of measurement point 

parameters. When attempting to enter a prohibited value, the system will not allow you 

to leave the cell before you correct the value. 

To perform any action with a cell, you need first to select the cell. 

To select a cell: 

 Click within the cell you need. 

The cell is selected. 

Note: To select a group cell (for example, the Point cell), click within 

the cell but not the group icon. 

You can use the copy and paste operations for each cell. Pasting the values incompatible 

with the target cell format is prohibited. You can also copy and paste group values into a 

group of cells in a row (Point, Measure, Bands). To do so, you need first to select a cell 

group. 

To select a cell group: 

 Click a group icon in the cell you need (for example,  for the Waveform 

measurement group.) 

The cell group is selected. If the cell group is collapsed, only the first cell is selected. 
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Figure 254 Selecting cell group 

You can change a column width to see all the text in the cell. To do so, drag the right 

border of the column heading to set the width you need. 

 
Figure 255 Changing column width 

Creating and Editing Measurement Points 

For each machine element, you can create all needed measurement points and specify 

their parameters. You may perform various actions with existing points: duplicate points; 

copy and then paste or replace points; change point locations; delete points. You can also 

add comments for a table row, which will be displayed when resting the mouse pointer 

over the Point cell. 

To create a 1-channel measurement point on the machine element: 

1. On the Elements tab, select the machine element you need. 

2. Select the Measurement Points tab on the right. 

3. To add a new point in the table, right-click in the table and select Add 1-channel 

point from the menu. You can also click  on the toolbar or press CTRL+P. 
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Figure 256 Creating measurement point on element 

A new 1-channel point with the default properties appears at the bottom of the table. For 

each 1-channel point, you can view and edit the following parameters: 

 Point name 

 Transducer direction 

This value is selected from a limited list (radial, tangential and so on). When 

specified, the corresponding symbol is displayed in the Code cell. 

 Point code 

This parameter is used to identify a point on graphs or in reports. Consists of three 

elements: 

 The point number on the machine 

 An abbreviation for the transducer orientation 

 An element abbreviation name that consists of up to 3 symbols. This 

abbreviation specifies the machine element where the point is placed (for 

example, HPC for "high pressure compressor", LPC for "low pressure 

compressor", and so on.) 

The point number is set automatically and cannot be changed. The only way to 

change the point number is to move the point up/down within the element model. 

The transducer orientation code is selected in the Dir. cell. Thus, in the Code cell 

you may change the element abbreviation only. The other two point code elements 

are generated automatically. 

 A measured signal 

For 1-channel point, you can select one of the following values: 

 Spectrum 

 Envelope Spectrum 

 Waveform 

 Parameter 
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 Measurement parameters 

 Averaging during data acquisition 

 Band parameters 

 Alarms/warnings for a band 

To create a 2-channel measurement point on the machine element: 

1. On the Elements tab, select the machine element you need. 

2. Select the Measurement Points tab on the right. 

3. To add a new point in the table, right-click in the table and select Add 2-channel 

point from the menu. You can also click  on the toolbar or press CTRL+O. 

Once created, a new 2-channel point appears at the bottom of the table. The Dir. and 

Code cells contains two sub-rows for each measurement channel. Notice that 

characteristics of both channels are the same, except for the measurement direction. 

 
Figure 257 Creating 2-channel point 

For each 2-channel point, you can view and edit the following parameters: 

 Point name 

 Transducer orientation 

This value is selected from a limited list (radial, tangential and so on). When 

specified, the corresponding symbol is displayed in the Code cell. Different 

directions must be specified for each channel. 

 Point code 

This parameter is used to identify a point on graphs or in reports. Consists of three 

elements: 

 The point number on the machine (the same for each channel) 

 An abbreviation for the transducer direction 
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 An element abbreviation name that consists of up to 3 symbols. This 

abbreviation specifies the machine element where the point is placed (for 

example, HPC for "high pressure compressor", LPC for "low pressure 

compressor", and so on.) 

The point number is set automatically and cannot be changed. The only way to 

change the point number is to move the point up/down within the element model. 

The transducer orientation code is selected in the Dir. cell. Thus, in the Code cell 

you may change the element abbreviation only. The other two point code elements 

are generated automatically. 

 A measured signal 

For 2-channel point, you can select one of the following values: 

 Spectrum 

 Waveform 

 Measurement parameters 

 Averaging during data acquisition 

 Band parameters 

 Alarms/warnings for a band 

To make multiple copies of a measurement point: 

1. Select the point you need. 

2. Right-click the point and select the Clone point from the menu. 

The Machine Editor dialog box appears. 

 
Figure 258 Machine Editor dialog box 

3. Type the number of points you want to create, and click OK. 

The specified amount of points with the selected point parameters appear at the 

bottom of the table. 

To duplicate a point: 

1. Select the point you need. 

2. Do one of the following: 

 Right-click the selected point and select Duplicate point from the menu. 

 Click  on the toolbar. 

 Holding the CTRL key down, click  in the Point cell and drag the point to the 

needed location (for example, at the bottom of the table). 

A new point with the selected point parameters appears at the bottom of the table. 
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To copy a point to the Clipboard: 

1. Select the point you need. 

2. Do one of the following: 

 Right-click the selected point and select Copy point from the menu. 

 Click  on the toolbar. 

 Press CTRL+C. 

The selected measurement point is copied to the Clipboard. 

To paste a point from the Clipboard: 

1. Select the point below which you want to add the previously copied point. 

2. Do one of the following: 

 Right-click the selected point and select Paste point from the menu. 

 Click  on the toolbar. 

 Press CTRL+V or CTRL+INSERT. 

The point from the Clipboard is inserted below the selected measurement point. 

To replace a point: 

1. Select the measurement point you want to replace with the previously copied point. 

2. Right-click the selected point and select Replace point from the menu. 

The selected point is replaced with the point from the Clipboard. 

To change the point order in the list: 

1. Select the point you need. 

2. Do one of the following: 

 Right-click the selected point and select Move up or Move down from the menu. 

 Click  in the Point cell and drag the point to the needed location. 

The point position is changed. 

To delete a measurement point: 

1. Select the point to be deleted. 

2. Do one of the following: 

 Right-click the selected point and select Delete point from the menu. 

 Click  on the toolbar. 

 Press CTRL+X or CTRL+DELETE. 
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The selected point is deleted. 

To create a comment for the measurement point: 

1. Select the point of interest by clicking the row number. 

2. Right-click the selected row and select Insert comment from the menu. 

The Machine editor dialog box appears. 

 
Figure 259 Machine Editor dialog box 

3. Enter any necessary comments and click OK. 

A small red icon appears in the upper right corner of the Point cell. When you rest 

the mouse pointer above this cell, the comment is shown in a popup window. 

 
Figure 260 Viewing point comment 

Measurement Parameters for Different Devices 

STD-500 Signal Parameters 

If a STD-500 data collector is selected for a machine, all parameters of this machine 

points will match STD-500 specifications. 
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To adjust parameters of a measured waveform: 

1. In the Measure cell, select the type of measured signal (waveform). 

2. Set the number of samples you need. 

 
Figure 261 Measurement properties for STD-500 

The rest of the device parameters are disabled and are calculated according to the 

number of samples and the STD-500 capabilities. 

CTD-2060 Signal Parameters 

If a CTD-2060 data collector is selected for a machine, all parameters of this machine 

points will match CTD-2060 specifications. 

To adjust parameters of a measured waveform: 

1. In the Measure cell, select the type of measured signal (waveform). 

2. Set the number of samples you need. 
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Figure 262 Measurement properties for CTD-2060 

The rest of the device parameters are disabled and are calculated according to the 

number of samples and the CTD-2060 capabilities. 

STD-3300 Signal Parameters 

If a STD-3300 analyzer is selected for a machine, all parameters of this machine points 

will match STD-3300 specifications. Using a STD-3300, you can measure either a 

waveform or vibration parameter. 

To adjust parameters of a measured signal: 

1. In the Measure cell, select the type of measured signal (waveform or parameter). 

2. In the row cells, select the measurement parameters of interest. 
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Figure 263 Measurement properties for STD-3300 

How to Create and Edit Bands 

To create a band in a measurement point: 

1. On the Elements tab, select the machine element you need. 

2. Click the Measurement points tab on the right. 

The table displays a list of measurement points. 

3. In the group cell Bands of the measurement point you need, click the  icon. 

The Bands group of the measurement point is selected. 

4. Right-click in the table and select Create band from the menu. You can also use the 

 button or press CTRL+B. 

At the bottom of the Bands sub-table of the selected measurement point, a new band 

appears. 

5. In the Band/Parameter cell, type the band name you need. 

6. Repeat Steps 4-5 to create all necessary bands for the measurement point. 

The picture below shows 11 bands created at the selected measurement point. 
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Figure 264 Eleven bands 

To perform any action with a band, you need first to select the band. 

To select a band: 

 Click the group icon ( ) in the Band/Parameter cell. 

The band is selected. 
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Figure 265 Selecting band 

To duplicate a band: 

1. Select the band you need. 

2. Do one of the following: 

 Right-click the selected band and select Duplicate band from the menu. 

 Click  on the toolbar. 

 Holding the CTRL key down, click  in the Band/Parameter cell and drag the 

band in the needed location (for example, at the bottom of the sub-table). 

A new band with parameters identical to those of the selected band appears at the 

bottom of the Bands table. 

To copy a band: 

1. Select the band you need. 

2. Do one of the following: 

 Right-click the selected band and select Copy parameter from the menu. 

 Click  on the toolbar. 

 Press CTRL+C. 

The selected band is copied to the Clipboard. 

To paste a band: 

1. Select the band below which you want to add the previously copied band. 

2. Do one of the following: 
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 Right-click the selected band and select Paste parameter from the menu. 

 Click  on the toolbar. 

 Press CTRL+V or CTRL+INSERT. 

The band from the Clipboard is inserted below the selected band. 

To replace a band: 

1. Select the band you want to replace with the previously copied band. 

2. Right-click the selected band and select Replace parameter from the menu. 

The selected band is replaced with the band from the Clipboard. 

To change the band order in the list: 

1. Select the band you need. 

2. Do one of the following: 

 Right-click the selected band and select Move up or Move down from the menu. 

 Click  in the Band/Parameter cell and drag the band in the needed location. 

The band position is changed. 

To delete a band: 

1. Select the band to be deleted. 

2. Do one of the following: 

 Right-click the selected band and select Delete parameter from the menu. 

 Click  on the toolbar. 

 Press CTRL+X or CTRL+DELETE. 

The selected band is deleted. 

Adjusting Absolute Band 

To adjust an absolute band: 

 Enter into the table cells the necessary parameter values for the created bands: 

 Band name 

 Band measurement unit 

 Band type (Abs) 

 Lower frequency of a band (Flow) 

 Upper frequency of a band (Fhigh) 

 Warning+ level (W+) 
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 Alarm+ level (A+) 

 Warning level for value change (D) 

 Warning level for percentage change (s) 

Note: (W-) and (A-) levels are not used for bands. They may be set for 

parameters only. 

Adjusting Relative Bands 

Before adjusting a relative band, you need first to define fundamental frequencies for a 

machine element model. The actual range of a relative band depends on the fundamental 

frequency in use and is constantly changed over time. Hence, for calculating RMS in a 

relative band: 

1. The center frequency is calculated. 

This frequency is linked to the shaft rotation frequency. The fundamental frequency 

value is not defined explicitly as this value is measured at the moment of calculation 

and depends on the machine operating mode. 

2. The band limits are calculated. 

RMS in the band frequency range is calculated in accordance with the lower and 

upper frequencies of the band. 

Having created fundamental frequencies, you may adjust your relative bands. 

To adjust relative bands for a machine element: 

1. Click the Measurement points tab. 

2. In the Type cell of the band you need, select a band type from the drop-down list. 

For a relative band, you can choose one of the following values: 

 Rel, % (a band boundaries are set as a fixed percentage of the center frequency). 

 Rel, Hz (a band boundaries are set as an offset in hertz from the center 

frequency). 

3. Specify the center frequency. To do so, in the first Fc cell specify the multiplier, and 

then select the needed fundamental frequency in the second Fc cell (Fc means center 

frequency). Fundamental frequencies are added on the Fundamental frequencies 

tab (see above in this section) 

The center frequency is calculated as Fc = k*N, where k is a multiplier (typically, 

0.5, 1, 2 or 3), and N is the fundamental frequency (it is equal to the shaft rotation 

frequency at the moment of band calculation). The multiplier specifies the harmonic 

number of the fundamental frequency for which the relative band is calculated. As a 

result, using the multiplier and the fundamental frequency, you may specify a certain 

logical frequency multiple to the shaft rotation frequency. 

4. Specify the lower frequency of the band. 
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For the Rel, % band type, the lower boundary is set in percentage; the accuracy is 

one decimal place. For the Rel, Hz band type, the lower boundary is set in Hz; the 

accuracy is up to two decimal places. Only positive numbers are acceptable. 

5. Specify the upper frequency of the band. 

For the Rel, % band type, the upper boundary is set in percentage; the accuracy is 

one decimal place. For the Rel, Hz band type, the upper boundary is set in Hz; the 

accuracy is up to two decimal places. Only positive numbers are acceptable. 

6. If necessary, clear the Calc. check box. 

If this check box is selected, the band value is calculated from the measured 

(recorded) signal. If the check box is not selected, the band value is recorded to the 

database in the same way signal values are; the band value is not automatically 

calculated neither recorded to the database. 

Measuring Peak or Peak/Peak in the Point 

To specify measurement of peak or peak/peak in a measurement point: 

1. On the Elements tab, select the machine element you need. 

2. Click the Measurement points tab on the right. 

The table displays a list of measurement points. 

3. In the group cell Bands of the measurement point you need, click the  icon. 

The Bands group of the measurement point is selected. 

4. Right-click in the table and select Create band from the menu. You can also use the  

button or press CTRL+B. 

At the bottom of the Bands sub-table of the selected measurement point, a new band 

appears. 

5. In the Band/Parameter cell, type the band name you need and press ENTER. 

6. To measure a signal amplitude in the point, select Peak in the Type cell. 

7. To measure a peak-peak value in the point, select Peak-peak in the Type cell. 

8. Select the Calc. check box if you need to calculate peak or peak-peak from the 

signal. If the check box is not selected, these values will be recorded from the 

inspection data. 

Configuring Calculated Parameters 

Use of Calculated Parameters 

Calculated parameters is a powerful tool for machine diagnostics. In fact, calculated 

parameters are scalar values computed from current measured or calculated machine 

parameters using specified formulas. During each inspection, calculated parameters are 
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automatically computed and saved into the database. Thus, you can create and monitor 

calculated parameters trends. Such trends can be viewed and analyzed as any other 

parameter trends in Vibrodesigner, e.g. band trends, shaft trends and so on. Analyzing 

trends allows you to trace data tendencies and predict subsequent data changes. For more 

information on parameter trends analysis, see ―Viewing Trends.‖ 

You can specify alarm/warning levels for calculated parameters. If the parameter 

exceeded a threshold level, an exclamation mark is displayed in the plant hierarchy (see 

―Analysis of Active Alarms/Warnings‖). Specifying monitoring formulas serves the 

needs of automating defect development inspection.  

Calculated parameters are specified for element or machine models. They can be added 

into trend set for simultaneous monitoring along with other parameter trends. 

Monitoring Formulas Editor Interface 

Specifying calculated parameters is performed on the Monitoring formulas tab of a 

particular machine model or element model. 

 
Figure 266 Monitoring formulas tab 

The calculated parameters editor consists of the following elements: 

 Toolbar providing buttons for common operations. 

 Table of parameters 

 
Figure 267 Calculated parameters table 
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Each table row represents information about a single calculated parameter. In a row cells, 

you can set the following: 

 Calculated parameter name 

 Calculated parameter measurement unit 

 Formula used for computing the parameter 

 Alarms/warning thresholds 

 Monitoring formula variables 

The A/W Levels and Variables columns contain cell groups. To expand/collapse a cell 

group, click the ―+‖ or ―-‖ icon to the left of the group name. 

The Variables group cell may include multiple sub-rows each of which describes one 

input variable. 

 
Figure 268 Variables group cell 

Note: The group icon is displayed within the first cell of a cell group 

(for example,  for the Variables group). Clicking this icon selects the 

entire cell group. 

Actions with rows and cells are done with the toolbar buttons and a context menu 

commands.  

Working with Rows 

To perform any action with a row, you need first to select the row. 

To select a row (calculated parameter): 

 Click the cell containing the row number. 

The row is selected. 

You can perform the following actions with an entire row: 

 Add a row (at the bottom of the table) 

 Duplicate the selected row 

 Copy a row 

 Paste a row (below the selected row) 

 Move a row up and down 

 Delete a row 

You can paste or add: 

 Calculated parameter (row) with the default parameters 
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 Calculated parameter (row) which parameters correspond to parameters of a selected 

row 

You can move up/down table’s rows. You can copy a selected row. It is possible to 

delete a selected row.  

You can perform the following actions with a Variables sub-row of the selected row: 

 Add a sub-row (at the bottom of the Variables table) 

 Paste a sub-row (below the selected sub-row) 

 Copy a sub-row 

 Delete a sub-row 

In the Variables group, you can paste or add: 

 A sub-row (variable) with the default parameters 

 A sub-row (variable) with the parameters of selected sub-row 

You can also copy the selected sub-row or delete one Variables sub-row. 

Working with Cells 

To perform any action with a cell, you need first to select the cell. 

To select a cell: 

 Click within the cell you need. 

The cell is selected. 

Note: To select a group cell (for example, the Variables cell), click 

within the cell but not the group icon. 

You can use the copy and paste operations for each cell. Pasting the values incompatible 

with the target cell format is prohibited. You can also copy and paste group values into a 

group of cells in a row (Regions, Variables). To do so, you need first to select a cell 

group. 

To select a cell group: 

 Click a group icon in the cell you need (for example,  for the Variables group.) 

The cell group is selected. If the cell group is collapsed, only the first cell is selected. 

You can edit any table’s cell. Editing capabilities of a particular cell depend on cell data 

format and cell value restrictions. 

You can change a column width to see all the text in the cell. To do so, drag the right 

border of the column heading to set the width you need. 

Creating and Editing Calculated Parameters 

For each machine element or machine, you can create all needed calculated parameters  

and specify monitoring formulas. You may perform various actions with existing 
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calculated parameters: duplicate parameters; copy and then paste or replace parameters; 

change the parameters order; delete parameters. You can also add comments for a table 

row, which will be displayed when resting the mouse pointer over the Parameter Name 

cell. 

To create a calculated parameter: 

1. Select either a target machine element on the Elements tab or a target machine 

model on the Elements tab. 

2. Select the Monitoring formulas tab on the right. 

3. To add a new calculated parameter in the table, right-click in the table and select 

Create parameter from the menu. You can also click  on the toolbar. 

A new row with the default properties appears at the bottom of the table.  

4. In the Parameter cell, type the name of the parameter. 

5. In the Unit cell, select the parameter measurement unit of interest from the drop-

down list. 

6. In the Variables group cell, specify all the needed variables to be used in the 

monitoring formula. For more information about creating variables, see ―Creating 

and editing monitoring formula variables‖. 

7. Double-click the Monitoring formula cell. 

The Monitoring formula dialog box appears. 

 
Figure 269 Monitoring formula dialog box 

8. Specify the formula to be used for computing the parameter. You can use any 

VBScript statements as a formula. For more information about VBScript operators 

and functions, see ―Monitoring Formulas and VB Script Overview‖. You can also 
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use object-calculator featues that enables you to utilize predefined methods, e.g. 

envelope spectrum for trends. For more information, refer to ―Using Object-

Calculator.‖ 

Note: You must assign the calculated value to the Result variable at the 

end of any monitoring formula. The program retrieves the resultant value 

from this reserved variable. 

9. If necessary, specify alarms/warnings for the calculated parameter. To do so, click 

the «-» sign in the A/W Levels column and then enter the needed values in the cells. 

The table below briefly describes available alarms/warnings. 

 
Figure 270 A/W Levels cell group 

Calculated parameter alarms 

CELL NAME DESCRIPTION 

W+ Upper level of the warning 

А+ Upper level of the alarm 

W- Lower level of the warning 

А- Lower level of the alarm 

D Warning for absolute change 

s Warning for relative change 

Tmeas The number of reference days for calculating warnings for changes. 

 

To edit a monitoring formula: 

1. In the row of the calculated parameter of interest, select the Monitoring formula 

cell. 

2. Do one of the following: 

 Right-click the selected cell and then select Edit from the menu. 

 Click  on the toolbar. 

The Monitoring formula dialog box is displayed. 

3. Modify the monitoring formula of the calculated parameter and click OK. 

The changed formula is saved. 

To duplicate a calculated parameter: 

1. Select the parameter you need. 
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2. Do one of the following: 

 Right-click the selected row and select Duplicate parameter from the menu. 

 Click  on the toolbar. 

A new row with the selected parameter properties appears at the bottom of the table. 

To change the calculated parameters order in the list: 

1. Select the parameter you need. 

2. Do one of the following: 

 Right-click the selected row and select Move up or Move down from the menu. 

 Click the row number of interest and drag the row to the needed location. 

The parameter position is changed. 

To delete a calculated parameter: 

1. Select the parameter to be deleted. 

2. Do one of the following: 

 Right-click the selected parameter and select Delete parameter from the menu. 

 Click  on the toolbar. 

 Press CTRL+X or CTRL+DELETE. 

The selected parameter is deleted. 

Creating and editing monitoring formula variables 

Before specifying a monitoring formula, you need to create an input variables array. 

Each variable is defined by : 

 Name which must meet the VBScript naming conventions. A name of the variable: 

 Must start with a letter 

 Has no «period» symbols 

 Consists of less than 255 symbols 

 Must be unique within the formula 

 Type (integer, float, bool) 

 Size (scalar, vector) 

 Reference to a data source 

Note: A variable is a sub-row of the calculated parameter row. 

To create a variable: 

1. Select the Variables cell of the needed calculated parameters. 
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2. Do one of the following: 

 Right-click the selected cell and then Add variable from the menu. 

 Click  on the toolbar. 

A new variable with the default properties appears at the bottom of the Variables 

table.  

3. In the Name cell, specify a name of the variable. 

4. In the Type cell, select the variable type. 

5. In the Size cell, specify the variable size. 

6. Double-click the Data source cell and select a data source for the variable. As a data 

source, you can select one of the following object types: 

 Waveform 

 Spectra 

 Parameter 

 Calculated spectra 

 Band 

 Calculated parameter 

 Alarm/warning 

To delete a variable: 

3. Select the variable to be deleted. 

4. Do one of the following: 

 Right-click the selected band and select Delete from the menu. 

 Click  on the toolbar. 

 Press CTRL+X or CTRL+DELETE. 

The selected variable is deleted. 

Excel File Format When Exporting Inspections 

When exporting inspection data into Microsoft Excel, a file containing multiple lists is 

created. The sections below describe the format of each list. 

Machine List 

The Machine list shows general information on a completed inspection. The data are 

displayed in three column. The first column shows inspection parameter names. The 
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second column contains values of the inspection parameters. The third column shows a 

brief description of inspection parameter values. The table below describes inspection 

parameters. 

Inspection parameters 

PARAMETER VALUE  DESCRIPTION 

CompanyID Company system ID Company name 

PlantID Plant system ID Plant name 

ShopID Machine shop system ID Machine shop name 

MachineID Machine system ID Machine name 

regime System ID of machine working 
mode 

Name of the machine 
working mode 

InspectionStatusID Inspection status system ID Inspection status name 

StartTimeLocal Starting inspection local time  

StopTimeLocal Finishing inspection local time  

bias The difference between the 
workstation local time and UTC. 

 

ParametersNum The number of inspected 
parameters 

 

VibroNum The number of inspected 
measurement points  

 

 

Parameters List 

The Parameters list shows information on inspected machine parameters. 

Machine parameters 

FIELD DESCRIPTION 

PointNum Number of measurement point 

Dir Brief name of transducer orientation 

Abbrev Code abbreviation of point 

UnitType Parameter measurement unit 

DirCode Measurement direction code 

UnitTypeCode Parameter measurement unit code 

Time Measurement period 

Validity Data validity flag 

Value Parameter value 
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Wave List 

The Wave list shows information about measured signals in the measurement points. 

Each point is displayed on a separate list. A name of the list includes the point number 

and measurement direction code, e.g. Waves1-10. 

Measured signal parameters 

FIELD DESCRIPTION 

PointNum Number of measurement point 

Dir Brief name of transducer orientation 

Abbrev Code abbreviation of point 

UnitType Parameter measurement unit 

DirCode Measurement direction code 

UnitTypeCode Parameter measurement unit code 

Time Measurement time 

HighFreq Upper frequency of the measurement band 

Samples Number of samples 

AverageType Averaging type 

AverageNumber Number of averages 

AverageSyncType Average synchronization type 

MinValue Minimum value of measured signal 

MaxValue Maximum value of measured signal 

Validity Data validity flag 

Value All values of the measured signal 

SyncCount Number of synchronized waveforms 

SyncID Synchronizad waveform ID 

 

Bands List 

The Bands list shows information on measurement bands. Each point is displayed on a 

separate list. A name of the list includes the point number and measurement direction 

code, e.g. Bands1-10. 
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Band parameters 

FIELD DESCRIPTION 

PointNum Number of measurement point 

Dir Brief name of transducer orientation 

Abbrev Code abbreviation of point 

UnitType Parameter measurement unit 

DirCode Measurement direction code 

UnitTypeCode Parameter measurement unit code 

Time Measurement time 

BandsCount Number of band in the measurent point  

BandID Band ID 

BandType Band type 

FreqType Frequency type 

ValueType Value type 

Fc Center frequency 

Flow Lower frequency 

Fhigh Upper frequency 

TachoPointNum Number of tachoparameter 

Validity Data validity flag 

Value RMS value in the band 

PhaseValue-Degree Band phase value (for relative bands only) 

CuttingRelBandsCount Amount of cutting fundamental frequencies (for remainder band 
type) 

CuttingRelBands Cutting Fundamental frequencies references  

 

Sync List 

The Sync list shows information on synchronized waveforms (if any). Each point is 

displayed on a separate list. A name of the list includes the waveform number, e.g. 

Sync1. 

Synchronized waveforms parameters 

FIELD DESCRIPTION 

PointNum Number of measurement point 

Time Measurement time 
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FIELD DESCRIPTION 

Resolution Waveform collection resolution (Hz) 

Numbers Number of samples with synchrolabels 

 

Monitoring Formulas and VB Script Overview 

This appendix describes main VBScript operators and statements, as well as embedded 

VBScript math functions. 

VBScript Operators 

VBScript encompasses the full set of operators: 

 Arithmetic operators 

 Logical operators 

 Comparison and concatenation operators 

When several operations occur in an expression, each part is evaluated and resolved in a 

predetermined order called operator precedence. Parentheses can be used to override the 

order of precedence and force some parts of an expression to be evaluated before other 

parts. Operations within parentheses are always performed before those outside. Within 

parentheses, however, normal operator precedence is maintained. When expressions 

contain operators from more than one category, arithmetic operators are evaluated first, 

comparison operators are evaluated next, and logical operators are evaluated last. 

Comparison operators all have equal precedence; that is, they are evaluated in the left-to-

right order in which they appear. Arithmetic and logical operators are evaluated in the 

following order of precedence: 

VBScript operators 

ARITHMETIC COMPARISON LOGICAL 

Negation (-) Equality (=) Not 

Exponentiation (^) Inequality (<>) And 

Multiplication and 

division (*, /) 
Less than (<) Or 

Integer division (\) Greater than (>) Xor 

Modulus arithmetic 

(Mod) 
Less than or equal to (<=) Eqv 

Addition and 

subtraction (+, -) 
Greater than or equal to (>=) Imp 

String concatenation 

(&) 
Is & 
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When multiplication and division occur together in an expression, each operation is 

evaluated as it occurs from left to right. Likewise, when addition and subtraction occur 

together in an expression, each operation is evaluated in order of appearance from left to 

right. 

The string concatenation operator (&) is not an arithmetic operator, but in precedence it 

does fall after all arithmetic operators and before all comparison operators. The Is 

operator is an object reference comparison operator. It does not compare objects or their 

values; it checks only to determine if two object references refer to the same object. 

VBScript Conditional Statements 

Very often when you write code, you want to perform different actions for different 

decisions. You can use conditional statements in your code to do this. In VBScript we 

have the following conditional statements: 

 if statement – use this statement if you want to execute a set of code when a 

condition is true. 

 if...then...else statement – use this statement if you want to select one of two sets of 

lines to execute.  

You should use the If...Then...Else statement if you want to either execute some code 

if a condition is true or select one of two blocks of code to execute. If you want to 

execute more than one statement when a condition is true, you must put each 

statement on separate lines and end the statement with the keyword "End If". If you 

want to execute a statement if a condition is true and execute another statement if the 

condition is not true, you must add the "Else" keyword. 

 if...then...elseif statement – use this statement if you want to select one of many sets 

of lines to execute  

You can use the if...then...elseif statement if you want to select one of many blocks 

of code to execute. 

 select case statement – use this statement if you want to select one of many sets of 

lines to execute  

You can also use the SELECT statement if you want to select one of many blocks of 

code to execute. 

VBScript Looping Statements 

Very often when you write code, you want to allow the same block of code to run a 

number of times. You can use looping statements in your code to do this. In VBScript 

there are four looping statements: 

 For...Next statement – runs statements a specified number of times.  

You can use a For...Next statement to run a block of code, when you know how 

many repetitions you want. You can use a counter variable that increases or 

decreases with each repetition of the loop. The For statement specifies the counter 

variable (i) and its start and end values. The Next statement increases the counter 
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variable (i) by one. Using the Step keyword, you can increase or decrease the counter 

variable by the value you specify.  

 For Each...Next statement – runs statements for each item in a collection or each 

element of an array. 

A For Each...Next loop repeats a block of code for each item in a collection, or for 

each element of an array.  

 Do...Loop statement – loops while or until a condition is true. 

You can use Do...Loop statements to run a block of code when you do not know how 

many repetitions you want. The block of code is repeated while a condition is true or 

until a condition becomes true.  

 While...Wend statement – Do not use it - use the Do...Loop statement instead. 

VBScript Math Functions 

VBScript math functions 

FUNCTION DESCRIPTION 

Abs(number) Returns the absolute value of a specified number 

Atn(number) 

Returns the arctangent of a number. The Atn function takes the 
ratio of two sides of a right triangle (number) and returns the 
corresponding angle in radians. The ratio is the length of the side 
opposite the angle divided by the length of the side adjacent to 
the angle. The range of the result is -pi /2 to pi/2 radians. To 
convert degrees to radians, multiply degrees by pi/180. To 
convert radians to degrees, multiply radians by 180/pi. 

Cos(number) 

Returns the cosine of an angle. The Cos function takes an angle 
and returns the ratio of two sides of a right triangle. The ratio is 
the length of the side adjacent to the angle divided by the length 
of the hypotenuse. The result lies in the range -1 to 1. To convert 
degrees to radians, multiply degrees by pi /180. To convert 
radians to degrees, multiply radians by 180/pi. 

Exp(number) Returns e (the base of natural logarithms) raised to a power. 

Fix(value) Returns the integer part of a specified number 

Hex(value) 
Returns a string representing the hexadecimal value of a number. 
If number is not already a whole number, it is rounded to the 
nearest whole number before being evaluated. 

Int(value) 
Returns the integer portion of a number. The number argument 
can be any valid numeric expression. If number contains Null, 
Null is returned. 

Log(number) 

Returns the natural logarithm of a number. The number argument 
can be any valid numeric expression greater than 0. 

The natural logarithm is the logarithm to the base e. The constant 
e is approximately 2.718282.You can calculate base-n logarithms 
for any number x by dividing the natural logarithm of x by the 
natural logarithm of n as follows: Logn(x) = Log(x) / Log(n) 
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FUNCTION DESCRIPTION 

Rnd(number) Returns a random number less than 1 but greater or equal to 0 

Sgn(number) Returns an integer indicating the sign of a number. 

Sin(number) 

Returns the sine of an angle. The Sin function takes an angle and 
returns the ratio of two sides of a right triangle. The ratio is the 
length of the side opposite the angle divided by the length of the 
hypotenuse. The result lies in the range -1 to 1. To convert 
degrees to radians, multiply degrees by pi /180. To convert 
radians to degrees, multiply radians by 180/pi. 

Sqr(number) Returns the square root of a number. 

Tan(number) 

Returns the tangent of an angle. Tan takes an angle and returns 
the ratio of two sides of a right triangle. The ratio is the length of 
the side opposite the angle divided by the length of the side 
adjacent to the angle. To convert degrees to radians, multiply 
degrees by pi /180. To convert radians to degrees, multiply 
radians by 180/pi. 

Working with Array Variables in Monitoring Formulas 

To declare an array variable in the monitoring formulas editor, you have to choose Array 

in the Dimension cell, as shown in the picture below. 

 
Figure 271 Creating array variable 

You can use the following methods when working with array variables: Variable.Item(i) 

and Variable.Count, where Variable – a name of the array variable created in the 

monitoring formulas editor by the user, Item (i) and Count – variable methods.  

These methods are not VBScript properties—they are only used in the monitoring 

formulas editor for array handling. 

The result of the Variable.Item(i) method is an i element of the array. 

The result of the Variable.Count method is an array size (the number of array elements). 

Note: You have to use the ―.‖ (dot) delimiter between a variable name 

and variable method. 

Using array methods to calculate wave peak-to-peak value (example) 

If wave.count > 0 Then  

max=wave.item(0) 

min=wave.item(0) 

For x = 0 To (wave.count - 1) 
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Value = wave.item(x) 

If max < value Then 

max = value 

End If 

Next 

Result = (max – min) 

end if 

Using Object-Calculator 

You can use in the monitoring formulas the object-calculator which is initialized by a 

wave and fundamental frequency values, and helps you to calculate some important wave 

characteristics not using bulk VBScript statements. 

Examples of object-calculator and its methods usage are shown in the last section. 

Creating Object-Calculator 

To use the object-calculator in your formula, insert the following string at 

the beginning of the formula: 

Set vdePointData = CreateObject("VdeMath.VdePointData"), 

where the vdePointData variable can have any name. 

Wave and fundamental frequency value initialization 

To initialize a wave, insert the following string in the formula: 

vdePointData.SetWave <Wave>, <Fhigh>, 

where Wave – wave array variable; Fhigh – upper frequency of the wave. 

To initialize a fundamental frequency value, insert the following string in 

the formula: 

vdePointData.SetN <N>, <F>,  

where N – fundamental frequency number; F – frequency value in Hertz. 

Using object-calculator to calculate data and to access data 

This section contains description of object-calculator data calculating and data 

accessing methods. 

To receive array of wave samples, use the following variable 

vdePointData.Wave 
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where Wave – array of wave samples. When working with the Wave variable, you can 

use the same methods as for any array (Item(i) and Count (see ―Working with Array 

Variables‖)). 

To receive array of spectrum lines, use the following variable 

vdePointData.Spectrum 

where Spectrum – spectrum lines array. The number of lines and step are calculated 

automatically using the upper frequency. When working with the Spectrum variable, you 

can use the same methods as for any array (Item(i) and Count (see ―Working with Array 

Variables‖)). 

To receive a fundamental frequency value, use the method 

vdePointData.N(<N>) 

where N – the number of fundamental frequency (the same as was set in SetN – see 

above). 

To receive a filtered signal from the original wave, use the method 

vdePointData.Filter(<Flow>, <Fhigh>, <Type>) 

where Flow – lower frequency of the filter in Hz, Fhigh – upper frequency of the filter in 

Hz, Type – a filter type (1 – the specified band is cut, 0 – the specified band is used). 

When working with the Filter variable, you can use the same methods as for any array. 

To receive an envelope spectrum, use the method 

vdePointData.EnvelopeSpectrum(<Flow>, <Fhigh>) 

where Flow – the lower frequency of envelope filter in Hertz, Fhigh - the upper 

frequency of envelope filter in Hertz. When working with this variable, you can use the 

same methods as for any array. 

To receive RMS in the absolute band, use the method 

vdePointData.AbsRMS(<Flow>, <Fhigh>) 

where Flow – the lower frequency of the band in Hertz, Fhigh - the upper frequency of 

the band in Hertz. The result is scalar. 

To receive RMS in the relative band (deviation from the center frequency is 

expressed in Hz), use the method 

vdePointData.RelHzRMS(<Left>, <Right>, <N>, <Coef>) 

where Left - the width of the left band (from the center) in Hertz, Right - the width of the 

right band (from the center) in Hertz, N - the number of fundamental frequency for the 

center frequency, Coef – fundamental frequency multiplier. The result is scalar. 

To receive RMS in the relative band  (deviation from the center frequency is 

expressed in %), use the method 

vdePointData.RelPercentRMS(<Left>, <Right>, <N>, <Coef>) 
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where Left – the width of the left band (from the center) in percentage of center 

frequency, Right - the width of the right band (from the center) in percentage of center 

frequency, N – the number of fundamental frequency for the center frequency, Coef – 

fundamental frequency multiplier. The result is scalar. 

To receive the average value of wave, use the method 

vdePointData.Average 

To receive the wave magnitude value within the period, use the method 

vdePointData.Peak(<Tlow>, <Thigh>) 

where Tlow - start time of the range in seconds (0 – not used), Thigh – end time of the 

range in seconds (0 – not used). 

To receive the Peak-Peak value within the period, use the method 

vdePointData.PkPk(<Tlow>, <Thigh>) 

where Tlow and Thigh the same as described above. 

To receive the Crest value within the period, use the method 

vdePointData.Crest(<Tlow>, <Thigh>) 

To receive the Kurtosis value within the period, use the method 

vdePointData.Kurtosis(<Tlow>, <Thigh>) 

To receive the Skewness value within the period, use the method 

vdePointData.Skewness(<Tlow>, <Thigh>) 

Using object-calculator to transform data 

This section contains description of object-calculator data transforming methods. 

These methods affect the return values of the data calculating and data getting methods 

described above. 

To differentiate wave, use the method 

vdePointData.ApplyDif 

To integrate wave, use the method 

vdePointData.ApplyInt 

To filter wave, use the method 

vdePointData.ApplyFilter <Flow>, <Fhigh> 

where Flow – lower frequency, and Fhigh – upper frequency of the filter in Hz  

To reset the object data to the original wave, use the method 

vdePointData.Reset 
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Using object-calculator in the Machine Element formulas (examples) 

Let the upper frequency of the wave is 4000 Hz, and its measure unit is ―mm/s‖. 

Formula to calculate the Crest value 

Set vdePointData = CreateObject("VdeMath.VdePointData") 

vdePointData.SetWave wave, 4000.0 

Result = vdePointData.Crest(0.0, 0.0) 

Formula to calculate Peak-Peak value of the integrated wave (i.e. in “mkm”) in the 

frequency band of 50-60 Hz 

Set vdePointData = CreateObject("VdeMath.VdePointData") 

vdePointData.SetWave wave, 4000.0 

vdePointData.ApplyInt 

vdePointData.ApplyFilter 50, 60 

Result = vdePointData.PkPk(0.0, 0.0) 

Using object-calculator in the Machine formulas (example) 

Let the machine model has one fundamental frequency, and its measure unit is ―rpm‖. 

Formula to calculate RMS value in the relative band “±5% from tripled 

fundamental frequency” 

’Variable N1 is link to the fundamental frequency 

Set vdePointData = CreateObject("VdeMath.VdePointData") 

vdePointData.SetWave wave, 4000.0 

vdePointData.SetN 1, N1/60.0 

Result = vdePointData.RelPercentRMS(5.0, 5.0, 1, 3.0) 

Windows Security Settings for Remote Access 

To enable remote access to the databases located on your workstation, you need to 

specify special Windows security settings. Choose one of the procedures below 

depending on the OS installed on your computer. 

To connect to a ASTD-2 machine shop system or databases located on remote computers 

on the local network, you also need to properly configure security settings of the OS 

installed on your computer
9
. 

                                                      

9
 If you have already configured necessary security settings for remote access to the databases 

located on your workstation, there is no need in these additional steps. 
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Windows 2000 SP4 

To enable access to the databases on your computer
10

: 

1. On the Windows Start menu, select Run. 

The Run dialog box is displayed. 

 
Figure 272 Run dialog box 

2. In the Open box, type dcomcnfg and click OK. 

The Distributed COM Configuration Properties dialog box appears. 

3. Click the Default Properties tab and specify the settings as in the picture below. 

 
Figure 273 Distributed COM Configuration Properties—Default Properties 

tab 

                                                      

10
 To enable access to remote databases and ASTD-2 machine shop system, go through Steps 1-7 

only. 
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4. Click the Apply button and then click the Default Security tab. 

5. In the Default Access  Permissions section, click the Edit Permissions button and 

specify the settings as in the picture below. 

 
Figure 274 Registry Value Permissions dialog box 

6. From the Type of Access list, select Allow Access and click OK. 

7. In the Default Launch Permissions section, click the Edit Permissions button and 

specify the settings as in the picture below. 

 
Figure 275 Registry Value Permissions dialog box 

8. From the Type of Access list, select Allow Launch and click OK. 

9. Click the Apply button and then click the Applications tab. 
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10. On the Applications tab, select VD SERVER from the list. 

The VD SERVER Properties dialog box appears. 

11. On the General tab, specify the settings as in the picture below. 

 
Figure 276 VD SERVER Properties 

12. Click the Security tab. 

13. Select Use custom access permissions and then click the Edit button. 

The Registry Value Permissions dialog box appears. 
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Figure 277 Registry Value Permissions 

14. From the Type of Access list, select Allow Access and click OK. 

15. Select Use custom launch permissions and then click the Edit button. 

The Registry Value Permissions dialog box appears. 

 
Figure 278 Registry Value Permissions 
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16. From the Type of Access list, select Allow Launch and click OK. 

Windows XP SP1 

To enable access to the databases on your computer
11

: 

1. On the Windows Start menu, select Control Panel > Administrative Tools > 

Component Services. 

The Component Services dialog box appears. 

2. From the tree on the left, select Component Services > Computers > My 

Computer. 

3. Right-click My Computer and select Properties from the menu. 

The My Computer Properties dialog box appears. 

4. Click the COM Security tab. 

5. In the Access Permissions section, click the Edit Default button and specify the 

settings as in the picture below. 

 
Figure 279 Access Permission dialog box 

6. Click OK. 

                                                      

11
 To enable access to remote databases and ASTD-2 machine shop system, go through Steps 1-5 

only. 
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7. In the Launch Permissions section, click the Edit Defaults button and specify the 

settings as in the picture below. 

 
Figure 280 Launch permission dialog box 

8. Click OK. 

9. In the tree on the left, select DCOM Settings and then select VD SERVER on the 

right. 

 
Figure 281 Selecting VD SERVER in DCOM settings 

10. Right-click VD SERVER and select Properties from the menu. 

11. On the General tab, specify the settings as in the picture below. 



   Vibrodesigner User's Guide 

  269 

 
Figure 282 VD SERVER dialog box—General tab 

12. Click the Security tab. 

13. Set the Launch Permissions option to Customize and click the Edit button. 

The Launch Permissions dialog box appears. 

14. Specify the settings as in the picture below. 

 
Figure 283 Launch permissions dialog box 
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15. Click OK. 

16. Set the Access Permissions option to Customize and click the Edit button. 

The Access Permissions dialog box appears. 

17. Specify the settings as in the picture below. 

 
Figure 284 Access permissions dialog box 

18. Click OK. 

Windows XP SP2 

To enable access to the databases on your computer
12

: 

1. On the Windows Start menu, select Control Panel > Administrative Tools > 

Component Services. 

The Component Services dialog box appears. 

2. From the tree on the left, select Component Services > Computers > My 

Computer. 

3. Right-click My Computer and select Properties from the menu. 

The My Computer Properties dialog box appears. 

4. Click the COM Security tab. 

                                                      

12
 To enable access to remote databases and ASTD-2 machine shop system, go through Steps 1-5 

only. 
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5. In the Access Permissions section, click the Edit Limits button and specify the 

settings as in the picture below. 

 
Figure 285 Access permissions dialog box 

6. Click OK. 

7. In the Launch and Activation Permissions section, click the Edit Permissions 

button and specify the settings as in the picture below. 
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Figure 286 Launch permissions dialog box 

8. Click OK. 

9. In the tree on the left, select DCOM Settings and then select VD SERVER on the 

right. 

 
Figure 287 Selecting VD SERVER in DCOM settings 

10. Right-click VD SERVER and select Properties from the menu. 

11. On the General tab, specify the settings as in the picture below. 
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Figure 288 VD SERVER dialog box—General tab 

12. Click the Security tab. 

13. Set the Launch Permissions option to Edit and click the Edit button. 

The Launch Permissions dialog box appears. 

14. Specify the settings as in the picture below. 

 
Figure 289 Launch permissions dialog box 
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15. Click OK. 

16. Set the Access Permissions option to Edit and click the Edit button. 

The Access Permissions dialog box appears. 

17. Specify the settings as in the picture below. 

 
Figure 290 Access permissions dialog box 

18. Click OK. 

Installing STD-500/510 Driver 

If you want to work with STD-500/510 monitors on your workstation, you need to install 

a special driver at the first connection. Installing the driver is shown with the STD-500 

monitor. Use the same procedure for installing the STD-510 driver. 

To install the STD-500 driver: 

1. Connect your STD-500 to any USB port of your workstation. Use a special USB 

cable delivered with STD-500. 

The Found New Hardware STD-500 message is displayed in the lower right corner 

of the Windows desktop. 
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Figure 291 Found New Hardware message 

After a while, the Found New Hardware Wizard appears. 

 
Figure 292 Found New Hardware Wizard—first step 

2. Click No, not this time and then click Next. 

 
Figure 293 Found New Hardware Wizard—second step 
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3. Click Install from a list or specific location and then click Next. 

 
Figure 294 Found New Hardware Wizard—third step 

4. Click Don’t search. I will choose the driver to install and and then click Next. 

 
Figure 295 Found New Hardware Wizard—fourth step 

5. Click the Have Disk button. 
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Figure 296 Found New Hardware Wizard—fourth step 

6. In the Copy manufacturer’s files from box, specify <Vibrodesigner Installation 

CD>\ Windows\INF\stdvmdrv.inf and then click OK. 

 
Figure 297 Found New Hardware Wizard—fifth step 

7. Click the Next button. 

The Files Needed dialog box appears. 

 
Figure 298 Files Needed dialog box 
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8. Click the Browse button, select the stdvmdrv.sys file located in the installation disk 

root folder, and then click Open. 

The path to the selected file is shown in the Copy files from box. 

9. Click OK. 

The driver installation is started. 

10. When finished, click the Finish button. 

The Your new hardware is installed and ready to use message is displayed in the 

lower right corner of the Windows desktop. 

 
Figure 299 Your new hardware is installed and ready to use message 

You can now view the information on the installed STD-500 in the 

Vibromonitoring devices section of the Windows Device Manager. 

 
Figure 300 STD-500 properties in Device Manager 
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Comparing Stationary Device and Database 

Configurations 

When working with stationary devices, the device configuration must match the 

configuration of machine measurement points defined in the program; otherwise, loading 

inspection data into the database will fail. To view both configurations and detect 

possible discrepancies, use the View configuration button on the Communication tab 

(see Figure 132). The Configuration Comparison dialog box appears. 

 
Figure 301 Comparing program and device configurations 

In this dialog box, you can see the channel configuration of the connected device (in the 

Device columns) as well as measurement points in the program bound to these channels 

(System columns). If a channel configuration does not match a measurement point 

configuration, you will see the exclamation mark ( ) in the first column of this channel. 

You can see discrepancies for channels 4, 8, 9, 12 and 13 in the picture above. If a 

channel has been configured in the program but in the device this channel is blank, such 

a channel is shown as grey (see channel 4 in the above picture). Mismatching in 

configuration parameters is shown with red (see channels 8-9 and 12-13). 

If the exclamation mark ( ) is displayed for a certain channel, loading data from the 

device into the Vibrodesigner database is prohibited and thus the Gather inspection 

data button on the Communication tab is unavailable. You need to change 

configuration either in the device or in the program in order to load data into the 

database. 
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Windows Firewall Settings 

If you use Windows XP SP2 on your computer, the Vibrodesigner installer will 

automatically configure RPC ports and Windows firewall. Then, if a user has changed 

default firewall setting, the Vibrodesigner program may work incorrectly. If so, you have 

to either turn the Windows firewall off or configure it manually, as described below. 

To turn Windows firewall off: 

1. Open the Windows Firewall window (Start menu > Control panel > Windows 

Firewall). 

2. On the General tab, select Off (not recommended) and click OK. 

 
Figure 302 Windows firewall is turned off 

If you need to work with Windows firewall turned on, do as follows: 

1. On your computer, restrict the dynamic RPC ports range. TO do so, by means of 

regedit.exe execute the RPCports.reg script, shown below. 

Windows Registry Editor Version 5.00 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Rpc\Internet] 

"Ports"=hex(7):31,00,39,00,34,00,34,00,30,00,2d,00,31,00,39,

00,35,00,33,00,39,\ 

  00,00,00,00,00 
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"PortsInternetAvailable"="Y" 

"UseInternetPorts"="Y" 

2. In the Windows firewall, open the following ports: 

 135(TCPIP) – SCM 

 19440 – 19540(TCPIP) – dynamic range of RPC ports 

3. Restart your computer. 

You can also automatically configure Windows firewall on the client computer by 

executing the FirewallDCOM_Client.vbs BB-script (see below) and restarting the 

firewall service. 

'===========================================================

=================== 

' Firewall settings 

'===========================================================

=================== 

' adding TCP port 

Sub AddTCPPort(objProfile,Name, Number) 

 set objPort = CreateObject( "HNetCfg.FWOpenPort" ) 

 objPort.Name = Name 

 objPort.Protocol = 6 'NET_FW_IP_PROTOCOL_TCP  

 objPort.Port = Number 

 objPort.Scope = 1 

 objPort.Enabled = TRUE 

 objProfile.GloballyOpenPorts.Add( objPort ) 

end Sub 

 

' adding UDP port 

Sub AddUDPPort(objProfile,Name, Number) 

 set objPort = CreateObject( "HNetCfg.FWOpenPort" ) 

 objPort.Name = Name 

 objPort.Protocol = 17 'NET_FW_IP_PROTOCOL_UDP 

 objPort.Port = Number 

 objPort.Scope = 1 

 objPort.Enabled = TRUE 
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 objProfile.GloballyOpenPorts.Add( objPort ) 

end Sub 

 

'Execution 

 

 set objFwMgr = CreateObject("HNetCfg.FwMgr") 

 set objProfile = objFwMgr.LocalPolicy.CurrentProfile 

 

 set objServices = objProfile.Services 

 

 

 'SCM 

 AddTCPPort objProfile,"RPC" ,135 

 

 ' DCOM dynamic range 

 For n = 0 to 99 

    AddTCPPort objProfile,"DCOM" & (n+1) ,19440+n 

 next 
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Chapter 12 Glossary 

Amplitude – a calculated signal that is equal to maximum deviation from a certain 

harmonic signal. Amplitude is expressed in terms of peak-to peak, zero-to-peak, or RMS. 

For pure sine waves only, these are related as follows: RMS = 0.707 times zero-to peak; 

peak-to-peak = 2 times zero-to-peak. 

Band – a specific range of frequencies. Each band has a defined upper and lower 

frequency limit.  

Band-Pass Filter – a filter with a single transmission band extending from lower to 

upper cutoff frequencies. The width of the band is determined by the separation of 

frequencies at which amplitude is attenuated by 3 dB (0.707). 

Calculated signal – a signal computed by Vibrodesigner using one or more measured or 

calculated signals in accordance with the specified measurement unit. 

Constant – a pre-defined real number. 

Database archive – a repository of structured data that based on the relational database 

model. 

Device – a data collector each channel of which contains one transducer.  

Division – a structure unit used to create a plant hierarchy. Divisions can belong to the 

root objects (database name). A machine shop division has all properties of the parent 

object. 

High-Pass Filter – a filter with a transmission band starting at a lower cutoff frequency 

and extending to (theoretically) infinite frequency. 

Inspection – the record of a set of measured signals from one or more elements of the 

machine. All the inspection data are collected under the same machine conditions and 

consequently can be used for vibration diagnostics. In the Vibrodesigner program, an 

inspection is the record of measured data into a database. 

Low-Pass Filter – a filter whose transmission band extends from 0 to an upper cutoff 

frequency. 

Machine – an electromechanical system designed to perform a particular technological 

task on the plant. A machine consists of one or more machine elements, for example, 

engine, turbine and so on. From the vibration diagnostics point of view, a machine is the 

equipment for vibration diagnostics measurements. Monitoring and prediction of the 

remaining time before failure and machine diagnostics can be performed either for the 

entire machine or for its elements. 

Machine element model – a standard machine element with a predefined set of units 

and measurement points. 
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Machine model – a machine type with certain properties. A machine model consists of 

standard elements. 

Machine shop – a plant hierarchy unit that can have child divisions and machines. 

Measured signal – a signal taken from transducers and transformed into digital form in 

accordance with the specified measurement unit. In contrast to calculated signals, the 

measured signal is received from a data collector. 

Measurement event – the record of current measured/calculated signal values into a 

measurement point. 

Measurement point – a certain location on a machine element model where vibration 

measurements are to be performed. Each point is strictly linked to the element model. A 

point is characterized by its own parameters (point code, measurement direction, point 

number), measurement parameters and alarm/warning levels. 

Object – a common name for any element of the plant hierarchy (machine shop, 

division, machine, route, device) or any element of the machine measurement model 

(element, point, measured or calculated signals). 

Orbit – a way to display two synchronized waveforms measured in orthogonal directions 

when the measured values (typically, vibration displacement) are plotted along 

perpendicular X and Y axes. Time is the orbit parameter. 

Out-of-route points – such points are belonged to a machine (machine element). The 

completed unarranged measurements are recorded in out-of-route points. 

Parameter – a scalar measured or calculated signal. The examples are air temperature in 

a heating chamber or any vibration parameter. 

Peak-to-peak amplitude – a vibration parameter that represents the doubled average 

value for the spectrum element in the entire frequency range or in the band. 

Phase angle – a calculated signal that uniquely defines a harmonic signal at every 

instant. 

Plant – a main hierarchy unit. A plant includes all downstream objects. 

RMS – a vibration parameter that represents square root of the arithmetical average of a 

set of squared instantaneous spectrum elements within the band. 

Route – the order of measurements in points during inspection. When creating a route 

from the measurement points, their measurement parameters are inherited from the 

points on the corresponding machines. A route stores references to particular 

measurement points, not points itself. 

Scalar value – a real number. 

Spectrum – a vector calculated signal. Calculated using discrete Fourier transformation 

of a waveform. 

Synchronized waveforms – the waveforms time axes of which are matched with the 

time labels. Time labels correspond to the same condition of the vibration system. For 
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example, waveforms can be synchronized by phase labels that correspond to the same 

condition of the rotated shaft. 

Transducer – a device for transforming the vibration magnitude into electric voltage 

that is passed into the measurement channel of the data collector. Using a transducer, a 

measurement is carried out. The transducer can be bound to the only point. A transducer 

has many parameters, including sensitivity. 

Vector– an ordered sequence of real numbers which amount is fixed and defined. 

Vibration parameter – a parameter that represents some integral characteristic of 

vibration, for example, band RMS. 

Warning level – a level specified for measured and calculated parameters. This level is 

needed to trace exceeding predefined allowable values. The warning level is a set of a 

parameter name, a parameter value range, an the degree of alarm. The warning types are 

listed in Chapter 11, ―Alarm/Warning Types.‖ 

Waveform – a vector formed as a serial record of measured signal in the vector elements 

(strictly in time ascending order). 
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